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Introduction 
This model is intended to be used as a coarse screening tool to rate stream crossings for 
hydraulic, aquatic organism passage (AOP), and geomorphic compatibility (GC). It is best used 
as a method to quickly analyze many crossings at once, and detail the susceptibility of the 
crossings in the context of the watershed scale. While the results are beneficial, they should not 
be used for design or final analysis. Much of the data is either obtained online from GIS sources, 
or is collected as part of the New Hampshire state protocol. Individual crossings may be found 
to have site specific considerations of modeling parameters when analyzed more closely; but to 
do so requires greater effort, and would immensely increase time and effort. The goal of this 
model is to provide a quick screening assessment of many culverts by utilizing available or 
standardized collection data protocols.  

Version 2 has several updates over Version 1. Most notably, Version 2 provides ratings for 
aquatic organism passage and geomorphic compatibility in addition to hydraulic ratings. 
Updates to the hydraulics in Version 2 include accounting for tailwater effects as well as a 
slightly different hydraulic rating scheme than the first version. In Version 1, a rating of 
Transitional meant that the headwater stage at the inlet of the crossing was within 15% above 
or below the crown; Pass meant a headwater stage below this zone; and Fail meant a stage 
above. To better represent what may be considered physical hazard conditions at each crossing 
resulting from hydraulic performance, in Version 2, a rating of Pass represents a headwater 
stage below the lowest crown at the culvert inlet(s) of the crossing; a rating of Fail means the 
headwater stage is overtopping the road (or in some cases another type of adjacent levee or 
user-established elevation); and Transitional means any headwater stage between those two 
elevations. Furthermore, Version 2 includes additional optional input that may exist at a site 
which may provide more accurate calculations at relatively little extra effort. 

This model was designed and documented to be used by persons with basic understandings of 
hydrology and hydraulics, and some experience with culvert crossings, at the very least. While 
this document will explain the data and variables to be used as well as the methods, equations, 
and calculations used, it will not attempt to explain every piece in detail. For specific questions, 
please consult relevant online documentation. The answers to even the most specific questions 
are most likely answered at numerous websites. For any technical errors or modeling issues, 
please contact Tom or Joel Ballestero of Streamworks, PLLC for help. 

Throughout this document, references to sections of this report as well as to content within the 
model are formatted in certain manners to help the reader more quickly understand to what 
the text is referring. References to section headers within this report appear as:  

Referenced Content - Section header or title within this report 
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References to the individual tabs, input, or any special definitions located within the model 
appear in the following manner: 

Referenced Content - Individual tabs located in the model 
Referenced Content - Data category headers located within the Ratings and Results 

tabs in the model  
Referenced Content - Required and optional input data parameters and column labels 

in the model  
Referenced Content - Any other calculated data or values described here, or 

referenced in the model 

Funding was provided in part by the National Oceanic and Atmospheric Administration’s 
(NOAA) Office for Coastal Management under the Coastal Zone Management Act in conjunction 
with the New Hampshire Department of Environmental Services’ (NHDES) Coastal Program. 
Project partners include NOAA, NHDES, the Strafford Regional Planning Commission (SRPC), the 
Rockingham Planning Commission (RPC), the University of New Hampshire’s (UNH) Stormwater 
Center (UNHSC), and the UNH Institute for the Study of Earth, Oceans, and Space (EOS). Project 
managers and contacts include Steve Couture and Nathalie Morison with NHDES, Kyle Pimental 
with SRPC, Julie LaBranche with RPC, Tom Ballestero with UNHSC, and Faye Rubin and David 
Justice with UNH EOS. 

Updates from Version 1 
This is the second version of this model. As such, there were major modifications and updates 
to the interface and layout of the model, compared to Version 1. The model was overhauled to 
present the crossings listed by row, rather than by column. This was done to conform to a more 
conventional way that a user would store and view the data – and because scrolling side-to-side 
to view input and results is more difficult that scrolling up-and-down, especially when dealing 
with larger data sets (a large number of culverts). The methods and calculations employed, 
however, are in large part unchanged behind the scenes. Some coefficients used in the 
hydraulic equations have been changed to reflect published changes since Version 1, but 
otherwise all the coefficients and equations used in the hydrologic and hydraulic calculations 
remain the same.  Some additional calculations and synthesis was added. 

The input required for they hydrology and hydraulic calculations (formerly input on the GIS 
Input and User Input tabs in Version 1) remains mostly the same, with some additions to 
further provide more options for defining a crossing. Some of the new input parameters are 
optional, and may help the user better analyze a crossing using minimal added effort. One 
major new addition to the available input is the fact that Pipe Arch culvert shapes are now 
included, and Culvert Type Reference Numbers are available to use for those shapes. 
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Another major update to the model is the manner in which it rates crossings for hydraulics. In 
Version 1 the ratings were defined by the elevations of 85% and 115% of the rise of the culvert 
at the inlet, with a rating of Transitional being a headwater depth between those two 
elevations, and ratings of Pass and Fail for headwater depths below or above those elevations, 
respectively. While there is nothing wrong with those former ratings, they did not convey well 
what happens at a crossing. Thus for Version 2, based on discussions with a Technical Advisory 
Committee it was decided to update the limits where the three ratings of Pass, Transitional, and 
Fail apply, and have those limits better describe approximate stages that may be considered 
critical points with reference to infrastructure. The two elevations which define the hydraulic 
ratings in Version 2 are the top of the culvert at the inlet, and at the elevation at which the 
water overtops the road. More specifically, this second stage does not have to be the point at 
which the water reaches the road. In the model, it is referred to as the Failure Elevation. While 
most commonly this elevation would be at the elevation of the road over the culvert it may be 
any elevation that the user desires to use as the stage at which a culvert is rated as Fail. This 
may be an adjacent levee, a stage at which flooding occurs at upstream infrastructure, or any 
other elevation. It is simply to define the point at which a culvert receives a hydraulic rating of 
Fail. 

In Version 1, the only hydraulic calculations performed were those for the headwater depths 
due to the inlet control. Recognizing that there are many other factors that can influence 
headwater depths resulting in outlet control, Version 2 computes both inlet and outlet control 
in order to determine a more accurate headwater depth. Two tabs were added to help the user 
define outlet control elements. The first is a Tailwater Input tab that simply allows the user to 
input known water surface elevations at the tailwater control. The second tab is the Rating 
Curve Generator, that – based on a simple cross section at the tailwater control – can generate 
the water elevations and copy them to the Tailwater Input tab automatically. These tabs are 
both optional, but provide for further analysis and better results at a crossing. 

Finally, two other important updates in Version 2 include two additional ratings for the 
crossings: Aquatic Organism Passage (AOP) and Geomorphic Compatibility (GC). The data 
required for developing these ratings are on the AOP Input and GC Input tabs, and provide a 
more complete description of the performance of a crossing – not only relating to passing flows 
(hydraulics), but to passing sediments and accommodating aquatic organism passage as well. 

Limitations and Precautions 
It is important to state that the purpose of this model is to provide a quick and relatively easy 
assessment of many stream crossings at once with regards to Hydraulics, Aquatic Organism 
Passage (AOP), and Geomorphic Compatibility (GC). Because of this, this model is meant to be 
simple to use with minimal input, and relatively little knowledge or experience with the 
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hydrology, hydraulics, or habitat associated with the dynamics of stream crossings. A rigorous 
analysis of the impact a stream crossing to both the stream system and infrastructure can be 
extremely involved, requiring significant effort and resources. Thus, many limitations and 
precautions come with the goal of simplifying such a complex analysis. These are most evident 
in the hydrologic and hydraulic calculations, as both are highly dynamic and chaotic processes. 
Limitations to the accuracy of the AOP and GC ratings exist within the method developments, 
however limitations in calculating these ratings within this model are not a factor. That is; 
calculating each model capability as to whether or not a crossing is actually passable by fish or 
sediments would depend on a number of factors unique to each scenario – and in the case of 
aquatic organisms – unique to each individual organism. This applies to the hydrology and 
hydraulics as well; estimating the peak flows and capacity of each watershed and culvert 
naturally results in limitations to the precision of the results. The methods themselves contain 
limitations to their exact ability to predict flows and headwater stages, but the ability of the 
model to run the calculations behind each method is not inhibited. 

The following list describe the model limitations and precautions  

A. Hydrologically, the model uses two methods to estimate flows at each site; the SCS runoff 
curve number method for all watersheds with area less than one square mile, and the USGS 
regression equations developed for New Hampshire for all watersheds larger than one square 
mile. While these methods are widely-used, and appropriate for many scenarios, both are 
rough estimations and do not perform as well as full, site specific watershed models. Both 
scenarios cannot account for specific types and degrees of urbanization – road drainage, dams, 
ponding, sequential road/stream crossings, and so on. Both are meant to be used on more 
rural, homogenous watersheds, and the very nature of a stream crossing infers that there is 
already some urbanization, even if only at that location.  

B. The model, overall, is only set up to run up to 1,000 crossings at a time. Keeping track of 
all may be challenging, and could cause the model to run and/or open slowly. Therefore, if a 
user has more than 1,000 crossings to be processed, separate files should be created.  

C. To keep the user from accidentally deleting or changing a cell that contains a formula, the 
file is protected. However, if the user desires to access locked cells or hidden tabs, the file is not 
password-protected. To unprotect the file (or a single sheet), simply click the Review ribbon 
tab, and select either Unprotect Sheet or Unprotect Workbook. Hidden tabs contain all the 
calculations behind the scenes as well as reference tables. These tabs may be accessed if the 
user has the need to do so. 

D. The model uses equations developed for all the most common culvert shapes, but not for 
all the shapes that a user may encounter in the field. Most of the time, the shape may be 
approximated and entered into the model in a manner that most appropriately describes the 
amount of flowable area with the appropriate dimensions – keeping in mind that the Rise 
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should remain the same, and that the Span and Embedded depth may be adjusted to more 
exactly match the flowable area. This is described in more detail later in this document. 

E. Similarly, defining the culvert shape within the model not only tells it which coefficients to 
use in the headwater depth calculations, it also tells the model how to use the dimensions to 
calculate the flowable area of the inlet. This is not an issue with most shapes, however, there is 
no standard equation for determining the area of a pipe arch shape. These culverts are defined 
by a curved outline with three radii; one for each of the two corners, one for the upper curve, 
and one for the lower curve. The lower curve has the largest radius, while the corners have by 
far the smallest. Pipe arches can vary in their dimensions, and usually have the open area given 
by the manufacturer. Determining the open area of the inlet is massively important to 
calculating the headwater depths at a crossing. The headwater depths define the hydraulic 
rating for each crossing. Therefore, essentially any headwater stage below the top of the pipe is 
irrelevant, as to how accurate is the headwater measurement – when a pipe is flowing full, the 
flow area is equal to the total area of the pipe. Thus, the incremental calculation of the 
partially-full flow at the inlet does not need to be exactly representative of what it would be at 
any stage; only the full area. Having said this, pipe arches look very similar to an elliptical 
culvert that has been stretched at the top, and squashed at the bottom; the maximum width 
occurs below the vertical center of the shape. Therefore, more of the flowable area is lower, 
and less is higher. This is not entirely important, as long as the total area is accounted for. 
Within this model, since a complete lookup table of pipe arch sizes would be impractical, and 
lead the user to perhaps select a size that does not represent their observed culvert properly, 
pipe arch areas are calculated by the ellipse equation. This has proved to be a fairly good 
predictor in calculating the manufacturer-published areas. Performing a check on pipe arch 
sizes in published tables of sizes and configurations and areas, the range of percent difference 
in the area of calculated vs published areas was from 88-117%. And although a variation of 10-
20% is quite large in terms of area, most of the calculated areas were much closer than that. Of 
all the Version 2 pipe arch culverts analyzed, 80% were within +/-2.5% and 90% were within +/-
5%. So while a user may select a pipe arch shape, and enter in the dimensions, they should 
always attempt to check the calculated area against the area published by the manufacturer. 

F. This model can only perform calculations for one culvert at a crossing, or for multiple, 
parallel, identical culverts at a crossing. It cannot analyze multiple, dissimilar culverts, or 
dissimilar culverts in series (where a culvert cross section changes midway). This may be 
accommodated in the model in a few different ways, and this is more elaborately detailed later 
in this document. 

G. There are many recommended ranges for the input parameters and for the methods used 
in this model. These are described in more detail later in this document, under the descriptions 
for the methods, and within the Using the Model section. 
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H. There are many physical properties of culverts that are unavailable to be properly defined 
within the model, or analyzed. This model cannot analyze culverts with multiple slopes (vertical 
elbow in the middle, broken-back culverts), nor can it properly describe any Culvert Shape, 
Material, End Type, or Edge Type that is not listed (these are all used to describe a Culvert Type 
Reference Number – more on that later). The user will have to describe those as best as 
possible. 

I. This model calculates the headwater depths at the inlet two ways – inlet control and 
outlet control. While these calculations are good starts, there are various site specific hydraulic 
conditions that may be present which are unaccounted. The model cannot yet perform 
calculations for energy losses within the culvert, or for cases where both the inlet and outlet 
are submerged, or for upstream turbulence causing additional losses at the inlet, among many 
others. The hydraulic calculations are most effective at producing results for longer, steeper, 
smaller, non-embedded culverts. Basically, any culvert where the inlet is the largest driving 
force behind the headwater stages. Outlet control headwater calculations are proposed to be 
added to the model by the end of Summer of 2017. 

J. Culverts with negative slopes cannot be analyzed properly; the slope has to be put into 
the polynomial equations with a positive value in order for the equations to be valid. Thus, 
culverts with negative slopes default to having a flat (0%) slope in the calculations, and may 
require more detailed analysis. 

K. This model calculates headwater depths according to how high a headwater stage would 
need to be at the inlet in order to pass the defined return-period flow through the culvert. 
Stream crossings may create a storage reservoir upstream, with the culvert being the outlet 
(and the road – or other feature – being the secondary spillway). This model does not perform 
storage routing.  

L. This model requires that elevations at each site be input for several of the tabs. The 
elevations at each crossing do not need to be tied-in to global coordinates (vertical/horizontal 
datums); their absolute location in space is not important. However, they all must be relative to 
one datum at each site across all the tabs which require elevation data – Hydraulic Input, 
Tailwater Input, Rating Curve Generator, and AOP Input. 

M. This model was created and coded in Microsoft Excel 2010 and Visual Basic for 
Applications 2010. While it has been checked to function with some other versions/years, it 
may not work with newer versions, or with mobile versions. 

N. The model has been checked, calibrated, and tested as much as possible with over 100 
culverts in its development. However, there are likely intricacies that may have been 
overlooked or did not arise at the time of development and testing. Please be sure to make any 
notes as to warnings or errors that you find, and be sure you check to see if there is a newer 
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version of the model available. Updates will be performed as feedback is returned to the 
authors, so please be sure to detail any issues as completely as possible. 

Methods, Input, and Calculations 
There are three types of ratings that this model produces: Hydraulic, Aquatic Organism Passage 
(AOP), and Geomorphic Compatibility (GC). The latter two use the New Hampshire state 
assessment protocols, both of which were adopted from the Vermont protocols. The former, 
hydraulic, has three components that each are performed using common, industry standard, 
well-published methods. 

It is assumed that the user of this model has at least a basic understanding of hydrology and 
hydraulics, and some experience with culvert and similar stream crossings. The methods used in 
this model will be discussed, and as much detail included to help guide even the most novice 
user through the input, but full-length discussion of methods and each variable is beyond the 
scope of this User’s Manual. If there are questions beyond what is detailed in this report, please 
refer to online documentation. Again, this model uses fairly common, well-documented 
methods, and there is likely an answer to even the most specific questions via online sources. 

Peak Flows (Hydrology) 
In order to rate each crossing for hydraulic performance, the first step is to determine the flow 
expected at each location, at select return intervals (risk). The return intervals calculated in this 
model are the 2-, 10-, 25-, 50-, and 100-yr storms. There are many methods to calculate peak 
flow from a watershed, with some being more involved than others. In order to keep the 
required input data and effort at a minimum, two hydrologic calculation methods were chosen: 
the SCS Runoff Curve Number method for all drainage areas less than one square mile, and the 
USGS Regression Equations published for New Hampshire for all drainage areas larger than one 
square mile. Both methods are widely used, and all the data required to calculate each may be 
obtained from online sources. Using separate documentation accompanying this model (See 
StreamWorks-TU Culvert Model Instructions at end of User’s Manual) , it is entirely possible to 
automate the collection of this data, as long as crossing coordinates can be provided. However, 
it is always best to check the automatically-collected data against known values to ensure the 
automated method was run correctly. Also, it is important to use the correct online sources in 
the correct units, as detailed in this section. Recommended ranges for some of the hydrologic 
values may also be found in this section, and should be considered when running the model. 
Though the model will still calculate peak flows, if values lie outside their recommended ranges, 
the likelihood for error increases. Both methods are not meant for use in more urban 
watersheds, as urbanization can lead to increased or decreased flows (i.e. impervious surfaces 
or flood control, respectively). Finally, both methods for calculating peak flows at the crossings 
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are commonly used, and much documentation may be found on each online. Please consult 
online sources if a more detailed explanation is required (see References at end). 

While this model is capable of calculating the peak flows for each crossing using the input 
described in the following sections, there is an option for the user to override (or provide) flows 
for each of the return periods, should the flows already be known, or if the calculated flows are 
in question. 

USGS Regression Equations for New Hampshire 

The USGS Regression Equations for New Hampshire are 4-variable, empirical equations that 
have been calibrated to peak flows in the state using recorded and published peak flows at 
USGS gaging stations as the control. Numerous independent variables were investigated for the 
regression analysis, and statistical software was used to determine the most relevant 
predictors, as well as define the coefficients for the best-fit equation for select return period 
flows. Since these equations were developed using specific datasets from specific sources, it is 
important to obtain these values from their exact online publications using their specified units. 
Even though there may be more current – or accurate – data available for each of the four 
parameters used in the equations, these equations may lose their relevancy if referenced to 
different sets of data. In other terms, the statistical analysis determined that the best predictors 
of flows to the outlet of a basin were these four parameters using their exact data sets – and 
not others. For the exact regression equations coded into this software, please refer to the 
USGS report (USGS, 2009). 

The four variables used in the regression equations are the Drainage Area in square miles, the 
Basinwide Mean of the Average April Precipitation in inches, the Percent Wetlands in percent 
(not decimal), and the 10-85 Slope (the slope of the flow path between points 10% and 85% up 
the length from the outlet) in feet per mile. Of these four variables, two are input into the 
model with units other than the ones defined by the USGS. The Drainage Area is input into the 
model with units of square feet, and the Percent Wetlands is calculated internally in the model, 
using the Area of Ponds and Wetlands (input into the model with units of square feet) and the 
Drainage Area (also in square feet).  

The sources and data sets for each variable should be followed exactly to ensure the most 
accurate prediction of peak flows. To determine the Drainage Area, the 2007 USGS Digital 
Elevation Model should be used. Similarly, using the topographical DEM for the path length, the 
10-85 Slope should use elevations referenced to the 2007 USGS National Elevation Dataset. The 
Area of Ponds and Wetlands should be referenced from the National Land Cover Dataset from 
2003. The Basinwide Mean of the Average April Precipitation refers, exactly, to the weighted 
mean of the average April precipitation depths for the selected drainage basin (in inches), 
determined with the 1971-2000 April precipitation dataset (obtained from the PRISM Group at 
Oregon State University) resampled with bilinear interpolation to a 180-ft cell resolution. In less 
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technical terms, but more detail, the Oregon State University PRISM Group publishes climate 
data to their website. They use, among other periods, 30-year windows of data for some data 
sets, and within those data sets, select time periods (summer, monthly, annual, etc.) may be 
obtained. The data sets are published with finite resolution, so the average – or weighted – 
value over a basin may be manipulated. Thus, taking the average April precipitation weighted 
for the entirety of the watershed for the month of April during the time period from 1971-2000 
is how this value should be developed.  

The regression equations were calibrated to known peak flows at USGS gaging stations across 
the state. Each gage had a watershed with its own properties; the limits of these properties for 
all the watersheds analyzed in the development of the equations are what the USGS suggests as 
the applicable ranges of values which the equations are likely accurate for. While values outside 
of the ranges are acceptable for use, the likelihood for prediction error increases. As detailed in 
the USGS’ report on the development of the regression equations, the appropriate ranges for 
the variables used in the equations are:  

Regression Equation Data Constraints 
Parameter Units Minimum Maximum 

Drainage Area mi2 0.70 1290 
Basin Mean of Avg April Precip in 2.79 6.23 

% Wetlands % 0.0 21.8 
10-85 Slope ft/mi 5.43 543 

SCS Curve Number Method 

The SCS (now NRCS) Curve Number method uses physical watershed properties and rainfall 
depths (corresponding to the appropriate return period peak flow) to estimate precipitation 
losses and a unit hydrograph unique to the basin. The unit hydrograph is then weighted by the 
rainfall amounts to calculate the peak flows. This method is meant to be customizable to any 
watershed (within the constraints of the parameter values) using the best available data, thus 
there is no specific data set needed for each parameter. However, in addition to the ranges of 
values for the parameters, this method was meant to be used on rural, homogenous land use 
(minimally diverse land use types), and consistent soil type watersheds. It was not intended for 
use on more urbanized watersheds, which is likely to be unavoidable in many cases, although 
more recent documentation does apply the model to urbanized watersheds without 
stormwater controls.  

Some of the data obtained for the USGS Regression Equations is also applicable for this SCS 
method: the Drainage Area and the Area of Ponds and Wetlands. 

As the method requires a few steps to compute the peak flows based on select input 
parameters, only the variables required to be input into the model – and not intermediate 
(though important) parameters – are detailed here. Those variables and their units are; the 
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Drainage Area in square feet, the Flow Path Length in feet, the Overall Flow Path Slope in ft/ft 
(a.k.a. unitless dimensions), the Area of Ponds and Wetlands in square feet, the Runoff Curve 
Number (unitless), and the 24-hour Precipitation Depth for each of the five return intervals (2-, 
10-, 25-, 50-, and 100-yr) in inches. Additionally, this method uses a Rainfall Distribution Type to 
define the timing over a 24 hour period when the precipitation falls. New Hampshire is divided 
between two types; Type 2 and Type 3. The default for this model is set to Type 2, but Type 3 
should be input to the model when appropriate. Maps depicting the location of each type 
across the state may be abundantly found online. 

While these values may be calculated various ways, and from any source most suitable, the 
following text is meant to further clarify how some of the parameters are calculated and to 
what they refer. The Flow Path Length refers to the longest length of a path taken by a drop of 
water from the basin outlet upstream to the watershed divide. The Overall Flow Path Slope 
refers to the slope of that flow path from its highest elevation to the elevation at the outlet. 
The Runoff Curve Number is a value used in the method to estimate the amount of the 
precipitation from the sky that actually contributes to flow (runoff), and how much is lost or 
stored. This number is calculated as the average of the individual curve numbers for the soils 
and land use types contained within the watershed, weighted by the area of each soil and land 
use type. Curve Numbers for land use types according to soil types are widely published online, 
and may be calculated automatically using a variety of online mappers (for example the USDA 
Web Soil Survey website).  

The applicable ranges for this method include two parameters that are calculated within the 
model, and not input directly by the user. These two parameters, Ia/P and Tc, will not 
immediately be apparent to the user if they are violated, however, a warning will be shown on 
the Results tab of the model that will describe if one of the ranges has been violated. As 
described in documentation on the SCS Curve Number Method, the ranges for the variables 
are: 

SCS Curve Number Method Data Constraints 
Parameter Units Minimum Maximum 

Drainage Area mi2 0.0 2.0 
Ia/P - 0.10 0.50 
CN - 40 100 
Tc hrs 0.1 10 

 

Hydraulics 
With the expected flows calculated at each crossing, the resulting headwater depth at the inlet 
is determined and forms a hydraulic rating for the culvert (headwater depth versus flow). 
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Culvert hydraulics are complicated and involve many factors. Headwater depth is hydraulically 
controlled in one of two ways: inlet control, which involves all the energy losses associated with 
the physical inlet configuration; and outlet control, which accounts for losses internally within a 
culvert and also the headwater effects from downstream of the culvert. In each case, both the 
inlet and outlet control headwater stage is calculated, and the larger of the two is the 
controlling stage (headwater depth). 

To simplify and standardize the effort involved with calculating inlet control hydraulics, the 
Federal Highway Administration (FHWA) developed empirical equations for certain 
combinations of physical metrics of inlet configurations. These equations are published in their 
report, Hydraulic Design Series number 5 (HDS5, 2012), and are incorporated into their free 
software, HY-8, which is a more robust analysis program than what is offered in this model. The 
equations used in this model for inlet control are borrowed directly from HDS5. While HY-8 may 
be a more thorough analysis for each crossing, it is cumbersome to input data and perform 
analyses for many crossings, and is meant to analyze culverts one at a time. HY8 results are not 
easily displayed as one summary. This is one of the main attributes of the differences between 
this model and the HY-8 software. 

Again, to simplify the required data and effort necessary to analyze each crossing, calculating 
outlet control headwater elevations are limited to user-entered values, or stages calculated by 
Manning’s Equation for the controlling channel cross section downstream of the crossing.  

Thus with headwater stage for both the calculated inlet and outlet control headwater depths at 
each return period flow, the highest is selected and compared to the top of culvert elevation 
and the road elevation to form the hydraulic rating. Another goal of this model is to easily and 
quickly represent the results for many culverts (town-wide or watershed wide), in a manner 
that can be understood at a glance. Whereas the resulting numerical headwater stages at each 
crossing for each flow are displayed in the results, the colored rating scores quickly and easily 
display how each performs, to help identify the most vulnerable crossings. When considering 
hydraulic vulnerability at a crossing, two water stages (headwater depths) were chosen that 
were considered simple benchmark representations the culvert hydraulic performance. The 
highest of the two is the stage at which the headwater begins to overtop the road (or 
embankment, levee, etc.). This signifies the stage at which flooding of the crossing may start to 
cause embankment erosion, embankment failure, flooding hazardous for travel, and/or 
road/culvert failure. The lower of the two stages was chosen as the top of the inlet of the 
culvert (though, in the case of multiple culverts, this needs to be defined, and will be discussed 
in more detail later). This stage represents a likely scenario where velocities inside and exiting 
the crossing are likely to be high, which may result in downstream erosion of the channel and 
banks. Thus, for each return period flow at each crossing, a rating of Transitional is given when 
the calculated headwater depth is between these two stages, a rating of Pass is given when the 



13 | P a g e  
  

depth is below to top of the culvert, and a rating of Fail is given when the headwater stage is 
calculated to overtop the cross section above the inlet. It is important to note that there are 
rare cases where the headwater stage can breach the top of road before reaching the top of 
the culvert (perched culvert). In cases such as these, no Transitional rating can be given, and the 
first check for a rating would be for failure; so a headwater stage overtopping the cross section 
but below the top of the culvert would be rated as Fail and not as Pass, which may be 
confusing, but all the more reason to understand the geometries at each and every crossing. 

Aquatic Organism Passage (AOP) 
The New Hampshire state protocol for assessing culverts for AOP (borrowed directly from 
Vermont) involves using physical metrics of a culvert which approximate whether or not the 
conduit may be navigated by aquatic species. Of course, the actual capability of an individual 
organism varies greatly with age and abilities, among other things. But the metrics taken into 
account by the protocol may be used as a screen to help determine the likelihood any organism 
would be able to or desire to navigate a culvert. Since most movement by aquatic organisms 
occurs at other than the flood flows, the least-passable scenario is typically at lower flows 
where culvert geometry dominates AOP. In most cases, this would be the low-flow conditions 
when depths are lowest, and continuous waterways (in cases where the outlet is perched) are 
less likely. Thus, the model input data should be collected during periods of low-flow, or if 
unavailable, to be estimated for those occurrences. Some of these metrics are measureable in 
numbers, while others are observable properties such as inlet obstructions or the presence of 
native bed material within the culvert. The decision tree described in the assessment protocol 
then uses these values to determine a rating of:  Full AOP, Reduced AOP, No AOP except for 
Adult Salmonids, and No AOP for all species. 

It is important to note that in cases where there are multiple culverts at one crossing, the most 
passable culvert governs the rating for the site as a whole; if an organism can pass one, then 
other less-passable culverts would likely be ignored. Thus, the data entered into this section of 
the model should be for that of the most-passable culvert at the crossing.  

Geomorphic Compatibility (GC) 
The New Hampshire state protocol for assessing culverts for GC was also borrowed directly 
from Vermont, and uses a combination of measurable parameters and observational (best 
judgement) descriptions. There are five variables that each receive a score, and the sum of 
those give a total score for the crossing. The crossing is then given a rating based off that score, 
using thresholds defined in the GC published document. Since this screening guide involves text 
descriptions as well as measurable numeric values, some of the input values are more difficult 
to enter into this culvert model (things such as spelling might cause an error in a score assigned 
to a category). Thus, in addition to entering in the text data into the model, the user has the 
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option to enter the score for each variable, which is then used to calculate the overall score for 
each crossing. This may be a more error-free method rather than attempting to enter the exact 
text each time. 

Using the Model 
This model was created to provide rapid hydraulic, aquatic organism, and geomorphic 
compatibility analyses for multiple crossings, using relatively little data and effort. The data 
required to run the model are nearly a minimum for these types of analyses, and do not cover 
the full spectrum. 

There are 11 tabs (worksheets) that are shown to the user (more calculation and reference tabs 
are hidden), seven of which are data input tabs, two are documentation, and two are results. As 
best practice, the seven input tabs should be filled-out in sequence to help ensure that all the 
fields are completed, though they may be filled-out in any order the user pleases. Descriptions 
of each tab are detailed in the following text. 

It should be noted that in order to use one of the tabs (the Rating Curve Generator), the user 
must have the Solver Add-In loaded and enabled within their version of Excel. There are 
different ways to do this for different versions of Excel, therefore the instructions for this may 
vary. Please refer to online documentation for the best way to do so for your version of Excel. 
The add-in will remain loaded and enabled for the future after it is installed the first time, 
therefore this step is only necessary once. This must also be referenced in Visual Basic, in order 
for the coding to be able to run the Solver function automatically. Microsoft and other’s 
provide ample online documentation as to how to do this. As a general guide, to install the add-
in within Excel, click the Developer tab, then on the ribbon select Add-Ins. If Solver is not 
shown, browse to find it, and then be sure it is selected with a check mark. For Visual Basic, 
click the Tools tab, and select References. Then browse for Solver, (if it is not shown anywhere, 
you may have to browse for it and load it) and be sure that it is selected with a check mark. 

When looking at each input tab, all the cells that may be edited by the user will appear in two 
shades of yellow. Cells appearing in the darker yellow (               ) are variables that are required 
for that tab. Cells appearing in the lighter yellow (               ) are variables that are either 
optional or not required. On some of the tabs, after data is input to the cells, a cell may change 
color to look like this , highlighted in light orange, with italicized, dark-orange font. This means 
that the value entered into the cell is outside the recommended applicable range of values for 
that parameter. This does not necessarily mean an error; rather, this is simply meant to bring 
attention to this value, and make the user is aware of it – and that it is not a typographical error 
– and to indicate to the user that the resulting calculations may be less accurate due to the 
abnormal value. All the calculations will still be performed when this happens, but always 



15 | P a g e  
  

ensure the crossing input data is reviewed for accuracy. More detail on these warnings is 
provided in the descriptions of each tab, including the ranges of values that define these 
warnings. 

Information Tab 
This tab contains information pertinent to the model, and covers some of the detail in this 
document, in abbreviated fashion. It also specifies brief steps recommended for running the 
model, and lists some of the limitations and precautions to consider when using the model. 

Instructions Tab 
This tab contains instructions on how to use the model, in less detail than described in this 
manual. However, it does include specific and detailed information and tables for helping the 
user select the appropriate Culvert Type Reference Number, to be used in the Hydraulic Input 
tab. 

General Input Tab 
This tab covers the basic information pertaining to the crossings. All of the categories in this tab 
are optional except for the Crossing ID. The Crossing ID must be unique for each crossing 
modeled in this batch run, as these are referenced in subsequent tabs, and by code and lookup 
functions. The Town, Road, and Stream are all location identifiers for the crossing, and the 
Latitude and Longitude are for exact reference location (at the upstream end of the culvert). 
These may be entered into the model in any format the user chooses (degrees-minutes-
seconds, northing and easting, decimal degrees, etc.), as they are just for reference. The final 
column, Notes, is where the user may document any special notes about the crossing that they 
please. 

Peak Flow Input Tab 
This tab contains all the data necessary to calculate the expected flows coming to each crossing. 
The data for this tab may all be obtained online, and there is additional documentation 
accompanying the model that details how to gather all this data in batch via GIS software or 
methods (found at end of this document). 

However, there may be instances where the user prefers to Override the Peak Flows. This may 
be the case for a variety of reasons; a drainage area too small to be properly analyzed online, 
one where too little information is available or the parameters seem suspect, an urban 
watershed that may be incorrectly delineated online, or a basin that has been previously or 
more thoroughly analyzed and flows determined. This may also be used in the case where 
future conditions may be modeled (adding a multiplier to current conditions, for example). 
Future conditions may also be accounted for in the data (such as increasing curve numbers or 
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precipitation depths, lowering pond and wetland area). Therefore, optional flow override cells 
have been provided for such cases. Flows input here automatically override any calculations 
performed by data in the other cells on this tab, so only use these cells if this is desired. 

For the remainder of the cells, fill them all out in order for the model to calculate the peak 
flows – if a value is zero, enter 0 into the cell (this is not completely necessary, but is good for 
reference that the value is not missing, but rather a zero value). Also pay attention to units, 
these cells must be filled out with the correct units in order to perform the calculations 
correctly. Units for each data entry may be found at the top of the column for each data entry. 
Obtaining the data for these cells may be accomplished a number of different ways. It is up to 
the user to obtain the data in the manner they are most comfortable, and that which provides 
the most accuracy. Be sure to read through the Methods, Input, and Calculations section for 
details on exactly what data should be referenced or used. 

Drainage Area is entered in as square feet. The total contributing area to the watershed 
upstream of the culvert should be included. The Flow Path Length is hydraulic length of the 
watershed, and is used in the SCS Lag Equation to calculate peak flows. This length may 
generally be given as the longest distance water follows through the watershed. However, 
specifically it refers to the path that would take water the longest to navigate (time of 
concentration) before arriving at the outlet of the watershed (the crossing location, for this 
model). Next, the Flow Path Slope should be entered for two lengths; Overall and by the 10-85 
Method. The Overall Slope is for the slope of the Flow Path Length (the difference in elevation 
from the high point to the outlet of the basin, divided by the length), and should be entered in 
as dimensionless number. The slope by the 10-85 Method is calculated as the difference in 
elevation from a point at 85% up the flow path length from the outlet minus the elevation of a 
point at 10% the flow path length up from the outlet, divided by the length of the flow path 
between the two points (or 75% of the total Flow Path Length). This slope should be entered in 
with units of ft/mi (difference in feet of elevation per mile of travel distance). The Area of Ponds 
and Wetlands contained within the watershed should next be entered (enter 0 for basins 
without any ponds or wetlands). This is followed by the Runoff Curve Number for the 
watershed. If the user is unfamiliar with how to obtain this value, refer to online 
documentation and tables of values. There are many good resources that can provide insight 
and guidance. Following this, in the next six columns, values for precipitation should be 
entered. The first is the Average of the Mean Basinwide April Precipitation, followed by the 24-
hour Precipitation Depths for the 2-, 10-, 25-, 50-, and 100-yr storms. All precipitation data 
should be entered in inches. Following these precipitation depths, there is an optional input cell 
for defining the Rainfall Distribution Type. In New Hampshire, the southern and eastern part of 
the state is rainfall distribution Type 3: this is the model default value. However, if the culvert 
location lies within the area for Type 2 rainfall distribution, the user may define this using this 
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input cell (user inputs of:  yes, y, 2, II, or type 2). Finally, there is also a Notes column in the tab 
where the user may record any information they desire with regards to values, input, or 
otherwise. 

Of note, the data – when entered – may appear highlighted as a different color and italicized 
(example). There are certain windows for some of the values used in these calculations that the 
methods recommend, or have been calibrated with. Values that lie outside of the range for the 
select parameter appear this way in order to highlight these instances. The peak flow 
calculations are still performed, but the user should be aware that the methods may not apply 
correctly. On the Peak Flow Input tab, warnings may appear for the 10-85 Slope, Area of Ponds 
and Wetlands, Runoff Curve Number, Average April Precipitation and the five 24-hour 
Precipitation Depths. 

The warning for the 10-85 Slope indicates that this value is either less than 5.43 or greater than 
543 ft/mi. These are the limits for which the Regression Equations were calibrated. For the Area 
of Ponds and Wetlands, the Regression Equations were calibrated to watersheds containing less 
than 21.8% ponds and wetlands:   any value greater than that amount appears highlighted. The 
Runoff Curve Number cannot be larger than 100 (this would mean an error in entering the 
correct value, or an error in developing the value).  Documentation on the SCS method state 
that it does not necessarily apply to Runoff Curve Numbers less than 40. Again, the Regression 
Equations were calibrated to watersheds that had Average April Precipitations from 2.79 to 
6.23 inches:   any values outside this range will result with a warning. Finally, the 
documentation regarding the SCS method state that a watershed that sees an Initial 
Abstraction (Ia, effectively, losses of precipitation to the watershed) divided by any 24-hour 
Precipitation Depth (this ratio of Ia/P is used in the equations within the SCS method 
calculations – the user need not worry about this much) should not be less than 0.1 or greater 
than 0.5. Essentially, this parameter reflects the amount of the precipitation that becomes flow 
contributing to the flood hydrograph. A ratio too low means that most of the precipitation 
becomes streamflow, a ratio too high means that much of the precipitation is lost to the 
watershed. In either case, the method was not developed for values outside of this range. 

These warnings, and others that are not shown immediately on this tab, are also shown on the 
Results tab, under the Peak Flow Results section, with details about the additional warnings 
provided in the Results tab description in this document. 

Hydraulic Input Tab 
This tab contains all the input data necessary to perform the headwater stage calculations, as 
well as the site elevations required to determine the final hydraulic ratings. All of the input data 
for this tab should be collected in the field at each crossing site.  



18 | P a g e  
  

As described previously, the headwater depth due to inlet control is calculated using a 5th order 
polynomial equation, with coefficients unique to different combinations of inlet and pipe 
configurations. There are four parameters that determine which inlet control equation to use: 
pipe shape, pipe material, the pipe end type, and the pipe edge type. The first two are usually 
simple; the pipe shape describes the form of the opening (circular, box, elliptical, etc.), and the 
pipe material is the material which the pipe is made of at the inlet (concrete, metal, etc.). The 
second two are a bit less familiar; the end type describes the configuration at and around the 
inlet entrance (headwall, wingwalls, projecting, etc.), and the edge type describes the edge 
condition of the pipe at the inlet (sharp, square, beveled, etc.). For the purpose of this model, 
these four descriptors have been placed into a table that the user will need to read in order to 
define a Culvert Type Reference Number. This number tells the model which coefficients to use 
in the polynomial equation. The reason this number is used, rather than having the user enter 
in text descriptors for each parameter, is twofold. The first is simply to reduce error in entering 
a specific text string for each value. The second, and more complex reason, is that the 
appropriate Culvert Type Reference Number for an observed situation in the field may be 
different that the actual values for the parameters. This will be discussed in more detail in the 
following Culvert Type Reference Number section. There is much to outline about this one 
parameter, so first the remainder of the inputs on this tab will be documented. 

The first column on this tab is the Crossing ID. These values are referenced to the General Input 
tab, and should not be altered. Moving past the next four columns, which will be discussed in 
detail in the following section, the next four parameters are used to determine the inlet area. 
The first, and only required input for all shapes, is the Culvert Span. This refers to the width of 
the culvert (in feet). For circular culverts, this value is also used for the Culvert Rise (except for 
the case of an embedded circular culvert, where the effective rise – calculated internally within 
the model – would be the span less the embedded depth, though the actual culvert rise 
remains the same). The Culvert Rise is the next input parameter, and is required for all non-
circular culverts. This refers to the actual rise (height) of the culvert, not the effective rise (such 
as the case of an embedded box culvert, for example). If a culvert is embedded, the actual rise 
is required and what should be recorded here. The next parameter is the Culvert Wall Rise. For 
all culverts that are not identical when rotated 180 degrees, this is required to help define the 
shape of the opening, which the model uses to determine the area (based on the shape defined 
by the Culvert Type Reference Number – description to follow). This value commonly refers to 
the point at which the shape is at its maximum span, but more specifically is the point at which 
the shape changes geometry, measured up from the invert. For pipe-arch culverts, it would be 
the location of the maximum width. For concrete arches, this would be the point at which the 
arch begins. For some shapes, such as a metal arch, this value would be zero. Finally, the last 
parameter that may be required is the Embedded Depth. This is the depth of the substrate at 
the inlet of the culvert that is rendered ineffective flowable area. This should be recorded only 
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in instances where the culvert is actually embedded. A circular pipe placed into the bed of a 
stream is considered embedded. A culvert with sediment deposition, or blocked by beaver 
activity is not actually embedded. Though the capacity of the culvert is clearly reduced in these 
instances, these are considered to be maintenance issues and not issues pertaining to the 
culvert inlet headwater stage calculations. This may result in misleading ratings when thinking 
of the crossing at the day of the survey compared to the actual capacity of the crossing. Next, 
the Culvert Length (in feet) is required to be input. Following this, the Inlet Invert Elevation and 
Outlet Invert Elevation are required (feet). It is important to note that these refer to the actual 
invert elevations, not the elevation of any material that may be present causing the pipe to be 
embedded. If the actual invert of the pipe cannot be measured, it may be inferred by the 
culvert dimensions and the depth of the bed material. However, if the culvert is meant to be 
embedded, or is an open-bottom structure, then the elevation of the sediment is the correct 
elevation to use for the model. Something that may occur at a site, especially in open-bottom 
structures, is an irregular cross section of the channel at the inlet. In some cases, it may be 
minor enough to ignore. However, to account for this within the model (as there is no option 
for an irregularly shaped inlet) the user may develop an average depth of the cross section at 
the inlet, and enter this value into the Embedded Depth cell. The actual invert should still be 
recorded, but accounting for the irregular bottom in the Embedded Depth provides a more 
accurate representation of the total flowable area that exists at the inlet. In this case, the Inlet 
Invert Elevation would still be recorded as the elevation of the thalweg at the inlet, as this – 
together with the Outlet Invert Elevation and the Culvert Length – define the culvert slope, 
which in many cases is the applicable slope. However, with instances of upstream deposition 
or, or culverts with multiple slopes (broken back culverts), there may be the need to override 
the slope calculated by the inlet and outlet Invert elevations and the length. If this is the case, 
there is an Optional Culvert Slope override where the user may input a more appropriate value 
for the effective slope at the inlet of the culvert. The final elevation required for this section is 
the Failure Elevation. This is the elevation (feet) that when the headwater stage exceeds it the 
crossing is considered to be rated as Failing. This elevation may be standardized to the manner 
in which the user chooses:  when the headwater stage reaches the road surface; when the 
headwater stage reaches the necessary freeboard; when headwater stages reach a point that 
floods infrastructure upstream of the crossing; among any number of reasons that might be of 
critical interest to the user or to the project. Of note, this elevation should generally (though 
there are uncommon circumstances) be above the elevation of the top of the pipe at the inlet. 
This elevation – the top of the pipe at the inlet – is what the model uses as the definition 
between Passing and Transitional ratings. Also important to note for these elevations, and for 
all the elevations at one crossing location (used in this tab and others), the elevations do not 
have to be absolute (global). Elevations may be relative elevations set to any datum (and any 
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value for that datum) at each site. However, all the elevations (relative or global) at one 
crossing across the entirety of the model should be relative to each other. 

Moving along, the next two input variables are optional, the first of which is the Optional 
Number of Adjacent Culverts. As detailed previously in the Limitations and Precautions section, 
this model is only able to analyze one type of culvert at one crossing. Crossings with identical 
culverts at the same elevations may be analyzed using this input cell, defining as many identical, 
parallel culverts as exist at the site. Unfortunately, where crossings have multiple, dissimilar 
culverts, some sort of adjustment must be made. There is no easy, standard way to do this, so it 
is up to the user to account for this using their best judgement. The most important thing to 
keep constant when combining multiple culverts into one shape, is to ensure that the invert 
elevation and the rise remain almost – though exactly is best – the same, and to adjust the 
shape and the width as best as possible in order to match the total flowable area for the new, 
singular, representative culvert to the combined total flowable area of all the culverts that 
actually exist at the site. Remember, the Inlet Invert Elevation and the Culvert Rise are used to 
determine the top of the pipe at the inlet, and the inlet control headwater elevations; therefore 
these are quite important to keep as close to the same as possible. This step may be challenging 
at times, and it is up to the user to use their best judgement. Finally, the Optional Culvert Slope 
has been described previously, and is an optional input the user may enter for a crossing that 
may better define the slope should that be deemed necessary. 

Similar to the Peak Flow Input tab, some cells containing values may appear highlighted in light 
orange with dark orange, italicized text (example) to convey a warning to the user. Again, the 
calculations for the inlet control headwater depths are still performed, but the user should be 
aware that some of the entered values may be outside the recommended ranges for some 
parameters. 

On the Hydraulic Input tab, there are warnings for Culvert Span, Outlet Invert Elevation, and 
Failure Elevation. In the FHWA’s HDS5 publication, and in the manual for HY-8, it is suggested 
that culverts with a span greater than 20 feet may be too large to properly be governed by the 
equations used in HY-8. Spans larger than this will appear with a warning. However, caution 
should be taken in that spans much smaller than this may still be better represented by open 
channel flow calculations than by the equations used in the model; the culvert hydraulic 
function fundamentally relates flow to the flowable area. However, since this flowable area is 
not readily defined anywhere in either publication, the 20-foot span warning is all that is used 
in this model. A warning is shown for the Outlet Invert Elevation when this elevation is higher 
than the Inlet Invert Elevation. This results in a negative slope, which is unworkable in the 
equations built into the model. When this occurs, the model automatically defaults to a flat 
(0%) slope. Thus, this warning alerts the user that either an incorrectly input elevation value 
was recorded/entered, or that the crossing may need further analysis to properly assess the 
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hydraulic capacity. Finally, a warning is shown for a Failure Elevation that is lower than the top 
of the culvert. While this is entirely possible, and in no way diminishes the model’s hydraulic 
analysis, this warning is simply to aid QA/QC by helping to ensure that all the data has been 
entered correctly. 

These warnings, and others that are not shown immediately on this tab, are also shown on the 
Results tab, under the Hydraulic Results section, with details about the additional warnings 
provided in the Results tab description in this document. 

Culvert Type Reference Number 

The Culvert Type Reference Number has been a source of confusion for many users who used 
Version 1 of this model. This is not something that is used in other places, or by any other 
source; it is unique to this model. The number is simply determined by the user to describe 
unique combinations of inlet conditions that are condensed down to one, easily referenced 
value. This value – the Culvert Type Reference Number – is then used by the model to select the 
appropriate inlet control polynomial coefficients (from a large reference table of values).  

The Culvert Type Reference Number condenses inlet geometric variables down into a number 
that then is used for hydraulic calculations.  

There are four properties that are used to define the Culvert Type Reference Number; the 
Shape, Material, End Type and Edge Type. The former two properties are straightforward and 
are likely familiar to many users; the latter two may be less familiar to users. When describing 
the culvert properties, the End Type refers to the layout of the site immediately surrounding 
the culvert inlet; features such as the presence of headwalls, wing walls, or if the culvert is 
projecting from the embankment. The Edge Type describes the condition of the edge of the 
culvert; whether it is sharp or thin, has a square or beveled edge, or perhaps is grooved. For the 
purpose of creating a simple sorted table for the user to use in selecting the Culvert Type 
Reference Number, the End and Edge Types have been combined into one description. Thus, in 
the Instructions tab in the model, the user is asked to refer to the table, Selecting the Culvert 
Type Reference Number.   First find the appropriate Shape, next the Material, then the End and 
Edge Type, and selecting the number which corresponds to those four conditions. For many 
crossings, this may be an easy task; for others, this may be a bit more difficult, as there may be 
configurations present without a well-defined Culvert Type Reference Number available in the 
table. 

The hydraulic calculations associated with flow into culverts combine the aspects of flow 
through pipes and open channels. There are many factors that create chaotic conditions almost 
impossible to model completely. In order to simplify the analysis and to estimate the expected 
hydraulic losses due to inlet conditions, the FHWA tested different combinations of inlet 
configurations under lab conditions, recorded the results, and developed plots of the data. 5th-



22 | P a g e  
  

order polynomial equations were fitted to the data and these are the equations embedded 
within this model; defining the Culvert Type Reference Number tells the model which 
polynomial coefficients to use. However, the FHWA developed these equations under lab 
conditions, and their purpose for doing so was to create equations used for designing culvert 
crossings. This model is meant more for estimating headwater stages at existing crossings. 
Thus, there may be ambiguity between what is observed in the field and what are available as 
options when defining the Culvert Type Reference Number. Existing crossings may be over 100 
years old and may contain very old infrastructure – like rock arches, rusted-out metal culverts, 
old iron paper mill rolls, and many more. None of these examples are standard culverts or 
would even be recommended – let alone permitted – to be used for the purpose of designing a 
crossing today. It is highly likely that many existing crossings will have properties that are not 
well defined, if even found, as options for determining the Culvert Type Reference Number. 

Model users should use their best judgement to select the most appropriate number associated 
with the most similar conditions found in the field. It is recognized, in practice, this is not always 
an easy task.  

First and foremost; try not to overthink this step. Remember that this model is meant as a 
coarse screening tool, and that thorough analysis is beyond its capabilities. Though not 
universally true, the most important factor in determining the capacity of a culvert is the 
flowable area of the culvert (the open cross section at the upstream entrance). If the culvert is 
oversized, the inlet conditions will have a much smaller overall impact. Therefore the most 
important information the user can develop in order to create the most accurate calculations is 
to obtain the correct sizing of the culvert which is used in calculating the culvert area. Of 
course, in doing this, defining the proper shape is important – the shape determines which area 
formula the model uses. This is usually the easiest part in determining the Culvert Type 
Reference Number. The more difficult part is determining the End and Edge Type. Try to 
estimate this as best as possible for the conditions present at each site. If the exact 
configuration is not available as an option, try to think about the configuration as it is observed 
in the field and how efficient or inefficient that configuration may be at conveying flows; for 
example, wingwalls direct flows into a culvert more efficiently than a square headwall. There 
are no universal truths associated with the inlet configurations for existing installations, 
therefore detailing an exact, ordered, relative-efficiency list of the configurations is not 
available. As a general guide for the four properties that describe the Culvert Type Reference 
Number, the most important and influential property to determine is the Shape. The next most 
influential property is the End Type, followed by the Edge Type, with the Material as the least 
influential property. This is due to the fact that the roughness described by the material has a 
larger impact on smaller culverts than larger ones. However, smaller culverts (at least, ones that 
would be more influenced by the material roughness) would not necessarily be applicable to 
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this model. These culverts would be more characteristic of drainage culverts than stream 
crossings. While smaller culverts may absolutely be analyzed in this model, most likely users will 
be interested in culverts that are larger, and to which the material would have the smallest 
impact. In terms of overall performance of the inlet configuration, the Material and End and 
Edge Type have far less impact on the headwater stages than the Shape or flowable area. 
Though, as good practice, properly attempting to describe all variables  is important. In an 
attempt to help the user select the appropriate End and Edge Type for a site without an exact 
configuration being listed in the model, the following guidance is offered: 

End Types: Wingwalls → End Section → Headwall → Mitered → Projecting 
Edge Types: Beveled → Grooved → Square → Thin 

These Types are listed in the order of most hydraulically efficient to least hydraulically efficient. 
This relative performance may be used as a guide to help the user best select a Culvert Type 
Reference Number that may best approximate the conditions in the field. If a crossing looks to 
be fairly efficient, select a more efficient configuration. The same goes for less efficient inlet 
conditions.  

Multiple Culverts 

Modeling multiple culverts at a site is challenging. This model, in keeping it as simple as 
possible, only performs calculations for one culvert at a time. Therefore at crossings with 
multiple culverts, assessing them in the model may be accomplished several ways.  The more 
accurate method is suggested herein. In situations with multiple culverts, model each 
individually, at the design flows as well as smaller flows (since not all of the design flows will 
pass through just one culvert).  At this point you will have a hydraulic rating curve for each of 
the individual culverts (headwater depth versus flow in each culvert).  Next, develop the rating 
curve for the system of culverts.  To do this, start by selecting a fixed headwater depth.  Next, 
from the individual culvert rating curves, read the flow through each culvert for that headwater 
depth.  Add these flows together and that is then one point on the multiple culvert hydraulic 
rating curve.  Select another headwater depth and repeat until the combined flows cover the 
range of the desired flood flows.  With the rating curve for the multiple culverts you may then 
apply the hydraulic rating criteria. 

Pipe Arches 

One final important note of the Hydraulic Input tab as it relates to the Pipe Arch culvert shape. 
Pipe arches come in many sizes, with each size having variable values to describe their overall 
shape. There are usually three radii associated with the pipe-arch shape:  one radius each for 
the top, bottom, and corner curves. These three radii vary with their lengths, depths, and 
widths across manufacturers and size classifications. Therefore, there is no single formula to 
determine the actual area of a pipe arch from a nominal size due to the infinite geometric 
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possibilities between manufacturares. In HY-8 this is remedied by having the user select a size, 
from which it determines the area using a manufacturer’s table of values. Selecting sizes is not 
an option in this model, rather the cross sectional pipe arch area is estimated using the 
equation for an ellipse. This was found to be quite accurate. In a comparison of the pipe arch 
sizes and areas listed in HY-8 to the areas calculated by the ellipse equation as part of the 
development of this model, it was found that the range of variability was anywhere from 88-
117% of the actual value. And while that is the full range of variability between the actual 
versus the calculated areas, most areas were calculated to be much closer than that. Of all the 
sizes, 80% were calculated within +/- 2.5% of the listed area, and 90% were within +/-5%. Thus 
allowing the user to enter pipe arch dimensions of span and rise and calculating the area from 
those two variables in the ellipse equation is a reasonable approximation. However, the user 
should be aware that this is not universally true; an area calculated to be 117% the size of the 
actual area will have a strong effect on the calculated headwater stages. When a Pipe Arch is 
present at a site, all its appropriate descriptions should be collected, and the actual area should 
be read from published sources or measured. Many manufacturer sources are available online, 
as well as in the documentation for HY-8, and even within HY-8 itself. The user may then decide 
to enter a slightly different Span (though the Rise should remain the same) for the Pipe Arch 
just in case the published area is different than what is calculated. 

Tailwater Input Tab 
This tab is a new addition to Version 2 of the model. It accounts for headwater effects resulting 
from downstream conditions. Most commonly, the model will use the tailwater stages 
calculated by Manning’s equation. However, there are other instances – such as tidal, 
backwater from dams, flooding from other rivers – that may require user definition of the 
tailwater elevation. Technically, this tab is not required, as headwater stages are still calculated 
for the inlet control calculations. However, as best practice, this tab should be completed. If the 
water elevations for the tailwater control are larger than those for the inlet control, the 
tailwater elevation will be the controlling headwater driver. The Tailwater input cells include a 
Water Surface Elevation for each of the five return period flows, and a column for Notes 
regarding any of the crossings. 

This tab may be filled-out in one of two ways. First, the user may opt to input the values 
manually, as would be the case for situations such as tidally-influenced backwater, some 
constant pool of water throughout the culvert, or tailwater elevations due to damming 
downstream from the crossing. However, the user may also calculate the water stages using 
the Rating Curve Generator in the following tab. Instructions for the use of this generator are in 
the following section, and briefly described on the tab. 
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As with the two previous tabs, warnings are shown for cells with Tailwater Water Surface 
Elevations – at any of the five return period flows – that are higher than the Inlet Invert 
Elevation. Again, all the calculations are performed to determine headwater stages for inlet 
control; however, with backwater possible within the system this may have a large effect on the 
actual hydraulic capacity of the crossing. The warnings shown on this tab are meant to inform 
the user that additional analysis may be necessary to more accurately assess culvert hydraulics. 
Additionally, if the user sees that a large number of crossings display warnings, it may serve as a 
general notice that the culvert collection as a whole may be misrepresented by the inlet 
equations alone. 

These warnings, and others that are not shown immediately on this tab, are also shown on the 
Results tab, under the Hydraulic Results section, with details about the additional warnings 
provided in the Results tab description in this document. 

Tailwater Rating Curve Generator Tab 
This tab is also a new addition to Version 2 of the model. This tab is only to calculate water 
stages at the downstream tailwater control cross section (downstream of the outlet of the 
crossing). This generator may only be used if the Solver function is referenced and enabled in 
both Excel and Visual Basic, as described previously.  

Essentially, what this generator does is to calculate the water stage at the tailwater cross 
section for each of the peak flows. This is not a simple calculation but rather it is an iterative 
process. This is the reason the Solver function needs to be enabled; Solver determines the 
water stages iteratively by varying the stage, calculating a flow, finding the difference in that 
flow to that defined for each Peak Flow, and adjusting the stage until the difference in flows is 
zero.  

There are brief instructions on the tab as to how to use the generator, as a listed order which 
the user should follow. Follow the steps in order to ensure that the generator works properly. 
If, at any time, the generator produces an error or you wish to stop the process, press the 
escape key and end the macro. Before starting this generator, the user must first have 
completed both the General Input and Peak Flow Input tabs. This allows the generator to 
reference values from both and calculations resulting from that input. 

To use this tab, the user will need to survey a cross section at the location of the tailwater 
control. This tailwater control point can almost always be estimated by the location of the 
highest thalweg elevation point downstream of the pool at the outlet of the culvert (the riffle 
head at the end of the scour hole). Often, at a stream crossing, there will be a scour pool at the 
downstream side of a culvert, usually caused by high culvert exit velocities eroding the stream 
bottom there. At the end of this pool, the stream channel has a higher elevation than the 
elevation of the bottom of the pool. This is the recommended location for the Tailwater Cross 
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Section. At this location, a cross section should be surveyed using Station and Elevation data, 
and the channel slope (TW Slope) estimated from this tailwater cross section on downstream. It 
is important to note that the elevation data entered here does not need to be tied-in to global 
elevations; but they do need to be referenced to the same datum as all other elevations at one 
site that are entered into this model. In addition to the stations and elevations, the user will 
need to estimate and record the values for Manning’s Roughness Coefficient (Manning’s n) for 
both the channel (usually applies from toe of bank-to-toe of bank) and the floodplain. There are 
many sources that can provide the user details on how to calculate/estimate these coefficients, 
and there are many more that provide approximate values for different scenarios. Please 
consult online documentation for more information regarding the Manning’s n. 

To start, the user must enter the Crossing ID. This is used by the tab to find the peak flows and 
reference them into the table below this input cell. Next, the user will enter the TW Slope in 
ft/ft. This refers to the downstream slope of the channel, starting at the location of the 
Tailwater Cross Section. Finally, the user needs to enter the cross section information into the 
User-Entered Tailwater Cross Section table, using Stations and Elevations. The third column in 
this table requires Manning’s n to be entered. This should be estimated in the field, or in the 
office from site pictures and understanding streambed materials. The value for Manning’s n 
applies from the station that it is entered next to, on to the next station entered (horizontally 
variable Manning n):  technically one is not required for the final station entered; however, one 
is required for all others. 

When data entry for this tab is complete the user should press the Calculate Rating Curve 
button. The rating curve is then computed and displayed in the adjacent table of Results, as 
well as display the cross section and water surface elevations (WSEL) on the Tailwater Cross 
Section and Flow Stages Plot. This should be reviewed by the user to inspect if the results look 
reasonable. If it does, the user may then press the Copy Values to Tailwater Input button to 
copy the values to the Tailwater Input tab. When this is done, the user may reset the sheet by 
pressing the Reset Sheet button. 

Of note, if the Tailwater Cross Section entered into the tab is not large enough to convey the 
peak flows for the crossing, the user will get a warning, and the macro will end. Without a 
channel large enough to convey the flows, the generator cannot achieve a solution. The user 
will then need to obtain/estimate additional cross section data points in order to make the 
cross section large enough to carry the flows. When collecting this data in the field, be sure to 
capture more than enough data to properly use this generator.   

AOP Input Tab 
AOP screening is another new addition to Version 2 of this model. This tab is optional to 
complete, but provides the user with an aquatic organism passage (AOP) rating. If there are 
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multiple culverts at a crossing, the information entered for a single crossing on this tab should 
be for the most-passable culvert at the site. The reasoning for this is simple: if one culvert is 
more passable than another, this would likely be the path an organism would take, rather than 
a more difficult one.  If what is considered the most passable culvert is impassable, then the 
other culverts are not passable.  They of course could be individually rated with this model. 

If an AOP rating is desired, all the cells in this tab are required except for the Outlet Pool Low-
Flow Water Elevation, which is only required when there is a low-flow water stage present at 
the outlet. This may not be the case for all crossings – some crossings may be dry during low-
flow conditions (ephemeral or intermittent streams). In this case, the model uses the Tailwater 
Control Profile Point Elevation as the surrogate for the Outlet Pool Water Elevation. 

Of note, this input is of a slightly different format than what is collected as part of the NHDES 
Culvert Assessment Protocol. Parameters collected per the NHDES protocol include 
combinations of elevations and depth readings. The data may be transformed from one format 
to the other, with all the input into this model telling the same story as that collected as part of 
the NHDES protocol. Since this model (especially for the hydraulic calculations and input) relies 
heavily on local site elevations, for the purpose of simplicity and consistency within the model, 
the input on the AOP Input tab is in elevation format, rather than the depth format seen in the 
NH Culvert Assessment Protocol. 

The first column on the tab is automatically populated from the Crossing IDs entered in on the 
General Input tab. Next is a column with a simple Yes or No answer and asks the user to define 
whether or not there is an Inlet Obstruction present. Obstructions may be of any type, from 
trash racks to log jams to sediment aggradation and so on. Next is a column for the Number of 
Culverts present at the site. It is important to note that this refers to the number of main-
channel culverts at a site, not floodplain or overflow culverts. Following this is a column for the 
Outlet Invert Type. The input here may be of the format “A” or “At Grade”; “B” or “Backwater”; 
“C” or “Cascade”; and “F” or “Free Fall”. These types may be researched more in the state’s 
Aquatic Organism Screening Tool documentation, but in brief: 

At Grade – refers to an outlet that has an invert at the thalweg of the stream, with the 
culvert and outlet having slopes relatively close to that of the stream channel. 
Backwater – refers to an outlet that has a constant stage of water over the invert, even 
at low-flows, caused by downstream controls. 
Cascade – refers to an outlet that has an invert that rests on stream material, but whose 
slope is much steeper than that of the rest of the channel; often resulting in cascading 
water over the surface. 
Free Fall – refers to an outlet with an invert that is perched above the water elevation of 
the downstream pool at low-flows. 
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The next two columns on the tab both have Yes or No input. A culvert with natural stream 
substrate throughout the length will have Yes input for Natural Bottom, and the presence of a 
pool just downstream of the outlet will also have Yes input for the Outlet Pool column. The next 
five columns are all elevations taken at locations along the profile of the stream and culvert: the 
Outlet Invert, Outlet Pool (which refers to the elevation of the bottom of the pool immediately 
downstream of the culvert), the Tailwater Control (discussed previously); and two elevations of 
the water surface along the profile: the Outlet (elevation of the water surface at the outlet of 
the culvert), and the Outlet Pool (the elevation of the water surface at the pool downstream of 
the outlet; preferably taken at the same location as the Outlet Pool profile elevation). Finally, 
there is a column for any Notes related to the AOP Input at the end of the table. 

Please refer to the state’s Aquatic Organism Screening Tool for further detail on the methods 
and variables for the AOP screen rating and data. 

GC Input Tab 
This tab is another update from Version 1 of the model. It is an optional tab to complete, but 
provides a rating for Geomorphic Compatibility for the crossing if filled out. The tab uses input 
that derives directly from the state’s Geomorphic Compatibility Screening Tool (which was 
borrowed directly from Vermont – refer to the Vermont Culvert Geomorphic Compatibility 
Screening Tool, 2008, which may be found in the References section of this document). 

The screening tool uses physical and observational metrics contained within five individual 
variables, with each variable then being assigned a score of 0 to 5, and the sum of those five 
scores giving a GC rating to the crossing.  

The data used to score each variable is only sometimes measurable in this screening tool; other 
times it is observational. Thus the recorded data for this screen contains a lot of text, and is 
subject to interpretation among observers. It is common practice that when this data is taken in 
the field, a score is immediately assigned for each variable. Therefore, this tab may be filled out 
in one of two ways: first, by filling out all the input cells with the actual, observed or measured 
values; or second, by entering in the individual scores for each variable. The second method is 
preferred, as entering the five scores in number format is easier than entering in each of the 
text or numerical values associated with the first method, but either way works. A combination 
of the two methods may be used as well. 

Please refer to the GC Screening Tool documentation listed in the References section for a more 
robust explanation of the screening tool and all of the variables and input used. 

To enter in the scores for each variable, the five columns to the right of the table may be used 
(the final column is for Notes pertaining to the GC Input tab for each crossing).  

The first column is automatically populated using the Crossing IDs from the General Input tab. 
The first input tabs next to this are for the Bankfull Width and Bankfull Mean Depth, both in 
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feet. These both refer to the bankfull dimensions of the stream near the crossing, and should 
be measured at a location upstream or down where good geomorphic indicators exist for 
obtaining each, and where the effects from the crossing are not present. The next input column 
is a Yes or No answer to whether or not there is Upstream Aggradation of sediment at the inlet 
to the crossing, and if so the depth of that aggradation recorded in feet in the next column, 
under Depth of Upstream Aggradation. The next column asks for a Yes or No response whether 
or not there is scour of the channel bottom at the outlet of the culvert (Downstream Scour), 
followed by a description of the bank heights by either rating them as High or Low in the 
Downstream Bank Height column. The next two columns are Yes or No answers, and refer to 
the culvert slope, stream slope, and valley slope. In the first, the culvert slope is compared to 
the stream slope, and is rated whether or not they are similar (Same Structure and Stream 
Slope). The second slope column (Local Break in Valley Slope) asks whether the crossing is 
located at a break in the valley slope. This may be most accurate to define using a topographic 
map and/or a computer, rather than at the site. Following this is a rating for the Approach 
Angle of Stream to Crossing, which defines the approach angle of the stream with relation to 
the culvert, and can be rated as: Natural (meaning naturally straight into the culvert); 
Channelized (meaning that the stream is entering the culvert straight-on, but that it was altered 
to do so); Mild (meaning that the stream enters the crossing at a mild angle); or Sharp (meaning 
that the stream enters the crossing at a sharp angle). The next two columns define whether or 
not there is erosion of the streambanks at the upstream or downstream end of the crossing 
(Upstream Erosion and Downstream Erosion columns). These two may be filled out using the 
responses of None, Low, or High. Finally, the column for Crossing Armoring details whether or 
not there is armoring present at the crossing, and if so whether it is intact or failing. This 
column may be filled out with responses of None, Intact, or Failing. 

With the cells filled out, the scores are either summed together (for the optional user-entered 
scores) or determined from the input then summed (for when individual input cells are filled 
out). The sum of the five individual scores produces a total score, which is then used to rate the 
crossing. Please refer to the Geomorphic Compatibility Rating section of this report for a full 
description of the ratings and the score ranges for each rating. 

Ratings Tab 
After completing all of the previously described tabs and all required or optional input, the full 
table of all the ratings may be seen on this Ratings tab. There are three tables, the first of which 
shows all the Crossing IDs and some locational information (Town, Road, and Stream), followed 
by the five Hydraulic Ratings (2-yr, 10-yr, 25-yr, 50-yr, and 100-yr), the AOP Rating, and the GC 
Score and GC Rating. Following this table are the Ratings At-A-Glance, which is a very brief 
summary of the ratings in a condensed manner, with the columns being very thin. This may be 
useful for the user to quickly look at a row and see, using coloring for the ratings, how the 
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crossing performs across all three assessments. If a row is all green, the crossing is performing 
well; conversely if there is a lot of red in a row, the crossing is failing one or more criteria. 
Finally, well to the right side of the tab, there is a table which shows the Ratings Key. This table 
describes the meaning of each of the Ratings in a little detail.  

Hydraulic Ratings 

Hydraulic Ratings are given for each of the five calculated peak flows. Hydraulic ratings of Pass, 
Transitional (shown as Trans), and Fail and are highlighted in green, yellow, and red, 
respectively. As described previously, these ratings describe the relative headwater stage at the 
inlet from each of the peak flows. The ratings are defined by two elevation points: the top of 
the culvert at the inlet, and the user-defined Failure Elevation, input by the user on the 
Hydraulic Input tab. The Failure Elevation may be any elevation the user chooses to reference, 
and may vary from site-to-site. What it should refer to is any critical elevation which, when the 
headwater stage reaches it, is considered hazardous or may result in damage to infrastructure. 
Most commonly this will occur at the elevation where water would begin flowing over the road; 
in other instances it is the elevation at which the water floods upstream infrastructure or 
bypasses (flanks) the structure in the case of perched roads. This stage is only input into the 
model to define when the user would like to see a rating of Fail. 

Thus, any peak flow that results in headwater stages that are below the top of the culvert at the 
inlet are rated as Pass. Any peak flow resulting in a headwater stage above the Failure Elevation 
is rated as Fail, and any headwater stage between the two elevation points is rated as 
Transitional. 

Aquatic Organism Passage Rating 

This section of the table displays the AOP Ratings resulting from the input on the AOP Input 
tab. The ratings are assigned as defined in the New Hampshire AOP Guide. The ratings are:  Full 
AOP, Reduced AOP, No AOP – Adult Salmonids, and No AOP, all highlighted in green, gray, 
orange, and red, respectively. A rating of Full AOP means that the crossing is likely to be 
passable by any aquatic organism. A rating of Reduced AOP means that the crossing likely is 
challenging or less desirable for organisms to navigate due to one or more factors. A rating of 
No AOP – Adult Salmonids means that the crossing is likely impassable for all aquatic organisms 
except for adult salmonids, which are much better swimmers and leapers than most other 
species. Finally, a rating of No AOP means that the crossing is likely impassable to all aquatic 
organisms, including adult salmonids. 

Geomorphic Compatibility Rating 

This section of the first table on the Results tab shows the Geomorphic Compatibility Rating 
and the Score calculated from the GC Input tab. The Geomorphic Compatibility Rating is based 
on the New Hampshire State Protocol. 
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Essentially, there are five categories included in the assessment that each receives a score from 
0 to 5. The sum of the individual scores gives the crossing a total score, and this is rated based 
on the total score out of the maximum possible 25, in increments of 5. This rating is meant to 
assess the crossing for its compatibility with the natural fluvial geomorphic characteristics of 
the stream – basically how the stream transports sediments and debris. If the crossing is a 
barrier to the transport of materials, an imbalance occurs, and may result in erosion, 
deposition, instability, and/or failure. 

Geomorphic Compatibility Rating Key 

Rating Score Range Description 

Fully 
Compatible 20 < Score ≤ 25 

Structure fully compatible with natural channel form 
and process. There is a low risk of failure. No 
replacement anticipated over the lifetime of the 
structure. A similar structure is recommended when 
replacement is needed. 

Mostly 
Compatible 15 < Score ≤ 20 

Structure mostly compatible with current channel form 
and process. There is a low risk of failure. No 
replacement anticipated over the lifetime of the 
structure. Minor design adjustments recommended 
when replacement is needed to make fully compatible 

Partially 
Compatible 10 < Score ≤ 15 

Structure compatible with either current form or 
process, but not both. Compatibility likely short-term. 
There is a moderate risk of structure failure and 
replacement may be needed. Re-design suggested to 
improve geomorphic compatibility. 

Mostly 
Incompatible 5 < Score ≤ 10 

Structure mostly incompatible with current form and 
process with a moderate to high risk of structure 
failure. Re-design and replacement planning should be 
initiated to improve geomorphic compatibility. 

Fully 
Incompatible 0 ≤ Score ≤ 5 

Structure fully incompatible with channel and high risk 
of failure. Re-design and replacement should be 
performed as soon as possible to improve geomorphic 
compatibility 

The first column in the GC Rating section is for the Total Score, which is the sum of the five 
individual scores. Next to this is the Rating, which a crossing is rated as Fully Compatible, 
Mostly Compatible, Partially Compatible, Mostly Incompatible, or Fully Incompatible, and are 
colored light green, dark green, yellow, orange, and red, respectively. The table shown on the 
previous page summarizes the Rating, the Score Range, and contains a description of each 
Rating. 
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Results Tab 
This tab shows some of the calculated results from the model, in addition to the three ratings. 
These results describe in more detail some of the key values and descriptions used in the final 
ratings, as well as any warnings that may be present for the data entered for any crossing. 

The first section of the table of results contains General Information which is referenced 
directly from the General Input tab. After this is a section for the Peak Flow Results. Contained 
within this section is the Watershed Area (in acres), followed by the Calculation Method that 
the model determined as being the appropriate method to calculate the five peak flows. The 
next five columns all show the calculated peak flows (in cfs); followed by the last two columns, 
which detail whether or not there are warnings associated with the data entered to calculate 
the peak flows, and the warnings. The Peak Flow Warning Type(s) are each separated by a dash 
(-), and are subject to the constraints detailed in previous sections of this document. The short 
codes are: Pa (Average April Precipitation), %W (Percent Ponds and Wetlands), S (10-85 Slope), 
Ia/P (Ia/P Ratio; the ratio of intercepted precipitation over the total precipitation amount), Cn 
(Curve Number), and Tc (Time of Concentration). 

The next section of the table is for the Hydraulic Results. The results shown here first contain 
the Total Flowable Area of the structure(s) at the crossing, followed by the Bankfull XS Area 
from Regional Curves, which calculates the ‘natural’ flowable area of the stream based on the 
Drainage Area, using equations developed for New Hampshire. The ratio of the structure 
flowable area at the crossing to the calculated bankfull area is then shown as a percent in the 
next column, % Flowable Area to Bankfull Area. The following three columns show the same as 
the three previous ones, only for the culvert and bankfull width instead. The next two columns 
detail whether or not there are any warnings present for the entered data, and the specific 
warnings. The short codes for the Hydraulic Warning Type(s) are: NS (Negative Slope), LS (Low 
Slope), W (Wide Span), and F (Failure Elevation lower than the Top of Pipe at the inlet). 

The final four sections of the results table show the same ratings for the three rating types, 
seen on the previous tab, with the exception of the GC Results section. This section simply 
shows the calculated or user-entered individual scores for the five variables used in 
determining the GC Rating.  

Statistics Tab 
This is the final tab in the file and simply shows the ratings for all three rating types as 
quantities and percentages of the total number of crossings analyzed. For the hydraulic ratings, 
the results are tabulated for all five return periods (2-, 10-, 25-, 50-, and 100-yr), and shown as 
pie charts for only the latter four of those return periods. The AOP and GC ratings, if the user 
has opted to enter this data, show the total number of crossings per each rating in pie charts 
for each of the two rating types.  
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https://pubs.usgs.gov/sir/2008/5206/pdf/sir2008-5206.pdf
https://streamstatsags.cr.usgs.gov/streamstats/
https://streamcontinuity.org/pdf_files/nh_stream_crossing_guidelines_unh_web_rev_2.pdf
https://streamcontinuity.org/pdf_files/nh_stream_crossing_guidelines_unh_web_rev_2.pdf
http://dec.vermont.gov/sites/dec/files/wsm/rivers/docs/rv_VTCulvertGCScreenTool.pdf
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Vermont Agency of Natural Resources. (2009). The Vermont Culvert Aquatic Organism Passage 
Screening Tool. Department of Fish and Wildlife.  
http://dec.vermont.gov/sites/dec/files/wsm/rivers/docs/rv_VTAOPScreeningTool.pdf 

 

Note:  all cited web links last accessed 22 May 2017 

 

http://dec.vermont.gov/sites/dec/files/wsm/rivers/docs/rv_VTAOPScreeningTool.pdf
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StreamWorks-TU Culvert GIS Model Instructions 

Authors: 
This protocol was originally authored in the model version 1 by Apollinaire William of Antioch College.  
For version 2 the methodology was refined by David Justice with NH GRANIT.   Tom Taggart and 
Robert Cole with NHDES then further modified the content to mesh with NHDES needs.   
 
Introduction 

 

The objective of this GIS model is to generate watershed characteristics such as area, slope, longest 
flow path, SCS curve numbers, coverage by wetlands, ponds and lakes, and precipitation distribution 
for any given storm event. These parameters are necessary for the computation of runoff and are 
essential for running a hydraulic model. The overall goal of the GIS modeling is to assess the hydraulic 
capacity of existing road stream crossings within the watershed. 

 
Data Requirements – Listing the data sources that are used in the model 

Data from NH Granit - http://www.granit.unh.edu/ 
o Digital Elevation Model (DEM) - 1m resolution  
o Soil Survey Geographic (SSURGO) database for New Hampshire - last revised in 2009 
o New Hampshire Land Cover Assessment - 2001 - 30m resolution 
o NH DOT Road Network - Scale: 1:24,000. 
o New Hampshire Hydrologic Dataset (NHHD) - Scale: 1:24,000 

 

Other datasets 
o 30-year normal- Precipitation: The normals are baseline datasets describing average monthly 

precipitation (mm) over the period 1981-2010. Monthly values in April were chosen to use 
with this model because they correspond to maximum precipitations for this area (New 
Hampshire).  
 Source: http://www.prism.oregonstate.edu/normals/. 

o Rainfall data for select recurrence interval storms: 2-10-25-50-100-year rainfall.  This data is 
available in gridded ascii file format from Cornell , at 0.8 km resolution; units are in 1000 x 
inches. 
 Source:  http://precip.eas.cornell.edu/ 

o Wetlands, ponds, and lakes from National Wetlands Inventory (U.S. Fish and Wildlife Service) . 
(CONUS_wet_poly layer).  
 Source:  http://www.fws.gov/wetlands/Data/State-Downloads.htmlShapefile for New 

Hampshire  

http://www.granit.unh.edu/
http://www.prism.oregonstate.edu/normals/
http://precip.eas.cornell.edu/
http://www.fws.gov/wetlands/Data/State-Downloads.html
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Software requirements 
o ArcGIS (with Spatial Analyst) 
o ArcHydro tools – Installation instructions follow   
o HEC-GeoHMS  – Installation instructions follow   

 
Note: 
Arc Hydro Tools are free with your ArcGIS software license. Download from: 
http://resources.arcgis.com/en/communities/hydro/01vn00000010000000.htm  
 

Project Folder and ArcMap Setup 
1.) Create a folder on C:\ named appropriately for the area of interest. It is best to keep the name 

under 13 characters and without spaces. In the case of the following examples, the Turkey River 
watershed will be evaluated, and therefore the example directory structure will be C:\Turkey\.  
The reason for a short folder name directly on the C drive is because    ArcHydro and HEC-
GeoHMS are limited by long file names and pathways, we recommend creating a project folder 
directly in the C: drive of your computer. ArcHydro will create its own additional folder named 
Layers in the destination folder you specify as your workspace once you start using Arc Hydro 
tools. This folder will store ArcHydro output raster data, i.e. agreedem, cat, cngrid, fac, fdr, fil, 
str, strlnk. 
 

2.) Open ArcMap and create a file geodatabase within the project folder – name it the exact same 
as the project folder – e.g. C:\Turkey\Turkey.gdb.  Save your map document in the folder you 
just created for the project (C:\Turkey\). 
 

3.) Set the coordinate system of the empty dataframe as the appropriate state coordinate system – 
for New Hampshire this is NAD_1983_StatePlane_New_Hampshire_FIPS_2800_Feet (WKID: 
3437 Authority: EPSG).  Ensure you are in ‘List by Source’ or ‘List by Drawing Order’ in the Table 
of Contents. Right click ‘Layers’ in the table of contents. Go to ‘Properties,’ Go to the 
‘Coordinates’ Tab. Select ‘NAD 1983 StatePlane New_Hampshire FIPS 2800 (US Feet)’ from 
Projected Coordinate Systems -> State Plane -> NAD 1983 (US Feet) and click OK. It’s a good 
idea to add this to your favorites.   
More info on the coordinate system at Granit - 
http://www.granit.unh.edu/resourcelibrary/GRANITresources/standards/datastandards.html  

 

4.) Check to see if Arc Hydro Tools and HEC-GeoHMS tools are installed in ArcMap.  

http://resources.arcgis.com/en/communities/hydro/01vn00000010000000.htm
http://www.granit.unh.edu/resourcelibrary/GRANITresources/standards/datastandards.html
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a. If these tools are not installed, go to http://www.hec.usace.army.mil/software/hec-
geohms/downloads.aspx and download the version of the tools that is appropriate for 
your ArcMap installation. HEC-GeoHMS will automatically install Arc Hydro Tools. 

b. If Arc Hydro tools are installed, they will need to be uninstalled. To do this: 
i. Close all Arc related applications. 

ii. Go to Add or Remove Programs in Windows and remove ‘Water Utilities 
Application Framework’, ‘Arc Hydro Tools’, and ‘HEC-GeoHMS’ if they are 
present in the list. Go to step 4a. 
 

5.) Activate ArcHydro toolbar by clicking Customize in the menu bar, then highlighting Toolbars 
then ensuring there is a check next to Arc Hydro Tools and HEC-GeoHMS. 
 

6.) Turn off background geoprocessing. To do this, go to geoprocessing menu in the menu bar, 
click Geoprocessing Options, uncheck enable in the Background Processing area. Click Okay. 
 

7.) Click ApUtilities in the Arc Hydro Toolbar, click Set Target Locations. Highlight HydroConfig, and 
click OK. Set Raster Data to target the project folder you created in step 1 (e.g. C:\Turkey\). Set 
Vector Data to target the project geodatabase (e.g. C:\Turkey\Turkey.gdb\). Click OK. 

 
Figure 1 

Input Gathering and Preprocessing 
Note 1: If a polygon representing the full extent of your area of interest (covering all possible culvert 
drainage areas) doesn’t exist, you will have to create one – in the case of a watershed, this may mean 
delineating the watershed or using a pre-defined Hydrologic Unit Code polygon if the HUC represents a 
true watershed or covers all possible culvert drainage areas.  
Note 2: Set the geodatabase you created previously as your default geodatabase, so that the results of 
the clip are output to the geodatabase. 

http://www.hec.usace.army.mil/software/hec-geohms/downloads.aspx
http://www.hec.usace.army.mil/software/hec-geohms/downloads.aspx
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Loading and Clipping the Data 

1.) The following instructions will step you through loading and clipping each dataset. Store all 
downloaded datasets in the project folder (C:\Turkey\)  

2.) Download and/or load and clip the LiDAR data for the area being analyzed: 
a. Download or load the LiDAR data from one of these locations: 

i. Web - NH Granit website: http://lidar.unh.edu/map/ 
ii. Local: 

N:\GIS\Core_GIS_Datasets\Elevation_and_Derived_Products\LiDAR_Datasets 
b. When the data is loaded into your map document, clip the LiDAR data to your area of 

interest, using the Clip Raster tool in the Data Management->Raster->Raster Processing-
>Clip.  

c. Note: Both locally and on the web, the data is separated into large watersheds / 
geographic regions; add the smallest one of these regions that covers the polygon 
representing your area of interest. 

3.) Download and/or load and clip the SSURGO Soils layer: 
a. Locations: 

i. Web – NH Granit website: 
http://granit.sr.unh.edu/data/search?dset=soils&#47;nh  

ii. Local: 
N:\GIS\Core_GIS_Datasets\Geological_and_Geophysical\Soils_NRCS\soils_ssurg
o_2009.shp 

b. As of 1/2017, soils data in the local copy is represented for the entire state in one shape 
file (soils_ssurgo_2009). Load this layer into ArcMap to be clipped by the watershed / 
project extent polygon later on. 

c.  Clip the SSURGO Soils data to your area of interest, using the Clip tool in Geoprocessing. 
 
4.)  Load and clip the NH Land Cover Assessment layer: 

a. Locations: 
i. Web – NH Granit website: 

http://granit.sr.unh.edu/data/search?dset=nhlc01&#47;nh  
ii. Local:  

N:\GIS\GIS_Projects\NH_Geological_Survey\GIS\Land_Cover_Land_Use\nhlc01.l
yr 

b. The 2001 release of this data is currently the most up to date. Add the entire data set 
into your map to clip by the watershed / project extent polygon later on.   

c.  Load nhlc01.lyr and repair data source to nhlc01.asc 
d. Clip the nhlc01.lyr data to your area of interest, using the Clip Raster tool in the Data 

Management->Raster->Raster Processing->Clip. Enable the Use Input Features for 
Clipping Geometry box. 

 

http://lidar.unh.edu/map/
http://granit.sr.unh.edu/data/search?dset=soils&#47;nh
http://granit.sr.unh.edu/data/search?dset=nhlc01&#47;nh
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Optional Note: In order to retain symbology for the data, repeat as followed. In the NH Land Cover 
Assessment 2001 layer, enter property symbology and save symbology in the Export as Raster 
option. In clip of desired region, open property symbology and Import symbology saved from NH 
Land Coer Assessment 2001.  

5.)  Load and Clip the New Hampshire Hydrologic Dataset: 
a. Locations:

i. Web – NH Granit website:
http://www.granit.unh.edu/data/search?dset=nhhd&#47

ii. Local:
N:\GIS\Core_GIS_Datasets\Water_Resources\NH_Hydrography_Dataset.gdb

b. Note: The relevant layers inside this geodatabase are NHDFlowline inside the
Hydrography file geodatabase feature dataset, and inside the WBD (Watershed
Boundary Dataset) file geodatabase feature dataset, the Hydrologic Unit level that will
fully encompass the drainage area of the outlet of the watershed / project extent as it
may be used as the watershed / project extent polygon later on, defining the extent to
which all of the other layers will be clipped.

c. Create layer of desired hydrography data by using the Clip tool in Geoprocessing, and
clipping to your watershed boundary or area of interest. (Note: Turkey River Watershed
results use turkeyflowline shapefile, an older attempt to reconcile GRANIT with LiDAR.
Future attempts should use  the most recent flowlines on the N Drive.)

6.) Download the 30 year April Normal Precipitation over the period of 1981-2010 from 
http://www.prism.oregonstate.edu/normals/. The options that should be selected for 
downloading of the correct data should be: 

a. Spatial resolution needed: 800m (18-350MB per data file; 5MB per full-size image)
b. Climate variable: precipitation
c. Temporal period: monthly values for April
d. Click ‘Download Data (.asc)’ after selection options are correct
e. Save this file in a Precipitation folder in your project folder.
f. Note: Refer to the picture (Figure 2) below for clarity:

Figure 2 

http://www.granit.unh.edu/data/search?dset=nhhd&#47
http://www.prism.oregonstate.edu/normals/
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g. Add the entire data set into your map.
h. Use the Project Raster tool to reproject these files to

‘NAD_1983_StatePlane_New_Hampshire_FIPS_2800_Feet’. In the Properties Display,
resample using Cubic Convolution.

i. Using the Clip Raster tool in the Data Management->Raster->Raster Processing->Clip.
Enable the Use Input Features for Clipping Geometry box.

7.) Go to http://precip.eas.cornell.edu/ click on ‘Data & Products’ at the top of the page. The page 
should display a map. On the left side of the page, click ‘GIS Data Files’. The map should be 
replaced by a page with drop down menus.  

a. For ‘Data Type’ select ‘Return Period Estimates.’
b. For ‘Duration’, select ’24 Hour.’
c. For ‘Recurrence’, select ‘2yr (50%)’, then click submit.
d. Rename the downloaded file (‘output.asc’) to something more illustrative of the data in

the file, such as ‘PRECIP_2YR_24HR.asc’ before proceeding.
e. Repeat Steps 6c through 6e, selecting ‘10yr (10%)’, ‘25yr (4%)’, ‘50yr (2%)’, and ‘100yr

(1%)’ for ‘Recurrence.’
f. In ArcMap, open these files and set their projections to ‘WGS-1972’ using the Define

Projection tool.
g. Use the Project Raster tool to reproject these files to

‘NAD_1983_StatePlane_New_Hampshire_FIPS_2800_Feet’. In the Properties Display,
resample using Cubic Convolution.

j. Clip each raster to the area of interest, using the Clip Raster tool in the Data
Management->Raster->Raster Processing->Clip. Enable the Use Input Features for
Clipping Geometry box.

8.) Get the New Hampshire Hydrologic Dataset: 
a. Locations:

i. Web ¨https://www.fws.gov/wetlands/Data/State-Downloads.html and
download the shapefile for the state of New Hampshire.

ii. Local: N:\GIS\Core_GIS_Datasets\Water_Resources\NH_NWI.gdb\NWI
b. Load the layer/shapefile into your map to clip by the watershed / project extent polygon

later on.

Note: Clipping the Data – For DES users only 
There are two ways to do this (for layers besides the DEM): 

1.) If loading layers from the Core Data sets on the N Drive… 
a. Be sure NOT TO RE-PROJECT THEM!!!!!!!
b. Clip these files using the polygon you have chosen to use as your project extent –

options include: a manually delineated watershed polygon, a HUC polygon that
encompasses the all possible culvert drainage areas, etc.

http://precip.eas.cornell.edu/
https://www.fws.gov/wetlands/Data/State-Downloads.html
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i. When clipping be sure to set the output projection as  
‘NAD_1983_StatePlane_New_Hampshire_FIPS_2800_Feet’ in the Environment 
Settings options 

2.) If using local layers,  
a. You can re-project the local layers using Project and Project Raster tools to ensure that 

all files are in the ‘NAD_1983_StatePlane_New_Hampshire_FIPS_2800_Feet’ projection. 
i. NOTE: When re-projecting the DEM (and any continuous raster data), be sure 

to go into Environment Settings and under Raster Storage set the Resample 
options to Cubic. Nearest Neighbor should never be used to resampling 
continuous data. 

b. Then clip  (without having to set the projection in the Environments options)  

 
For the DEM, the best method (since the LiDAR is in UTM 19N) might be to: 

a) Clip in the original projection. 
b) Then re-project to NAD_1983_StatePlane_New_Hampshire_FIPS_2800_Feet with Cubic Spline 

resampling.   

 

DEM Processing 
Pre-check 

1. Ensure that the dem is in your table of contents, and is projected in correct PCS 
(NAD_1983_StatePlane_New_Hampshire_FIPS_2800_Feet); if it is not, go to ArcToolbox->Data 
Management->Projections and Transformations->Raster and select Project Raster. Set Input 
Raster to the DEM you clipped from the larger LiDAR data, and name the output raster dataset 
to something appropriate (e.g. turkeySPFt), set output coordinate system to 
‘NAD_1983_StatePlane_New_Hampshire_FIPS_2800_Feet’, and set resampling to Cubic. The X 
and Y should have values that correspond to the number of feet per previous map unit. In the 
example case, X and Y are both 3.280833 as this is the number of feet there is in one meter. 

DEM Processing Steps 
2. In ArcHydro, click Terrain Preprocessing, select DEM Manipulation, and then click DEM 

Reconditioning. Set Raw DEM to the DEM you extracted by mask (e.g. demSP83 double check 
this name has not changed.). Set the AGREE Stream to your flowline, (e.g.nhdTraceTurkeySP). 
Set Sharp drop/rise equal to 10. Click Okay. This process can take a while, and can require many 
tens of gigabytes of hard disc space. If this process continually fails, ensure that all files involved 
are in StatePlane Feet, and ensure that you have at least 50 gigabytes of disc space available. It 
is useful to clean Arc Hydro temp files to free up space if reconditioning fails: In Arc Hydro 
Toolbar click ApUtils, go to Additional Utilities, click Clean User’s Temp Folder and click yes.  

3.  In Arc Hydro Tools toolbar, click Terrain Preprocessing, click DEM Manipulation, click Fill Sinks. 
Leave everything on defaults and click Okay. This will create a layer Fil. 
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4.  In Arc Hydro Tools toolbar, click Terrain Preprocessing, click Flow Direction. Leave everything 
on defaults and click Okay. This will create a layer Fdr. 

5.  In Arc Hydro Tools toolbar, click Terrain Preprocessing, click Flow Accumulation. Leave 
everything on defaults and click Okay. This process can take a while. This will create a layer 
called Fac. 

6.  In Arc Hydro Tools toolbar, click Terrain Preprocessing, click Stream Definition. In Area (Square 
km), type ‘05’ after the decimal place. Delete everything after ‘.05’. Note that you cannot make 
this field blank or zero at any time, it will cause an error. Make sure the ‘.05’ is in this field 
before you delete anything. The end result in this field should be ‘0.05’. This will create a layer 
called Str. 

7.  In Arc Hydro Tools toolbar, click Terrain Preprocessing, click Stream Segmentation. Leave 
everything on defaults and click Okay.  Q; are the ‘Null’ values for ‘Sink Link Grid’ and ‘Sink 
Watershed Grid’ correct? This will create a layer called StrLnk. 

8.  In Arc Hydro Tools toolbar, click Terrain Preprocessing, click Catchment Grid Delineation. Leave 
everything on defaults and click Okay. This will create a layer called Cat. 

9.  In Arc Hydro Tools toolbar, click Terrain Preprocessing, click Catchment Polygon Processing. 
Leave everything on defaults and click Okay. This will create a layer called Catchment. 

10.  In Arc Hydro Tools toolbar, click Terrain Preprocessing, click Drainage Line Processing. Leave 
everything on defaults and click Okay. This will create a layer called DrainageLine. 

11.  In Arc Hydro Tools toolbar, click Terrain Preprocessing, click Adjoint Catchment Processing. 
Leave everything on defaults and click Okay. This will create a layer called AdjointCatchment. 

 

Watershed Processing 
In this process, you will create Batch Points based on road-stream crossings (Culverts layer) and then 
you will delineate the watershed based on each individual point. After watersheds are delineated, 
you will calculate watershed characteristics (area, slope, and longest flow path). 

 

12. Turn off all layers except the Culvert layer and the Drainage Line layer. 
13. Use the Snap Pour Point tool from ArcGIS toolbox (Spatial Analyst Tools > Hydrology > Snap Pour 

Point) to snap river-roads crossing to the nearest point of the drainage line where the flow 
accumulation is maximal (a snap distance of 15 feet is chosen here, but can vary based on the 
“Near” command to find the maximum distance between the drainage lines and culvert 
locations). The Snap Pour Point tool is used to ensure the selection of points of high 
accumulation flow when delineating drainage basins using the Watershed tool. Snap Pour Point 
will search within a snap distance around the specified pour points for the cell of highest 
accumulated flow and move the pour point to that location. 

14. Open the Culvert Points attribute table. Highlight the first record from the attribute table and 
zoom to it. 
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15. From Arc Hydro Tools toolbar, click the Point Delineation tool as indicated by a red arrow in 
Figure 3. This tool allows watershed delineation for interactively defined points. 

 
Figure 3. Location of Point Delineation tool (pointed to with a red arrow) 

 
16. Leave defaults when a dialogue window (Figure 4) opens and click OK. 

 

 
Figure 4 

17. Click the nearest snapped culvert location to the first crossing point you just zoomed to. It 
should delineate the watershed in red if you have clicked close enough to the pour point; if not 
the following dialog box will open. You can try clicking “Yes – Snap” (choose the number of 
distance cells based on the size of your raster cells), but when the point delineates you must 
check to make sure that snapped point and resulting watershed make sense relative to the 
landscape! 
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Figure 5 

18. Click Yes to the question “Do you want to save the watershed?” and type the name of a 
culvert following with an easy identifier – like the local ID (see Figure 6) you used in the field or 
the 15 character NAACC crossing code (copied and pasted from the attribute table). For 
Description, you can type in the road name or stream name, survey ID, or whatever will make 
sense to you later. Or nothing at all.  

 

 
Figure 6 

 
19. Continue delineating watersheds in the same way (highlight > zoom to > click pour point > 

delineate > name and save) until you have completed all the crossings. When finished, 
notice that the software has created two layers. One called “Watershed” and another one 
called “WatershedPoint”. It is important to know is the Watershed layer has a field called “ 
HydroID” which is the same as the field “DrainID” from the WatershedPoint layer – this will 
be necessary later. 



45 | P a g e  
  

Longest flow path for watersheds 
 

20. From HEC-GeoHMS Toolbar, set parameters for data management (Preprocessing > Data 
Management) as shown in Figure 7. You do not need to type in anything. For Raw DEM, 
select the name your DEM; set the rest as following. 

 
Figure 7. Data management window for HEC- GeoHMS extension. 

 
21. Open the new Watershed layer attribute table. Begin selecting multiple watersheds, but make 

sure they do NOT overlap or nest (smaller watershed within a larger watershed selected at the 
same time) – select as many as you can. (HEC-GeoHMS will not compute characteristics for 
overlapping or nesting watersheds and will only return null parameters.) From HEC-GeoHMS 
toolbar select Characteristics > Longest Flow Path. Notice the resulting layer is automatically 
named Longestflowpath (Figure 8). You will add 1 after the name to make it Longestflowpath1 
since you will compute for Longestflowpath2, Longestflowpath3, and so on depending on the 
number of runs needed to make the calculations without overlapping. Make sure the Input 
Raw DEM is your original DEM and the Input Subbasin the Watershed layer; leave fdr as 
default for Input Flow Direction Grid (Figure 9). 
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Important note: make sure this tool is NOT run in the background. It has a tendency to crash 
when run in the background instead of as a visible process. It can be changed in the 
Environments Panel. 

 

 
Figure 8 

 

22. Continue selecting new watersheds from 
the Watershed layer attribute table and 
running the Longest Flow Path tool in HEC-
GeoHMS until all the watersheds have been 
calculated. Give each new batch of 
calculations a different name.  

 

23. Append or merge all the Longest Flow Path 
batches into a single table. Join this table to 
the Watershed layer using the HydroID in 
the LongestFlowPath layer and the DrainID 
in the Watershed layer (see Figure below). 
In the layer properties, you can go into the 
Field tab and uncheck all fields except 
DrainID, Slp, Slp1085, and LongestFL – these 
are the only fields we will need for later 
output analysis. 

 

                Figure 9    
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Area of wetlands/ponds in watershed (ft2) 
 

You will use a wetland layer from National Wetlands Inventory (U.S. Fish and Wildlife Service) 
(http://www.fws.gov/wetlands/Data/State-Downloads.html) or the wetlands and ponds 
shapefile from your state. 

 
24. Clip the layer to the extent of the watershed you delineated (using the Clip tool in ArcGIS). 

 
25. Open the attribute table of the clipped layer and add a new field (Name: Wet_Sqft, 

Type: Double, Precision = 10, Scale = 2) (Figure 10). 
 

 
Figure 10 

 
26. Right click Wet_Sqft and use Calculate Geometry and set necessary parameters (Figure 11). 

The output is computed in square feet for each watershed.  
 

http://www.fws.gov/wetlands/Data/State-Downloads.html)
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Figure 11 

27. To calculate how much (square feet) of watersheds, ponds, and lakes is in each watershed, 
use Spatial Join tool (ArcToolbox > Analysis Tools.tbx > Overlay > Spatial Join) to join the 
wetland layer you clipped in step 6 to the Watershed layer (Target Features = Watershed, Join 
Features = Wetlands layer, Join Operation: JOIN_ONE_TO_MANY. Set the output location to 
the Wetlands folder you created earlier) (Figure 12). 

 

 
Figure 12 
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Notice that the output contains HydroID field (which originates from the Watershed layer) and Sqft 
(which originates from the wetlands layer) (Figure 13). 
 

 
Figure 13 

 
28. Right click HydroID > Summarize > When prompted to a dialog window, scroll down to expand 

Wet_Sqft field (this is a field you created in step 44) and check Sum in the “Choose one or 
more summary statistics to be included in the output table” box. The output table will show 
how much of total area (lakes, ponds, and wetlands combined) found in every watershed.  

 
29. Open output table properties and click Fields tab to uncheck all fields except 

HydroID and Wet_Sqft. 
 

SCS Curve Numbers (CN) generation 
 

A widely used method of calculating storm runoff developed by the Soil Conservation Service (SCS) 
uses storm rainfall and a curve number. A curve number is a quantitative descriptor of the land 
cover/soil complex and is commonly assigned based on information acquired from field surveys and 
interpretations of aerial photographs (Slack & Welch, 1980). Curve numbers have been tabulated by 
the Soil Conservation Service on the basis of soil type and land use. Four soil groups are defined: 

• Group A: Deep sand, deep loess, aggregated silts 
• Group B: Shallow loess, sandy loam 
• Group C: Clay loams, shallow sandy loam, soils low in organic content, and soils usually 

high in clay 
• Group D: Soils that swell significantly when wet, heavy plastic clays, and certain saline 

soils (Chow, Maidment, & Mays, 1988). 
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To generate CN values requires three steps: Land cover data preparation, soil data preparation and 
creation of SCS curve number grid. SCS curve number grid is used by many hydrologic models to 
extract the curve number for watersheds. We will use HEC-Geo-HMS for ArcGIS. 

 
Land cover data preparation 
 

30. Add land cover data to ArcMap. Notice that the layer does not have a spatial reference. 
Use the Define projection tool to assign spatial reference to the raster data (ArcToolbox > Data 
Management Tools > Projections and Transformations > Define Projection). You will then 
choose WGS84 for Coordinate System. Then set the projected coordinate system to your 
state’s appropriate NAD_1983 coordinates using the Project Raster tool. 
 

 
Figure 14 

 
31. Reclassify land use into classes that have the same general characteristics (From ArcGIS 

ArcToolbox > Spatial Analyst Tools > Reclass > Reclassify). You will use the following table to 
replace old values with new values (Table 1). The reclassify shows only eight classes. Save as 
LC_Reclass. 
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Table 1: Reclassification of land cover 
Old classes New classes 
110: Residential/commercial/industrial 1 
140: Transportation 2 
211: Row crops 3 
212: Hay/Pasture 4 
221: Orchards 5 
412: Beach/Oak 6 
414: Paper Birch/Aspen 
419: Other Hardwoods 
421: White/Red Pine 
422: Spruce/Fir 
423: Hemlock 
424: Pitch Pine 
430: Mixed Forest 
500: Open water 7 
610: Forested wetlands 
620: Open wetlands 
630: Tidal wetlands 
710: Disturbed land 8 
790: Other cleared 

 

 
Figure 15: Reclassify dialogue window. 
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32. Convert the newly reclassified landcover from raster to polygon (ArcGIS Toolbox > 

Conversion Tools > From Raster > Raster to Polygon). Notice that the Simplify polygon box 
is unchecked. Name the output something appropriate to differentiate (Figure 16). Save as 
LC_Clip_Reclass_Polygon. 

 

 
Figure 16 

 
You will open the attribute table of land use layer (LC_Clip_Polygon) and add a new field 
(Name = LandUse; Type = Short Integer). Use Field Calculator to calculate LandUse field 
values based on the GRIDCODE field (Figure 17). 
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Figure 17 

 
Preparing Soil data 

 

33. Open the attribute table of Soil data and add a new field named "SoilCode", Type = Text, 
Length = 5. 

 
 

34. Right click the SoilCode field and click Field Calculator. Use Field Calculator and select 
HydrolGrp field name in the field calculator (Figure 18) > OK. 
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Figure 18 
 
When the Field Calculator window opens, double click HydrolGrp field. The window should now 

show that SoilCode = [HydrolGrp]. 
 
35. Hit OK. You will notice that some values in the new field are missing. This is because HydrolGrp 

field did not have any either. Therefore, you will use the DrainClass field to determine which 
class corresponds to each description. For example “Very poorly drained” would correspond to 
D, well drained to B, Excessively drained to A and poorly drained to C (Table 2). 

 
Table 2. Soil code based on soil drainage characteristics. 
Soil Description Soil Code 

Excessively drained A 

Well drained B 

Poorly drained C 

Very poorly drained 
(including water) 

D 

No description C 

 
 
36. Select records that correspond to Very poorly drained of the DrainClass field > Right click 

SoilCode field to select Field Calculator (make sure to be in editing mode!) > Type "D" under 
Soil Code = > OK. 
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Proceed with the rest of classes. However, for those which do not have any description, you 
should refer to MUName field to decide which group to assign every record. For our case, since 
the rest of records consists mostly of water, we will consider the soil to be very poorly drained (D 
category). 

 
37. Create four attribute fields with names "PctA", "PctB", "PctC" and "PctD". Data type is 

short integer for the four fields.  
 

38. You will use the Select by Attributes (from the drop-down arrow of the top left corner of the 
table) to select Soil Code that corresponds to category A (Figure 19). Use Field Calculator to 
populate the Pct A field with the value of 100; leave a value of 0 for other fields, i.e. PctB, PctC, 
and PctD (e.g. Figure 19). Repeat this step for PctB, PctC, and PctD. For soils containing two soil 
codes split the percentages appropriately (i.e. Soil Code: A/D, PctA = 50, PctD = 50. Make sure 
the table uses 0 instead of NULL fields. 

 

 
Figure 19. Example of the Use of Field Calculator for PctA field. 
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Creating CN LookUp table 

 

39. Create a CnLookUp table using Create Table tool (ArcToolBox > Data Management Tools > 
Table > Create Table). Table Location should be your project folder's geodatabase. Give the 
name "CnLookUp" to the table (Figure 20), then hit OK. 

 

 
Figure 20 

 
40. Right click the table > Open. Click the top left drop-down arrow and select Add Field (Field 

Name: LUvalue, Type: Short Integer, Allow Null Values: Yes). Add another field (Name: 
Description, Type: text, lenth: 30). 

 
 

41. Add four more fields (Type = short integer) and name them "A", "B", "C", "D" 
respectively as illustrated in Figure 21. 

 

 
 

Figure 21. LuValue, Description, A, B, C and D new fields added to CnLookUp table. 
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42. Right click the table in the TOC, then click Edit Features > Start Editing. You will populate the 
table with CN values (Figure 22), then you will save edits before closing the editing session. 
These values have been retrieved from Soil Conservation Service (SCS) Technical Release 55 
(Cronshey, 1986). 

 

 
Figure 22 

Union of Soil and Landuse Data 
 

43. In this step, we will union Soil and Landuse Data using the Union tool (ArcToolbox > Analysis 
Tools > Overlay > Union). Name the output layer “LC_Soils_Union” (Figure 
23). 

 
Figure 23 
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44. Open the attribute table of LC_Soils_Union layer and click the drop down arrow from top left 
corner of the attribute table > Click Select by Attributes. Set parameters as follows when a 
dialogue window opens (Figure 24). 

 

 
Figure 24. Select by Attribute dialogue window. 
 

The reason for selecting FID_Soils = -1 and FID_LC = -1 is that these records correspond to areas of 
soils and land cover which do not overlap; therefore, these need to be cleaned before we use the new 
layer to create CN Grid. Now you have created a new layer that has both soil attributes and land use 
attributes. This layer is necessary for the computation of SCS runoff curve numbers (CN) which will be 
performed in the next step using the HEC-GeoHMS toolbar. 
 
Creating CN Grid 

 

45. Activate the HEC-GeoHMS extension toolbar by right clicking an empty space next to the 
main menu tool bar and checking the HEC-GeoHMS toolbar. The toolbar appears in ArcMap 
(Figure 25). 

 
 

 
Figure 25 
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46. You will now compute a CN Grid using Generate CN Grid tool (from the HEC-GeoHMS 

tool bar, click the drop-down arrow next to Utility > Click Generate CN Grid > OK). 
 

Leave fil as default for Input Hydro DEM; set the Input soil Landuse Polygon to the new layer 
you created in steps 62 – 65; leave CNLookUp as default for Input Curve Number 

 
Lookup; Make sure the output corresponds to where you want it and leave CNGrid as 
default name for the output layer as shown (Figure 26).  
 

 
 

Figure 26 
 

47. In order to determine the average CN value for each of the watersheds, we will use the Zonal 
Statistics as Table tool (ArcToolBox > Spatial Analyst Tools > Zonal > Zonal Statistics as Table) 
(Figure 27). The resulting table shows a field named "MEAN". This field stores averaged CN 
values for each watershed (Figure 28). 
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Note: As with the process for Longest Flow Path, trying to run watersheds that overlap or nest at 

the same time will result in null or incorrect outputs. Select non-overlapping watersheds in 
multiple batches, or use an iterative model through the model builder to run each watershed 
individually and merge them together afterward. 

 

 
Figure 27 

 

 
 

Figure 28. Table with averaged CN values for each watershed. 
 

48. Highlight as many non-overlapping watersheds as possible and run the Zonal Statistics as 
Table tool in batches until all watersheds have been run.  

 

49. Merge the batches together into a final table with all watersheds – check that all 
watersheds are accounted for and all CN values are populated. 
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50. Join the CN values to the Watershed layer using the HydroID. 
 

 

Precipitation Data 
51. Add precipitation data you downloaded from http://www.prism.oregonstate.edu/normals/. 

Those are 2-10-25-50-100-year rainfall ascii files from Cornell (0.8 km resolution). 
 

52. Convert ASCII data into raster format using ASCII to Raster tool (ArcToolBox > Conversion 
Tools > To Raster > ASCII to Raster) (Figure 29). 

 

 
Figure 29 

 
53. Define the projection as WGS-72 using the Define Projection Tool (ArcToolBox > Data 

Management Tools > Projections and Transformations > Define Projection). For input data set, 
browse to add ASCIITo_2_Yr1 layer > for coordinate system choose WGS 1972. Then project 
the raster and choose the appropriate WGS-83 state plane coordinate system for the output 
coordinate system and output name to be prec_2yr. 

 
 
 
 
 
 
 
 

http://www.prism.oregonstate.edu/normals/
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54. To calculate the average precipitation (inches) for each watershed, you will use the Zonal 

Statistics as Table tool (ArcToolBox > Spatial Analyst Tools > Zonal > Zonal Statistics as Table) 
where the input raster of feature zone data is the watershed of interest, the zone field is the 
HydroID, the Input value raster is the precipitation raster data. The output table should be 
stored into the file geodatabase you created. For Statistics type, choose MEAN (Figure 30). 

 

 
Figure 30 

 
Select and run statistics for watersheds in the same manner you selected them to run 
watershed characteristics (not overlapping or nesting), or the Zonal Statistics as Table tool can 
be used as an iterative model to compute the precipitation for all watersheds.  

 
55. Merge or append all the mean precipitation tables, then join them to Watershed layer. 

 

56. For any watersheds that are too small to run the zonal statistics, select and zoom to the 
watershed, then use the identify tool to view the pixel value from the precipitation raster and 
manually input it into the table.  

 
57. Repeat these steps for precipitation data (steps 56-61) for each of the 10-yr, 25-yr, 50-yr, and 

100-yr storm intervals. Export these tables as .csv (or whatever file type you’re comfortable 
with), bring them into Excel (or your spreadsheet of choice), and divide  precipitation values 
by 1000. 
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58. Repeat these steps for precipitation data (steps 56-61) for the mean April precipitation. After 
exporting, convert the precipitation from millimeters to inches (1mm = 0.0393701 inch).  

 
59. When exporting and compiling all tables and GIS data, BE SURE that all precipitation is 

measured in inches and all areas, lengths, and slopes are in ft or ft2. Final output to be loaded 
into the Excel-based hydraulic capacity model should look like the following figure: 

 

 
 

Figure 31 
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	Introduction
	This model is intended to be used as a coarse screening tool to rate stream crossings for hydraulic, aquatic organism passage (AOP), and geomorphic compatibility (GC). It is best used as a method to quickly analyze many crossings at once, and detail the susceptibility of the crossings in the context of the watershed scale. While the results are beneficial, they should not be used for design or final analysis. Much of the data is either obtained online from GIS sources, or is collected as part of the New Hampshire state protocol. Individual crossings may be found to have site specific considerations of modeling parameters when analyzed more closely; but to do so requires greater effort, and would immensely increase time and effort. The goal of this model is to provide a quick screening assessment of many culverts by utilizing available or standardized collection data protocols. 
	Version 2 has several updates over Version 1. Most notably, Version 2 provides ratings for aquatic organism passage and geomorphic compatibility in addition to hydraulic ratings. Updates to the hydraulics in Version 2 include accounting for tailwater effects as well as a slightly different hydraulic rating scheme than the first version. In Version 1, a rating of Transitional meant that the headwater stage at the inlet of the crossing was within 15% above or below the crown; Pass meant a headwater stage below this zone; and Fail meant a stage above. To better represent what may be considered physical hazard conditions at each crossing resulting from hydraulic performance, in Version 2, a rating of Pass represents a headwater stage below the lowest crown at the culvert inlet(s) of the crossing; a rating of Fail means the headwater stage is overtopping the road (or in some cases another type of adjacent levee or user-established elevation); and Transitional means any headwater stage between those two elevations. Furthermore, Version 2 includes additional optional input that may exist at a site which may provide more accurate calculations at relatively little extra effort.
	This model was designed and documented to be used by persons with basic understandings of hydrology and hydraulics, and some experience with culvert crossings, at the very least. While this document will explain the data and variables to be used as well as the methods, equations, and calculations used, it will not attempt to explain every piece in detail. For specific questions, please consult relevant online documentation. The answers to even the most specific questions are most likely answered at numerous websites. For any technical errors or modeling issues, please contact Tom or Joel Ballestero of Streamworks, PLLC for help.
	Throughout this document, references to sections of this report as well as to content within the model are formatted in certain manners to help the reader more quickly understand to what the text is referring. References to section headers within this report appear as: 
	Referenced Content - Section header or title within this report
	References to the individual tabs, input, or any special definitions located within the model appear in the following manner:
	Referenced Content - Individual tabs located in the model
	Referenced Content - Data category headers located within the Ratings and Results tabs in the model 
	Referenced Content - Required and optional input data parameters and column labels in the model 
	Referenced Content - Any other calculated data or values described here, or referenced in the model
	Funding was provided in part by the National Oceanic and Atmospheric Administrationˇs (NOAA) Office for Coastal Management under the Coastal Zone Management Act in conjunction with the New Hampshire Department of Environmental Servicesˇ (NHDES) Coastal Program. Project partners include NOAA, NHDES, the Strafford Regional Planning Commission (SRPC), the Rockingham Planning Commission (RPC), the University of New Hampshireˇs (UNH) Stormwater Center (UNHSC), and the UNH Institute for the Study of Earth, Oceans, and Space (EOS). Project managers and contacts include Steve Couture and Nathalie Morison with NHDES, Kyle Pimental with SRPC, Julie LaBranche with RPC, Tom Ballestero with UNHSC, and Faye Rubin and David Justice with UNH EOS.
	Updates from Version 1
	This is the second version of this model. As such, there were major modifications and updates to the interface and layout of the model, compared to Version 1. The model was overhauled to present the crossings listed by row, rather than by column. This was done to conform to a more conventional way that a user would store and view the data � and because scrolling side-to-side to view input and results is more difficult that scrolling up-and-down, especially when dealing with larger data sets (a large number of culverts). The methods and calculations employed, however, are in large part unchanged behind the scenes. Some coefficients used in the hydraulic equations have been changed to reflect published changes since Version 1, but otherwise all the coefficients and equations used in the hydrologic and hydraulic calculations remain the same.  Some additional calculations and synthesis was added.
	The input required for they hydrology and hydraulic calculations (formerly input on the GIS Input and User Input tabs in Version 1) remains mostly the same, with some additions to further provide more options for defining a crossing. Some of the new input parameters are optional, and may help the user better analyze a crossing using minimal added effort. One major new addition to the available input is the fact that Pipe Arch culvert shapes are now included, and Culvert Type Reference Numbers are available to use for those shapes.
	Another major update to the model is the manner in which it rates crossings for hydraulics. In Version 1 the ratings were defined by the elevations of 85% and 115% of the rise of the culvert at the inlet, with a rating of Transitional being a headwater depth between those two elevations, and ratings of Pass and Fail for headwater depths below or above those elevations, respectively. While there is nothing wrong with those former ratings, they did not convey well what happens at a crossing. Thus for Version 2, based on discussions with a Technical Advisory Committee it was decided to update the limits where the three ratings of Pass, Transitional, and Fail apply, and have those limits better describe approximate stages that may be considered critical points with reference to infrastructure. The two elevations which define the hydraulic ratings in Version 2 are the top of the culvert at the inlet, and at the elevation at which the water overtops the road. More specifically, this second stage does not have to be the point at which the water reaches the road. In the model, it is referred to as the Failure Elevation. While most commonly this elevation would be at the elevation of the road over the culvert it may be any elevation that the user desires to use as the stage at which a culvert is rated as Fail. This may be an adjacent levee, a stage at which flooding occurs at upstream infrastructure, or any other elevation. It is simply to define the point at which a culvert receives a hydraulic rating of Fail.
	In Version 1, the only hydraulic calculations performed were those for the headwater depths due to the inlet control. Recognizing that there are many other factors that can influence headwater depths resulting in outlet control, Version 2 computes both inlet and outlet control in order to determine a more accurate headwater depth. Two tabs were added to help the user define outlet control elements. The first is a Tailwater Input tab that simply allows the user to input known water surface elevations at the tailwater control. The second tab is the Rating Curve Generator, that � based on a simple cross section at the tailwater control � can generate the water elevations and copy them to the Tailwater Input tab automatically. These tabs are both optional, but provide for further analysis and better results at a crossing.
	Finally, two other important updates in Version 2 include two additional ratings for the crossings: Aquatic Organism Passage (AOP) and Geomorphic Compatibility (GC). The data required for developing these ratings are on the AOP Input and GC Input tabs, and provide a more complete description of the performance of a crossing � not only relating to passing flows (hydraulics), but to passing sediments and accommodating aquatic organism passage as well.
	Limitations and Precautions
	It is important to state that the purpose of this model is to provide a quick and relatively easy assessment of many stream crossings at once with regards to Hydraulics, Aquatic Organism Passage (AOP), and Geomorphic Compatibility (GC). Because of this, this model is meant to be simple to use with minimal input, and relatively little knowledge or experience with the hydrology, hydraulics, or habitat associated with the dynamics of stream crossings. A rigorous analysis of the impact a stream crossing to both the stream system and infrastructure can be extremely involved, requiring significant effort and resources. Thus, many limitations and precautions come with the goal of simplifying such a complex analysis. These are most evident in the hydrologic and hydraulic calculations, as both are highly dynamic and chaotic processes. Limitations to the accuracy of the AOP and GC ratings exist within the method developments, however limitations in calculating these ratings within this model are not a factor. That is; calculating each model capability as to whether or not a crossing is actually passable by fish or sediments would depend on a number of factors unique to each scenario � and in the case of aquatic organisms � unique to each individual organism. This applies to the hydrology and hydraulics as well; estimating the peak flows and capacity of each watershed and culvert naturally results in limitations to the precision of the results. The methods themselves contain limitations to their exact ability to predict flows and headwater stages, but the ability of the model to run the calculations behind each method is not inhibited.
	The following list describe the model limitations and precautions 
	A. Hydrologically, the model uses two methods to estimate flows at each site; the SCS runoff curve number method for all watersheds with area less than one square mile, and the USGS regression equations developed for New Hampshire for all watersheds larger than one square mile. While these methods are widely-used, and appropriate for many scenarios, both are rough estimations and do not perform as well as full, site specific watershed models. Both scenarios cannot account for specific types and degrees of urbanization � road drainage, dams, ponding, sequential road/stream crossings, and so on. Both are meant to be used on more rural, homogenous watersheds, and the very nature of a stream crossing infers that there is already some urbanization, even if only at that location. 
	B. The model, overall, is only set up to run up to 1,000 crossings at a time. Keeping track of all may be challenging, and could cause the model to run and/or open slowly. Therefore, if a user has more than 1,000 crossings to be processed, separate files should be created. 
	C. To keep the user from accidentally deleting or changing a cell that contains a formula, the file is protected. However, if the user desires to access locked cells or hidden tabs, the file is not password-protected. To unprotect the file (or a single sheet), simply click the Review ribbon tab, and select either Unprotect Sheet or Unprotect Workbook. Hidden tabs contain all the calculations behind the scenes as well as reference tables. These tabs may be accessed if the user has the need to do so.
	D. The model uses equations developed for all the most common culvert shapes, but not for all the shapes that a user may encounter in the field. Most of the time, the shape may be approximated and entered into the model in a manner that most appropriately describes the amount of flowable area with the appropriate dimensions � keeping in mind that the Rise should remain the same, and that the Span and Embedded depth may be adjusted to more exactly match the flowable area. This is described in more detail later in this document.
	E. Similarly, defining the culvert shape within the model not only tells it which coefficients to use in the headwater depth calculations, it also tells the model how to use the dimensions to calculate the flowable area of the inlet. This is not an issue with most shapes, however, there is no standard equation for determining the area of a pipe arch shape. These culverts are defined by a curved outline with three radii; one for each of the two corners, one for the upper curve, and one for the lower curve. The lower curve has the largest radius, while the corners have by far the smallest. Pipe arches can vary in their dimensions, and usually have the open area given by the manufacturer. Determining the open area of the inlet is massively important to calculating the headwater depths at a crossing. The headwater depths define the hydraulic rating for each crossing. Therefore, essentially any headwater stage below the top of the pipe is irrelevant, as to how accurate is the headwater measurement � when a pipe is flowing full, the flow area is equal to the total area of the pipe. Thus, the incremental calculation of the partially-full flow at the inlet does not need to be exactly representative of what it would be at any stage; only the full area. Having said this, pipe arches look very similar to an elliptical culvert that has been stretched at the top, and squashed at the bottom; the maximum width occurs below the vertical center of the shape. Therefore, more of the flowable area is lower, and less is higher. This is not entirely important, as long as the total area is accounted for. Within this model, since a complete lookup table of pipe arch sizes would be impractical, and lead the user to perhaps select a size that does not represent their observed culvert properly, pipe arch areas are calculated by the ellipse equation. This has proved to be a fairly good predictor in calculating the manufacturer-published areas. Performing a check on pipe arch sizes in published tables of sizes and configurations and areas, the range of percent difference in the area of calculated vs published areas was from 88-117%. And although a variation of 10-20% is quite large in terms of area, most of the calculated areas were much closer than that. Of all the Version 2 pipe arch culverts analyzed, 80% were within +/-2.5% and 90% were within +/-5%. So while a user may select a pipe arch shape, and enter in the dimensions, they should always attempt to check the calculated area against the area published by the manufacturer.
	F. This model can only perform calculations for one culvert at a crossing, or for multiple, parallel, identical culverts at a crossing. It cannot analyze multiple, dissimilar culverts, or dissimilar culverts in series (where a culvert cross section changes midway). This may be accommodated in the model in a few different ways, and this is more elaborately detailed later in this document.
	G. There are many recommended ranges for the input parameters and for the methods used in this model. These are described in more detail later in this document, under the descriptions for the methods, and within the Using the Model section.
	H. There are many physical properties of culverts that are unavailable to be properly defined within the model, or analyzed. This model cannot analyze culverts with multiple slopes (vertical elbow in the middle, broken-back culverts), nor can it properly describe any Culvert Shape, Material, End Type, or Edge Type that is not listed (these are all used to describe a Culvert Type Reference Number � more on that later). The user will have to describe those as best as possible.
	I. This model calculates the headwater depths at the inlet two ways � inlet control and outlet control. While these calculations are good starts, there are various site specific hydraulic conditions that may be present which are unaccounted. The model cannot yet perform calculations for energy losses within the culvert, or for cases where both the inlet and outlet are submerged, or for upstream turbulence causing additional losses at the inlet, among many others. The hydraulic calculations are most effective at producing results for longer, steeper, smaller, non-embedded culverts. Basically, any culvert where the inlet is the largest driving force behind the headwater stages. Outlet control headwater calculations are proposed to be added to the model by the end of Summer of 2017.
	J. Culverts with negative slopes cannot be analyzed properly; the slope has to be put into the polynomial equations with a positive value in order for the equations to be valid. Thus, culverts with negative slopes default to having a flat (0%) slope in the calculations, and may require more detailed analysis.
	K. This model calculates headwater depths according to how high a headwater stage would need to be at the inlet in order to pass the defined return-period flow through the culvert. Stream crossings may create a storage reservoir upstream, with the culvert being the outlet (and the road � or other feature � being the secondary spillway). This model does not perform storage routing. 
	L. This model requires that elevations at each site be input for several of the tabs. The elevations at each crossing do not need to be tied-in to global coordinates (vertical/horizontal datums); their absolute location in space is not important. However, they all must be relative to one datum at each site across all the tabs which require elevation data � Hydraulic Input, Tailwater Input, Rating Curve Generator, and AOP Input.
	M. This model was created and coded in Microsoft Excel 2010 and Visual Basic for Applications 2010. While it has been checked to function with some other versions/years, it may not work with newer versions, or with mobile versions.
	N. The model has been checked, calibrated, and tested as much as possible with over 100 culverts in its development. However, there are likely intricacies that may have been overlooked or did not arise at the time of development and testing. Please be sure to make any notes as to warnings or errors that you find, and be sure you check to see if there is a newer version of the model available. Updates will be performed as feedback is returned to the authors, so please be sure to detail any issues as completely as possible.
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	There are three types of ratings that this model produces: Hydraulic, Aquatic Organism Passage (AOP), and Geomorphic Compatibility (GC). The latter two use the New Hampshire state assessment protocols, both of which were adopted from the Vermont protocols. The former, hydraulic, has three components that each are performed using common, industry standard, well-published methods.
	It is assumed that the user of this model has at least a basic understanding of hydrology and hydraulics, and some experience with culvert and similar stream crossings. The methods used in this model will be discussed, and as much detail included to help guide even the most novice user through the input, but full-length discussion of methods and each variable is beyond the scope of this Userˇs Manual. If there are questions beyond what is detailed in this report, please refer to online documentation. Again, this model uses fairly common, well-documented methods, and there is likely an answer to even the most specific questions via online sources.
	In order to rate each crossing for hydraulic performance, the first step is to determine the flow expected at each location, at select return intervals (risk). The return intervals calculated in this model are the 2-, 10-, 25-, 50-, and 100-yr storms. There are many methods to calculate peak flow from a watershed, with some being more involved than others. In order to keep the required input data and effort at a minimum, two hydrologic calculation methods were chosen: the SCS Runoff Curve Number method for all drainage areas less than one square mile, and the USGS Regression Equations published for New Hampshire for all drainage areas larger than one square mile. Both methods are widely used, and all the data required to calculate each may be obtained from online sources. Using separate documentation accompanying this model (See StreamWorks-TU Culvert Model Instructions at end of Userˇs Manual) , it is entirely possible to automate the collection of this data, as long as crossing coordinates can be provided. However, it is always best to check the automatically-collected data against known values to ensure the automated method was run correctly. Also, it is important to use the correct online sources in the correct units, as detailed in this section. Recommended ranges for some of the hydrologic values may also be found in this section, and should be considered when running the model. Though the model will still calculate peak flows, if values lie outside their recommended ranges, the likelihood for error increases. Both methods are not meant for use in more urban watersheds, as urbanization can lead to increased or decreased flows (i.e. impervious surfaces or flood control, respectively). Finally, both methods for calculating peak flows at the crossings are commonly used, and much documentation may be found on each online. Please consult online sources if a more detailed explanation is required (see References at end).
	While this model is capable of calculating the peak flows for each crossing using the input described in the following sections, there is an option for the user to override (or provide) flows for each of the return periods, should the flows already be known, or if the calculated flows are in question.
	The USGS Regression Equations for New Hampshire are 4-variable, empirical equations that have been calibrated to peak flows in the state using recorded and published peak flows at USGS gaging stations as the control. Numerous independent variables were investigated for the regression analysis, and statistical software was used to determine the most relevant predictors, as well as define the coefficients for the best-fit equation for select return period flows. Since these equations were developed using specific datasets from specific sources, it is important to obtain these values from their exact online publications using their specified units. Even though there may be more current � or accurate � data available for each of the four parameters used in the equations, these equations may lose their relevancy if referenced to different sets of data. In other terms, the statistical analysis determined that the best predictors of flows to the outlet of a basin were these four parameters using their exact data sets � and not others. For the exact regression equations coded into this software, please refer to the USGS report (USGS, 2009).
	The four variables used in the regression equations are the Drainage Area in square miles, the Basinwide Mean of the Average April Precipitation in inches, the Percent Wetlands in percent (not decimal), and the 10-85 Slope (the slope of the flow path between points 10% and 85% up the length from the outlet) in feet per mile. Of these four variables, two are input into the model with units other than the ones defined by the USGS. The Drainage Area is input into the model with units of square feet, and the Percent Wetlands is calculated internally in the model, using the Area of Ponds and Wetlands (input into the model with units of square feet) and the Drainage Area (also in square feet). 
	The sources and data sets for each variable should be followed exactly to ensure the most accurate prediction of peak flows. To determine the Drainage Area, the 2007 USGS Digital Elevation Model should be used. Similarly, using the topographical DEM for the path length, the 10-85 Slope should use elevations referenced to the 2007 USGS National Elevation Dataset. The Area of Ponds and Wetlands should be referenced from the National Land Cover Dataset from 2003. The Basinwide Mean of the Average April Precipitation refers, exactly, to the weighted mean of the average April precipitation depths for the selected drainage basin (in inches), determined with the 1971-2000 April precipitation dataset (obtained from the PRISM Group at Oregon State University) resampled with bilinear interpolation to a 180-ft cell resolution. In less technical terms, but more detail, the Oregon State University PRISM Group publishes climate data to their website. They use, among other periods, 30-year windows of data for some data sets, and within those data sets, select time periods (summer, monthly, annual, etc.) may be obtained. The data sets are published with finite resolution, so the average � or weighted � value over a basin may be manipulated. Thus, taking the average April precipitation weighted for the entirety of the watershed for the month of April during the time period from 1971-2000 is how this value should be developed. 
	The regression equations were calibrated to known peak flows at USGS gaging stations across the state. Each gage had a watershed with its own properties; the limits of these properties for all the watersheds analyzed in the development of the equations are what the USGS suggests as the applicable ranges of values which the equations are likely accurate for. While values outside of the ranges are acceptable for use, the likelihood for prediction error increases. As detailed in the USGSˇ report on the development of the regression equations, the appropriate ranges for the variables used in the equations are: 
	Regression Equation Data Constraints
	Maximum
	Minimum
	Units
	Parameter
	1290
	0.70
	mi2
	Drainage Area
	6.23
	2.79
	in
	Basin Mean of Avg April Precip
	21.8
	0.0
	%
	% Wetlands
	543
	5.43
	ft/mi
	10-85 Slope
	The SCS (now NRCS) Curve Number method uses physical watershed properties and rainfall depths (corresponding to the appropriate return period peak flow) to estimate precipitation losses and a unit hydrograph unique to the basin. The unit hydrograph is then weighted by the rainfall amounts to calculate the peak flows. This method is meant to be customizable to any watershed (within the constraints of the parameter values) using the best available data, thus there is no specific data set needed for each parameter. However, in addition to the ranges of values for the parameters, this method was meant to be used on rural, homogenous land use (minimally diverse land use types), and consistent soil type watersheds. It was not intended for use on more urbanized watersheds, which is likely to be unavoidable in many cases, although more recent documentation does apply the model to urbanized watersheds without stormwater controls. 
	Some of the data obtained for the USGS Regression Equations is also applicable for this SCS method: the Drainage Area and the Area of Ponds and Wetlands.
	As the method requires a few steps to compute the peak flows based on select input parameters, only the variables required to be input into the model � and not intermediate (though important) parameters � are detailed here. Those variables and their units are; the Drainage Area in square feet, the Flow Path Length in feet, the Overall Flow Path Slope in ft/ft (a.k.a. unitless dimensions), the Area of Ponds and Wetlands in square feet, the Runoff Curve Number (unitless), and the 24-hour Precipitation Depth for each of the five return intervals (2-, 10-, 25-, 50-, and 100-yr) in inches. Additionally, this method uses a Rainfall Distribution Type to define the timing over a 24 hour period when the precipitation falls. New Hampshire is divided between two types; Type 2 and Type 3. The default for this model is set to Type 2, but Type 3 should be input to the model when appropriate. Maps depicting the location of each type across the state may be abundantly found online.
	While these values may be calculated various ways, and from any source most suitable, the following text is meant to further clarify how some of the parameters are calculated and to what they refer. The Flow Path Length refers to the longest length of a path taken by a drop of water from the basin outlet upstream to the watershed divide. The Overall Flow Path Slope refers to the slope of that flow path from its highest elevation to the elevation at the outlet. The Runoff Curve Number is a value used in the method to estimate the amount of the precipitation from the sky that actually contributes to flow (runoff), and how much is lost or stored. This number is calculated as the average of the individual curve numbers for the soils and land use types contained within the watershed, weighted by the area of each soil and land use type. Curve Numbers for land use types according to soil types are widely published online, and may be calculated automatically using a variety of online mappers (for example the USDA Web Soil Survey website). 
	The applicable ranges for this method include two parameters that are calculated within the model, and not input directly by the user. These two parameters, Ia/P and Tc, will not immediately be apparent to the user if they are violated, however, a warning will be shown on the Results tab of the model that will describe if one of the ranges has been violated. As described in documentation on the SCS Curve Number Method, the ranges for the variables are:
	SCS Curve Number Method Data Constraints
	Maximum
	Minimum
	Units
	Parameter
	2.0
	0.0
	mi2
	Drainage Area
	0.50
	0.10
	-
	Ia/P
	100
	40
	-
	CN
	10
	0.1
	hrs
	Tc
	With the expected flows calculated at each crossing, the resulting headwater depth at the inlet is determined and forms a hydraulic rating for the culvert (headwater depth versus flow). Culvert hydraulics are complicated and involve many factors. Headwater depth is hydraulically controlled in one of two ways: inlet control, which involves all the energy losses associated with the physical inlet configuration; and outlet control, which accounts for losses internally within a culvert and also the headwater effects from downstream of the culvert. In each case, both the inlet and outlet control headwater stage is calculated, and the larger of the two is the controlling stage (headwater depth).
	To simplify and standardize the effort involved with calculating inlet control hydraulics, the Federal Highway Administration (FHWA) developed empirical equations for certain combinations of physical metrics of inlet configurations. These equations are published in their report, Hydraulic Design Series number 5 (HDS5, 2012), and are incorporated into their free software, HY-8, which is a more robust analysis program than what is offered in this model. The equations used in this model for inlet control are borrowed directly from HDS5. While HY-8 may be a more thorough analysis for each crossing, it is cumbersome to input data and perform analyses for many crossings, and is meant to analyze culverts one at a time. HY8 results are not easily displayed as one summary. This is one of the main attributes of the differences between this model and the HY-8 software.
	Again, to simplify the required data and effort necessary to analyze each crossing, calculating outlet control headwater elevations are limited to user-entered values, or stages calculated by Manningˇs Equation for the controlling channel cross section downstream of the crossing. 
	Thus with headwater stage for both the calculated inlet and outlet control headwater depths at each return period flow, the highest is selected and compared to the top of culvert elevation and the road elevation to form the hydraulic rating. Another goal of this model is to easily and quickly represent the results for many culverts (town-wide or watershed wide), in a manner that can be understood at a glance. Whereas the resulting numerical headwater stages at each crossing for each flow are displayed in the results, the colored rating scores quickly and easily display how each performs, to help identify the most vulnerable crossings. When considering hydraulic vulnerability at a crossing, two water stages (headwater depths) were chosen that were considered simple benchmark representations the culvert hydraulic performance. The highest of the two is the stage at which the headwater begins to overtop the road (or embankment, levee, etc.). This signifies the stage at which flooding of the crossing may start to cause embankment erosion, embankment failure, flooding hazardous for travel, and/or road/culvert failure. The lower of the two stages was chosen as the top of the inlet of the culvert (though, in the case of multiple culverts, this needs to be defined, and will be discussed in more detail later). This stage represents a likely scenario where velocities inside and exiting the crossing are likely to be high, which may result in downstream erosion of the channel and banks. Thus, for each return period flow at each crossing, a rating of Transitional is given when the calculated headwater depth is between these two stages, a rating of Pass is given when the depth is below to top of the culvert, and a rating of Fail is given when the headwater stage is calculated to overtop the cross section above the inlet. It is important to note that there are rare cases where the headwater stage can breach the top of road before reaching the top of the culvert (perched culvert). In cases such as these, no Transitional rating can be given, and the first check for a rating would be for failure; so a headwater stage overtopping the cross section but below the top of the culvert would be rated as Fail and not as Pass, which may be confusing, but all the more reason to understand the geometries at each and every crossing.
	The New Hampshire state protocol for assessing culverts for AOP (borrowed directly from Vermont) involves using physical metrics of a culvert which approximate whether or not the conduit may be navigated by aquatic species. Of course, the actual capability of an individual organism varies greatly with age and abilities, among other things. But the metrics taken into account by the protocol may be used as a screen to help determine the likelihood any organism would be able to or desire to navigate a culvert. Since most movement by aquatic organisms occurs at other than the flood flows, the least-passable scenario is typically at lower flows where culvert geometry dominates AOP. In most cases, this would be the low-flow conditions when depths are lowest, and continuous waterways (in cases where the outlet is perched) are less likely. Thus, the model input data should be collected during periods of low-flow, or if unavailable, to be estimated for those occurrences. Some of these metrics are measureable in numbers, while others are observable properties such as inlet obstructions or the presence of native bed material within the culvert. The decision tree described in the assessment protocol then uses these values to determine a rating of:  Full AOP, Reduced AOP, No AOP except for Adult Salmonids, and No AOP for all species.
	It is important to note that in cases where there are multiple culverts at one crossing, the most passable culvert governs the rating for the site as a whole; if an organism can pass one, then other less-passable culverts would likely be ignored. Thus, the data entered into this section of the model should be for that of the most-passable culvert at the crossing. 
	The New Hampshire state protocol for assessing culverts for GC was also borrowed directly from Vermont, and uses a combination of measurable parameters and observational (best judgement) descriptions. There are five variables that each receive a score, and the sum of those give a total score for the crossing. The crossing is then given a rating based off that score, using thresholds defined in the GC published document. Since this screening guide involves text descriptions as well as measurable numeric values, some of the input values are more difficult to enter into this culvert model (things such as spelling might cause an error in a score assigned to a category). Thus, in addition to entering in the text data into the model, the user has the option to enter the score for each variable, which is then used to calculate the overall score for each crossing. This may be a more error-free method rather than attempting to enter the exact text each time.
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	This model was created to provide rapid hydraulic, aquatic organism, and geomorphic compatibility analyses for multiple crossings, using relatively little data and effort. The data required to run the model are nearly a minimum for these types of analyses, and do not cover the full spectrum.
	There are 11 tabs (worksheets) that are shown to the user (more calculation and reference tabs are hidden), seven of which are data input tabs, two are documentation, and two are results. As best practice, the seven input tabs should be filled-out in sequence to help ensure that all the fields are completed, though they may be filled-out in any order the user pleases. Descriptions of each tab are detailed in the following text.
	It should be noted that in order to use one of the tabs (the Rating Curve Generator), the user must have the Solver Add-In loaded and enabled within their version of Excel. There are different ways to do this for different versions of Excel, therefore the instructions for this may vary. Please refer to online documentation for the best way to do so for your version of Excel. The add-in will remain loaded and enabled for the future after it is installed the first time, therefore this step is only necessary once. This must also be referenced in Visual Basic, in order for the coding to be able to run the Solver function automatically. Microsoft and otherˇs provide ample online documentation as to how to do this. As a general guide, to install the add-in within Excel, click the Developer tab, then on the ribbon select Add-Ins. If Solver is not shown, browse to find it, and then be sure it is selected with a check mark. For Visual Basic, click the Tools tab, and select References. Then browse for Solver, (if it is not shown anywhere, you may have to browse for it and load it) and be sure that it is selected with a check mark.
	When looking at each input tab, all the cells that may be edited by the user will appear in two shades of yellow. Cells appearing in the darker yellow (               ) are variables that are required for that tab. Cells appearing in the lighter yellow (               ) are variables that are either optional or not required. On some of the tabs, after data is input to the cells, a cell may change color to look like this , highlighted in light orange, with italicized, dark-orange font. This means that the value entered into the cell is outside the recommended applicable range of values for that parameter. This does not necessarily mean an error; rather, this is simply meant to bring attention to this value, and make the user is aware of it � and that it is not a typographical error � and to indicate to the user that the resulting calculations may be less accurate due to the abnormal value. All the calculations will still be performed when this happens, but always ensure the crossing input data is reviewed for accuracy. More detail on these warnings is provided in the descriptions of each tab, including the ranges of values that define these warnings.
	This tab contains information pertinent to the model, and covers some of the detail in this document, in abbreviated fashion. It also specifies brief steps recommended for running the model, and lists some of the limitations and precautions to consider when using the model.
	This tab contains instructions on how to use the model, in less detail than described in this manual. However, it does include specific and detailed information and tables for helping the user select the appropriate Culvert Type Reference Number, to be used in the Hydraulic Input tab.
	This tab covers the basic information pertaining to the crossings. All of the categories in this tab are optional except for the Crossing ID. The Crossing ID must be unique for each crossing modeled in this batch run, as these are referenced in subsequent tabs, and by code and lookup functions. The Town, Road, and Stream are all location identifiers for the crossing, and the Latitude and Longitude are for exact reference location (at the upstream end of the culvert). These may be entered into the model in any format the user chooses (degrees-minutes-seconds, northing and easting, decimal degrees, etc.), as they are just for reference. The final column, Notes, is where the user may document any special notes about the crossing that they please.
	This tab contains all the data necessary to calculate the expected flows coming to each crossing. The data for this tab may all be obtained online, and there is additional documentation accompanying the model that details how to gather all this data in batch via GIS software or methods (found at end of this document).
	However, there may be instances where the user prefers to Override the Peak Flows. This may be the case for a variety of reasons; a drainage area too small to be properly analyzed online, one where too little information is available or the parameters seem suspect, an urban watershed that may be incorrectly delineated online, or a basin that has been previously or more thoroughly analyzed and flows determined. This may also be used in the case where future conditions may be modeled (adding a multiplier to current conditions, for example). Future conditions may also be accounted for in the data (such as increasing curve numbers or precipitation depths, lowering pond and wetland area). Therefore, optional flow override cells have been provided for such cases. Flows input here automatically override any calculations performed by data in the other cells on this tab, so only use these cells if this is desired.
	For the remainder of the cells, fill them all out in order for the model to calculate the peak flows � if a value is zero, enter 0 into the cell (this is not completely necessary, but is good for reference that the value is not missing, but rather a zero value). Also pay attention to units, these cells must be filled out with the correct units in order to perform the calculations correctly. Units for each data entry may be found at the top of the column for each data entry. Obtaining the data for these cells may be accomplished a number of different ways. It is up to the user to obtain the data in the manner they are most comfortable, and that which provides the most accuracy. Be sure to read through the Methods, Input, and Calculations section for details on exactly what data should be referenced or used.
	Drainage Area is entered in as square feet. The total contributing area to the watershed upstream of the culvert should be included. The Flow Path Length is hydraulic length of the watershed, and is used in the SCS Lag Equation to calculate peak flows. This length may generally be given as the longest distance water follows through the watershed. However, specifically it refers to the path that would take water the longest to navigate (time of concentration) before arriving at the outlet of the watershed (the crossing location, for this model). Next, the Flow Path Slope should be entered for two lengths; Overall and by the 10-85 Method. The Overall Slope is for the slope of the Flow Path Length (the difference in elevation from the high point to the outlet of the basin, divided by the length), and should be entered in as dimensionless number. The slope by the 10-85 Method is calculated as the difference in elevation from a point at 85% up the flow path length from the outlet minus the elevation of a point at 10% the flow path length up from the outlet, divided by the length of the flow path between the two points (or 75% of the total Flow Path Length). This slope should be entered in with units of ft/mi (difference in feet of elevation per mile of travel distance). The Area of Ponds and Wetlands contained within the watershed should next be entered (enter 0 for basins without any ponds or wetlands). This is followed by the Runoff Curve Number for the watershed. If the user is unfamiliar with how to obtain this value, refer to online documentation and tables of values. There are many good resources that can provide insight and guidance. Following this, in the next six columns, values for precipitation should be entered. The first is the Average of the Mean Basinwide April Precipitation, followed by the 24-hour Precipitation Depths for the 2-, 10-, 25-, 50-, and 100-yr storms. All precipitation data should be entered in inches. Following these precipitation depths, there is an optional input cell for defining the Rainfall Distribution Type. In New Hampshire, the southern and eastern part of the state is rainfall distribution Type 3: this is the model default value. However, if the culvert location lies within the area for Type 2 rainfall distribution, the user may define this using this input cell (user inputs of:  yes, y, 2, II, or type 2). Finally, there is also a Notes column in the tab where the user may record any information they desire with regards to values, input, or otherwise.
	Of note, the data � when entered � may appear highlighted as a different color and italicized (example). There are certain windows for some of the values used in these calculations that the methods recommend, or have been calibrated with. Values that lie outside of the range for the select parameter appear this way in order to highlight these instances. The peak flow calculations are still performed, but the user should be aware that the methods may not apply correctly. On the Peak Flow Input tab, warnings may appear for the 10-85 Slope, Area of Ponds and Wetlands, Runoff Curve Number, Average April Precipitation and the five 24-hour Precipitation Depths.
	The warning for the 10-85 Slope indicates that this value is either less than 5.43 or greater than 543 ft/mi. These are the limits for which the Regression Equations were calibrated. For the Area of Ponds and Wetlands, the Regression Equations were calibrated to watersheds containing less than 21.8% ponds and wetlands:   any value greater than that amount appears highlighted. The Runoff Curve Number cannot be larger than 100 (this would mean an error in entering the correct value, or an error in developing the value).  Documentation on the SCS method state that it does not necessarily apply to Runoff Curve Numbers less than 40. Again, the Regression Equations were calibrated to watersheds that had Average April Precipitations from 2.79 to 6.23 inches:   any values outside this range will result with a warning. Finally, the documentation regarding the SCS method state that a watershed that sees an Initial Abstraction (Ia, effectively, losses of precipitation to the watershed) divided by any 24-hour Precipitation Depth (this ratio of Ia/P is used in the equations within the SCS method calculations � the user need not worry about this much) should not be less than 0.1 or greater than 0.5. Essentially, this parameter reflects the amount of the precipitation that becomes flow contributing to the flood hydrograph. A ratio too low means that most of the precipitation becomes streamflow, a ratio too high means that much of the precipitation is lost to the watershed. In either case, the method was not developed for values outside of this range.
	These warnings, and others that are not shown immediately on this tab, are also shown on the Results tab, under the Peak Flow Results section, with details about the additional warnings provided in the Results tab description in this document.
	This tab contains all the input data necessary to perform the headwater stage calculations, as well as the site elevations required to determine the final hydraulic ratings. All of the input data for this tab should be collected in the field at each crossing site. 
	As described previously, the headwater depth due to inlet control is calculated using a 5th order polynomial equation, with coefficients unique to different combinations of inlet and pipe configurations. There are four parameters that determine which inlet control equation to use: pipe shape, pipe material, the pipe end type, and the pipe edge type. The first two are usually simple; the pipe shape describes the form of the opening (circular, box, elliptical, etc.), and the pipe material is the material which the pipe is made of at the inlet (concrete, metal, etc.). The second two are a bit less familiar; the end type describes the configuration at and around the inlet entrance (headwall, wingwalls, projecting, etc.), and the edge type describes the edge condition of the pipe at the inlet (sharp, square, beveled, etc.). For the purpose of this model, these four descriptors have been placed into a table that the user will need to read in order to define a Culvert Type Reference Number. This number tells the model which coefficients to use in the polynomial equation. The reason this number is used, rather than having the user enter in text descriptors for each parameter, is twofold. The first is simply to reduce error in entering a specific text string for each value. The second, and more complex reason, is that the appropriate Culvert Type Reference Number for an observed situation in the field may be different that the actual values for the parameters. This will be discussed in more detail in the following Culvert Type Reference Number section. There is much to outline about this one parameter, so first the remainder of the inputs on this tab will be documented.
	The first column on this tab is the Crossing ID. These values are referenced to the General Input tab, and should not be altered. Moving past the next four columns, which will be discussed in detail in the following section, the next four parameters are used to determine the inlet area. The first, and only required input for all shapes, is the Culvert Span. This refers to the width of the culvert (in feet). For circular culverts, this value is also used for the Culvert Rise (except for the case of an embedded circular culvert, where the effective rise � calculated internally within the model � would be the span less the embedded depth, though the actual culvert rise remains the same). The Culvert Rise is the next input parameter, and is required for all non-circular culverts. This refers to the actual rise (height) of the culvert, not the effective rise (such as the case of an embedded box culvert, for example). If a culvert is embedded, the actual rise is required and what should be recorded here. The next parameter is the Culvert Wall Rise. For all culverts that are not identical when rotated 180 degrees, this is required to help define the shape of the opening, which the model uses to determine the area (based on the shape defined by the Culvert Type Reference Number � description to follow). This value commonly refers to the point at which the shape is at its maximum span, but more specifically is the point at which the shape changes geometry, measured up from the invert. For pipe-arch culverts, it would be the location of the maximum width. For concrete arches, this would be the point at which the arch begins. For some shapes, such as a metal arch, this value would be zero. Finally, the last parameter that may be required is the Embedded Depth. This is the depth of the substrate at the inlet of the culvert that is rendered ineffective flowable area. This should be recorded only in instances where the culvert is actually embedded. A circular pipe placed into the bed of a stream is considered embedded. A culvert with sediment deposition, or blocked by beaver activity is not actually embedded. Though the capacity of the culvert is clearly reduced in these instances, these are considered to be maintenance issues and not issues pertaining to the culvert inlet headwater stage calculations. This may result in misleading ratings when thinking of the crossing at the day of the survey compared to the actual capacity of the crossing. Next, the Culvert Length (in feet) is required to be input. Following this, the Inlet Invert Elevation and Outlet Invert Elevation are required (feet). It is important to note that these refer to the actual invert elevations, not the elevation of any material that may be present causing the pipe to be embedded. If the actual invert of the pipe cannot be measured, it may be inferred by the culvert dimensions and the depth of the bed material. However, if the culvert is meant to be embedded, or is an open-bottom structure, then the elevation of the sediment is the correct elevation to use for the model. Something that may occur at a site, especially in open-bottom structures, is an irregular cross section of the channel at the inlet. In some cases, it may be minor enough to ignore. However, to account for this within the model (as there is no option for an irregularly shaped inlet) the user may develop an average depth of the cross section at the inlet, and enter this value into the Embedded Depth cell. The actual invert should still be recorded, but accounting for the irregular bottom in the Embedded Depth provides a more accurate representation of the total flowable area that exists at the inlet. In this case, the Inlet Invert Elevation would still be recorded as the elevation of the thalweg at the inlet, as this � together with the Outlet Invert Elevation and the Culvert Length � define the culvert slope, which in many cases is the applicable slope. However, with instances of upstream deposition or, or culverts with multiple slopes (broken back culverts), there may be the need to override the slope calculated by the inlet and outlet Invert elevations and the length. If this is the case, there is an Optional Culvert Slope override where the user may input a more appropriate value for the effective slope at the inlet of the culvert. The final elevation required for this section is the Failure Elevation. This is the elevation (feet) that when the headwater stage exceeds it the crossing is considered to be rated as Failing. This elevation may be standardized to the manner in which the user chooses:  when the headwater stage reaches the road surface; when the headwater stage reaches the necessary freeboard; when headwater stages reach a point that floods infrastructure upstream of the crossing; among any number of reasons that might be of critical interest to the user or to the project. Of note, this elevation should generally (though there are uncommon circumstances) be above the elevation of the top of the pipe at the inlet. This elevation � the top of the pipe at the inlet � is what the model uses as the definition between Passing and Transitional ratings. Also important to note for these elevations, and for all the elevations at one crossing location (used in this tab and others), the elevations do not have to be absolute (global). Elevations may be relative elevations set to any datum (and any value for that datum) at each site. However, all the elevations (relative or global) at one crossing across the entirety of the model should be relative to each other.
	Moving along, the next two input variables are optional, the first of which is the Optional Number of Adjacent Culverts. As detailed previously in the Limitations and Precautions section, this model is only able to analyze one type of culvert at one crossing. Crossings with identical culverts at the same elevations may be analyzed using this input cell, defining as many identical, parallel culverts as exist at the site. Unfortunately, where crossings have multiple, dissimilar culverts, some sort of adjustment must be made. There is no easy, standard way to do this, so it is up to the user to account for this using their best judgement. The most important thing to keep constant when combining multiple culverts into one shape, is to ensure that the invert elevation and the rise remain almost � though exactly is best � the same, and to adjust the shape and the width as best as possible in order to match the total flowable area for the new, singular, representative culvert to the combined total flowable area of all the culverts that actually exist at the site. Remember, the Inlet Invert Elevation and the Culvert Rise are used to determine the top of the pipe at the inlet, and the inlet control headwater elevations; therefore these are quite important to keep as close to the same as possible. This step may be challenging at times, and it is up to the user to use their best judgement. Finally, the Optional Culvert Slope has been described previously, and is an optional input the user may enter for a crossing that may better define the slope should that be deemed necessary.
	Similar to the Peak Flow Input tab, some cells containing values may appear highlighted in light orange with dark orange, italicized text (example) to convey a warning to the user. Again, the calculations for the inlet control headwater depths are still performed, but the user should be aware that some of the entered values may be outside the recommended ranges for some parameters.
	On the Hydraulic Input tab, there are warnings for Culvert Span, Outlet Invert Elevation, and Failure Elevation. In the FHWAˇs HDS5 publication, and in the manual for HY-8, it is suggested that culverts with a span greater than 20 feet may be too large to properly be governed by the equations used in HY-8. Spans larger than this will appear with a warning. However, caution should be taken in that spans much smaller than this may still be better represented by open channel flow calculations than by the equations used in the model; the culvert hydraulic function fundamentally relates flow to the flowable area. However, since this flowable area is not readily defined anywhere in either publication, the 20-foot span warning is all that is used in this model. A warning is shown for the Outlet Invert Elevation when this elevation is higher than the Inlet Invert Elevation. This results in a negative slope, which is unworkable in the equations built into the model. When this occurs, the model automatically defaults to a flat (0%) slope. Thus, this warning alerts the user that either an incorrectly input elevation value was recorded/entered, or that the crossing may need further analysis to properly assess the hydraulic capacity. Finally, a warning is shown for a Failure Elevation that is lower than the top of the culvert. While this is entirely possible, and in no way diminishes the modelˇs hydraulic analysis, this warning is simply to aid QA/QC by helping to ensure that all the data has been entered correctly.
	These warnings, and others that are not shown immediately on this tab, are also shown on the Results tab, under the Hydraulic Results section, with details about the additional warnings provided in the Results tab description in this document.
	The Culvert Type Reference Number has been a source of confusion for many users who used Version 1 of this model. This is not something that is used in other places, or by any other source; it is unique to this model. The number is simply determined by the user to describe unique combinations of inlet conditions that are condensed down to one, easily referenced value. This value � the Culvert Type Reference Number � is then used by the model to select the appropriate inlet control polynomial coefficients (from a large reference table of values). 
	The Culvert Type Reference Number condenses inlet geometric variables down into a number that then is used for hydraulic calculations. 
	There are four properties that are used to define the Culvert Type Reference Number; the Shape, Material, End Type and Edge Type. The former two properties are straightforward and are likely familiar to many users; the latter two may be less familiar to users. When describing the culvert properties, the End Type refers to the layout of the site immediately surrounding the culvert inlet; features such as the presence of headwalls, wing walls, or if the culvert is projecting from the embankment. The Edge Type describes the condition of the edge of the culvert; whether it is sharp or thin, has a square or beveled edge, or perhaps is grooved. For the purpose of creating a simple sorted table for the user to use in selecting the Culvert Type Reference Number, the End and Edge Types have been combined into one description. Thus, in the Instructions tab in the model, the user is asked to refer to the table, Selecting the Culvert Type Reference Number.   First find the appropriate Shape, next the Material, then the End and Edge Type, and selecting the number which corresponds to those four conditions. For many crossings, this may be an easy task; for others, this may be a bit more difficult, as there may be configurations present without a well-defined Culvert Type Reference Number available in the table.
	The hydraulic calculations associated with flow into culverts combine the aspects of flow through pipes and open channels. There are many factors that create chaotic conditions almost impossible to model completely. In order to simplify the analysis and to estimate the expected hydraulic losses due to inlet conditions, the FHWA tested different combinations of inlet configurations under lab conditions, recorded the results, and developed plots of the data. 5th-order polynomial equations were fitted to the data and these are the equations embedded within this model; defining the Culvert Type Reference Number tells the model which polynomial coefficients to use. However, the FHWA developed these equations under lab conditions, and their purpose for doing so was to create equations used for designing culvert crossings. This model is meant more for estimating headwater stages at existing crossings. Thus, there may be ambiguity between what is observed in the field and what are available as options when defining the Culvert Type Reference Number. Existing crossings may be over 100 years old and may contain very old infrastructure � like rock arches, rusted-out metal culverts, old iron paper mill rolls, and many more. None of these examples are standard culverts or would even be recommended � let alone permitted � to be used for the purpose of designing a crossing today. It is highly likely that many existing crossings will have properties that are not well defined, if even found, as options for determining the Culvert Type Reference Number.
	Model users should use their best judgement to select the most appropriate number associated with the most similar conditions found in the field. It is recognized, in practice, this is not always an easy task. 
	First and foremost; try not to overthink this step. Remember that this model is meant as a coarse screening tool, and that thorough analysis is beyond its capabilities. Though not universally true, the most important factor in determining the capacity of a culvert is the flowable area of the culvert (the open cross section at the upstream entrance). If the culvert is oversized, the inlet conditions will have a much smaller overall impact. Therefore the most important information the user can develop in order to create the most accurate calculations is to obtain the correct sizing of the culvert which is used in calculating the culvert area. Of course, in doing this, defining the proper shape is important � the shape determines which area formula the model uses. This is usually the easiest part in determining the Culvert Type Reference Number. The more difficult part is determining the End and Edge Type. Try to estimate this as best as possible for the conditions present at each site. If the exact configuration is not available as an option, try to think about the configuration as it is observed in the field and how efficient or inefficient that configuration may be at conveying flows; for example, wingwalls direct flows into a culvert more efficiently than a square headwall. There are no universal truths associated with the inlet configurations for existing installations, therefore detailing an exact, ordered, relative-efficiency list of the configurations is not available. As a general guide for the four properties that describe the Culvert Type Reference Number, the most important and influential property to determine is the Shape. The next most influential property is the End Type, followed by the Edge Type, with the Material as the least influential property. This is due to the fact that the roughness described by the material has a larger impact on smaller culverts than larger ones. However, smaller culverts (at least, ones that would be more influenced by the material roughness) would not necessarily be applicable to this model. These culverts would be more characteristic of drainage culverts than stream crossings. While smaller culverts may absolutely be analyzed in this model, most likely users will be interested in culverts that are larger, and to which the material would have the smallest impact. In terms of overall performance of the inlet configuration, the Material and End and Edge Type have far less impact on the headwater stages than the Shape or flowable area. Though, as good practice, properly attempting to describe all variables  is important. In an attempt to help the user select the appropriate End and Edge Type for a site without an exact configuration being listed in the model, the following guidance is offered:
	End Types: Wingwalls ¢ End Section ¢ Headwall ¢ Mitered ¢ Projecting
	Edge Types: Beveled ¢ Grooved ¢ Square ¢ Thin
	These Types are listed in the order of most hydraulically efficient to least hydraulically efficient. This relative performance may be used as a guide to help the user best select a Culvert Type Reference Number that may best approximate the conditions in the field. If a crossing looks to be fairly efficient, select a more efficient configuration. The same goes for less efficient inlet conditions. 
	Modeling multiple culverts at a site is challenging. This model, in keeping it as simple as possible, only performs calculations for one culvert at a time. Therefore at crossings with multiple culverts, assessing them in the model may be accomplished several ways.  The more accurate method is suggested herein. In situations with multiple culverts, model each individually, at the design flows as well as smaller flows (since not all of the design flows will pass through just one culvert).  At this point you will have a hydraulic rating curve for each of the individual culverts (headwater depth versus flow in each culvert).  Next, develop the rating curve for the system of culverts.  To do this, start by selecting a fixed headwater depth.  Next, from the individual culvert rating curves, read the flow through each culvert for that headwater depth.  Add these flows together and that is then one point on the multiple culvert hydraulic rating curve.  Select another headwater depth and repeat until the combined flows cover the range of the desired flood flows.  With the rating curve for the multiple culverts you may then apply the hydraulic rating criteria.
	One final important note of the Hydraulic Input tab as it relates to the Pipe Arch culvert shape. Pipe arches come in many sizes, with each size having variable values to describe their overall shape. There are usually three radii associated with the pipe-arch shape:  one radius each for the top, bottom, and corner curves. These three radii vary with their lengths, depths, and widths across manufacturers and size classifications. Therefore, there is no single formula to determine the actual area of a pipe arch from a nominal size due to the infinite geometric possibilities between manufacturares. In HY-8 this is remedied by having the user select a size, from which it determines the area using a manufacturerˇs table of values. Selecting sizes is not an option in this model, rather the cross sectional pipe arch area is estimated using the equation for an ellipse. This was found to be quite accurate. In a comparison of the pipe arch sizes and areas listed in HY-8 to the areas calculated by the ellipse equation as part of the development of this model, it was found that the range of variability was anywhere from 88-117% of the actual value. And while that is the full range of variability between the actual versus the calculated areas, most areas were calculated to be much closer than that. Of all the sizes, 80% were calculated within +/- 2.5% of the listed area, and 90% were within +/-5%. Thus allowing the user to enter pipe arch dimensions of span and rise and calculating the area from those two variables in the ellipse equation is a reasonable approximation. However, the user should be aware that this is not universally true; an area calculated to be 117% the size of the actual area will have a strong effect on the calculated headwater stages. When a Pipe Arch is present at a site, all its appropriate descriptions should be collected, and the actual area should be read from published sources or measured. Many manufacturer sources are available online, as well as in the documentation for HY-8, and even within HY-8 itself. The user may then decide to enter a slightly different Span (though the Rise should remain the same) for the Pipe Arch just in case the published area is different than what is calculated.
	This tab is a new addition to Version 2 of the model. It accounts for headwater effects resulting from downstream conditions. Most commonly, the model will use the tailwater stages calculated by Manningˇs equation. However, there are other instances � such as tidal, backwater from dams, flooding from other rivers � that may require user definition of the tailwater elevation. Technically, this tab is not required, as headwater stages are still calculated for the inlet control calculations. However, as best practice, this tab should be completed. If the water elevations for the tailwater control are larger than those for the inlet control, the tailwater elevation will be the controlling headwater driver. The Tailwater input cells include a Water Surface Elevation for each of the five return period flows, and a column for Notes regarding any of the crossings.
	This tab may be filled-out in one of two ways. First, the user may opt to input the values manually, as would be the case for situations such as tidally-influenced backwater, some constant pool of water throughout the culvert, or tailwater elevations due to damming downstream from the crossing. However, the user may also calculate the water stages using the Rating Curve Generator in the following tab. Instructions for the use of this generator are in the following section, and briefly described on the tab.
	As with the two previous tabs, warnings are shown for cells with Tailwater Water Surface Elevations � at any of the five return period flows � that are higher than the Inlet Invert Elevation. Again, all the calculations are performed to determine headwater stages for inlet control; however, with backwater possible within the system this may have a large effect on the actual hydraulic capacity of the crossing. The warnings shown on this tab are meant to inform the user that additional analysis may be necessary to more accurately assess culvert hydraulics. Additionally, if the user sees that a large number of crossings display warnings, it may serve as a general notice that the culvert collection as a whole may be misrepresented by the inlet equations alone.
	These warnings, and others that are not shown immediately on this tab, are also shown on the Results tab, under the Hydraulic Results section, with details about the additional warnings provided in the Results tab description in this document.
	This tab is also a new addition to Version 2 of the model. This tab is only to calculate water stages at the downstream tailwater control cross section (downstream of the outlet of the crossing). This generator may only be used if the Solver function is referenced and enabled in both Excel and Visual Basic, as described previously. 
	Essentially, what this generator does is to calculate the water stage at the tailwater cross section for each of the peak flows. This is not a simple calculation but rather it is an iterative process. This is the reason the Solver function needs to be enabled; Solver determines the water stages iteratively by varying the stage, calculating a flow, finding the difference in that flow to that defined for each Peak Flow, and adjusting the stage until the difference in flows is zero. 
	There are brief instructions on the tab as to how to use the generator, as a listed order which the user should follow. Follow the steps in order to ensure that the generator works properly. If, at any time, the generator produces an error or you wish to stop the process, press the escape key and end the macro. Before starting this generator, the user must first have completed both the General Input and Peak Flow Input tabs. This allows the generator to reference values from both and calculations resulting from that input.
	To use this tab, the user will need to survey a cross section at the location of the tailwater control. This tailwater control point can almost always be estimated by the location of the highest thalweg elevation point downstream of the pool at the outlet of the culvert (the riffle head at the end of the scour hole). Often, at a stream crossing, there will be a scour pool at the downstream side of a culvert, usually caused by high culvert exit velocities eroding the stream bottom there. At the end of this pool, the stream channel has a higher elevation than the elevation of the bottom of the pool. This is the recommended location for the Tailwater Cross Section. At this location, a cross section should be surveyed using Station and Elevation data, and the channel slope (TW Slope) estimated from this tailwater cross section on downstream. It is important to note that the elevation data entered here does not need to be tied-in to global elevations; but they do need to be referenced to the same datum as all other elevations at one site that are entered into this model. In addition to the stations and elevations, the user will need to estimate and record the values for Manningˇs Roughness Coefficient (Manningˇs n) for both the channel (usually applies from toe of bank-to-toe of bank) and the floodplain. There are many sources that can provide the user details on how to calculate/estimate these coefficients, and there are many more that provide approximate values for different scenarios. Please consult online documentation for more information regarding the Manningˇs n.
	To start, the user must enter the Crossing ID. This is used by the tab to find the peak flows and reference them into the table below this input cell. Next, the user will enter the TW Slope in ft/ft. This refers to the downstream slope of the channel, starting at the location of the Tailwater Cross Section. Finally, the user needs to enter the cross section information into the User-Entered Tailwater Cross Section table, using Stations and Elevations. The third column in this table requires Manningˇs n to be entered. This should be estimated in the field, or in the office from site pictures and understanding streambed materials. The value for Manningˇs n applies from the station that it is entered next to, on to the next station entered (horizontally variable Manning n):  technically one is not required for the final station entered; however, one is required for all others.
	When data entry for this tab is complete the user should press the Calculate Rating Curve button. The rating curve is then computed and displayed in the adjacent table of Results, as well as display the cross section and water surface elevations (WSEL) on the Tailwater Cross Section and Flow Stages Plot. This should be reviewed by the user to inspect if the results look reasonable. If it does, the user may then press the Copy Values to Tailwater Input button to copy the values to the Tailwater Input tab. When this is done, the user may reset the sheet by pressing the Reset Sheet button.
	Of note, if the Tailwater Cross Section entered into the tab is not large enough to convey the peak flows for the crossing, the user will get a warning, and the macro will end. Without a channel large enough to convey the flows, the generator cannot achieve a solution. The user will then need to obtain/estimate additional cross section data points in order to make the cross section large enough to carry the flows. When collecting this data in the field, be sure to capture more than enough data to properly use this generator.  
	AOP screening is another new addition to Version 2 of this model. This tab is optional to complete, but provides the user with an aquatic organism passage (AOP) rating. If there are multiple culverts at a crossing, the information entered for a single crossing on this tab should be for the most-passable culvert at the site. The reasoning for this is simple: if one culvert is more passable than another, this would likely be the path an organism would take, rather than a more difficult one.  If what is considered the most passable culvert is impassable, then the other culverts are not passable.  They of course could be individually rated with this model.
	If an AOP rating is desired, all the cells in this tab are required except for the Outlet Pool Low-Flow Water Elevation, which is only required when there is a low-flow water stage present at the outlet. This may not be the case for all crossings � some crossings may be dry during low-flow conditions (ephemeral or intermittent streams). In this case, the model uses the Tailwater Control Profile Point Elevation as the surrogate for the Outlet Pool Water Elevation.
	Of note, this input is of a slightly different format than what is collected as part of the NHDES Culvert Assessment Protocol. Parameters collected per the NHDES protocol include combinations of elevations and depth readings. The data may be transformed from one format to the other, with all the input into this model telling the same story as that collected as part of the NHDES protocol. Since this model (especially for the hydraulic calculations and input) relies heavily on local site elevations, for the purpose of simplicity and consistency within the model, the input on the AOP Input tab is in elevation format, rather than the depth format seen in the NH Culvert Assessment Protocol.
	The first column on the tab is automatically populated from the Crossing IDs entered in on the General Input tab. Next is a column with a simple Yes or No answer and asks the user to define whether or not there is an Inlet Obstruction present. Obstructions may be of any type, from trash racks to log jams to sediment aggradation and so on. Next is a column for the Number of Culverts present at the site. It is important to note that this refers to the number of main-channel culverts at a site, not floodplain or overflow culverts. Following this is a column for the Outlet Invert Type. The input here may be of the format ˝A˛ or ˝At Grade˛; ˝B˛ or ˝Backwater˛; ˝C˛ or ˝Cascade˛; and ˝F˛ or ˝Free Fall˛. These types may be researched more in the stateˇs Aquatic Organism Screening Tool documentation, but in brief:
	At Grade � refers to an outlet that has an invert at the thalweg of the stream, with the culvert and outlet having slopes relatively close to that of the stream channel.
	Backwater � refers to an outlet that has a constant stage of water over the invert, even at low-flows, caused by downstream controls.
	Cascade � refers to an outlet that has an invert that rests on stream material, but whose slope is much steeper than that of the rest of the channel; often resulting in cascading water over the surface.
	Free Fall � refers to an outlet with an invert that is perched above the water elevation of the downstream pool at low-flows.
	The next two columns on the tab both have Yes or No input. A culvert with natural stream substrate throughout the length will have Yes input for Natural Bottom, and the presence of a pool just downstream of the outlet will also have Yes input for the Outlet Pool column. The next five columns are all elevations taken at locations along the profile of the stream and culvert: the Outlet Invert, Outlet Pool (which refers to the elevation of the bottom of the pool immediately downstream of the culvert), the Tailwater Control (discussed previously); and two elevations of the water surface along the profile: the Outlet (elevation of the water surface at the outlet of the culvert), and the Outlet Pool (the elevation of the water surface at the pool downstream of the outlet; preferably taken at the same location as the Outlet Pool profile elevation). Finally, there is a column for any Notes related to the AOP Input at the end of the table.
	Please refer to the stateˇs Aquatic Organism Screening Tool for further detail on the methods and variables for the AOP screen rating and data.
	This tab is another update from Version 1 of the model. It is an optional tab to complete, but provides a rating for Geomorphic Compatibility for the crossing if filled out. The tab uses input that derives directly from the stateˇs Geomorphic Compatibility Screening Tool (which was borrowed directly from Vermont � refer to the Vermont Culvert Geomorphic Compatibility Screening Tool, 2008, which may be found in the References section of this document).
	The screening tool uses physical and observational metrics contained within five individual variables, with each variable then being assigned a score of 0 to 5, and the sum of those five scores giving a GC rating to the crossing. 
	The data used to score each variable is only sometimes measurable in this screening tool; other times it is observational. Thus the recorded data for this screen contains a lot of text, and is subject to interpretation among observers. It is common practice that when this data is taken in the field, a score is immediately assigned for each variable. Therefore, this tab may be filled out in one of two ways: first, by filling out all the input cells with the actual, observed or measured values; or second, by entering in the individual scores for each variable. The second method is preferred, as entering the five scores in number format is easier than entering in each of the text or numerical values associated with the first method, but either way works. A combination of the two methods may be used as well.
	Please refer to the GC Screening Tool documentation listed in the References section for a more robust explanation of the screening tool and all of the variables and input used.
	To enter in the scores for each variable, the five columns to the right of the table may be used (the final column is for Notes pertaining to the GC Input tab for each crossing). 
	The first column is automatically populated using the Crossing IDs from the General Input tab. The first input tabs next to this are for the Bankfull Width and Bankfull Mean Depth, both in feet. These both refer to the bankfull dimensions of the stream near the crossing, and should be measured at a location upstream or down where good geomorphic indicators exist for obtaining each, and where the effects from the crossing are not present. The next input column is a Yes or No answer to whether or not there is Upstream Aggradation of sediment at the inlet to the crossing, and if so the depth of that aggradation recorded in feet in the next column, under Depth of Upstream Aggradation. The next column asks for a Yes or No response whether or not there is scour of the channel bottom at the outlet of the culvert (Downstream Scour), followed by a description of the bank heights by either rating them as High or Low in the Downstream Bank Height column. The next two columns are Yes or No answers, and refer to the culvert slope, stream slope, and valley slope. In the first, the culvert slope is compared to the stream slope, and is rated whether or not they are similar (Same Structure and Stream Slope). The second slope column (Local Break in Valley Slope) asks whether the crossing is located at a break in the valley slope. This may be most accurate to define using a topographic map and/or a computer, rather than at the site. Following this is a rating for the Approach Angle of Stream to Crossing, which defines the approach angle of the stream with relation to the culvert, and can be rated as: Natural (meaning naturally straight into the culvert); Channelized (meaning that the stream is entering the culvert straight-on, but that it was altered to do so); Mild (meaning that the stream enters the crossing at a mild angle); or Sharp (meaning that the stream enters the crossing at a sharp angle). The next two columns define whether or not there is erosion of the streambanks at the upstream or downstream end of the crossing (Upstream Erosion and Downstream Erosion columns). These two may be filled out using the responses of None, Low, or High. Finally, the column for Crossing Armoring details whether or not there is armoring present at the crossing, and if so whether it is intact or failing. This column may be filled out with responses of None, Intact, or Failing.
	With the cells filled out, the scores are either summed together (for the optional user-entered scores) or determined from the input then summed (for when individual input cells are filled out). The sum of the five individual scores produces a total score, which is then used to rate the crossing. Please refer to the Geomorphic Compatibility Rating section of this report for a full description of the ratings and the score ranges for each rating.
	After completing all of the previously described tabs and all required or optional input, the full table of all the ratings may be seen on this Ratings tab. There are three tables, the first of which shows all the Crossing IDs and some locational information (Town, Road, and Stream), followed by the five Hydraulic Ratings (2-yr, 10-yr, 25-yr, 50-yr, and 100-yr), the AOP Rating, and the GC Score and GC Rating. Following this table are the Ratings At-A-Glance, which is a very brief summary of the ratings in a condensed manner, with the columns being very thin. This may be useful for the user to quickly look at a row and see, using coloring for the ratings, how the crossing performs across all three assessments. If a row is all green, the crossing is performing well; conversely if there is a lot of red in a row, the crossing is failing one or more criteria. Finally, well to the right side of the tab, there is a table which shows the Ratings Key. This table describes the meaning of each of the Ratings in a little detail. 
	Hydraulic Ratings are given for each of the five calculated peak flows. Hydraulic ratings of Pass, Transitional (shown as Trans), and Fail and are highlighted in green, yellow, and red, respectively. As described previously, these ratings describe the relative headwater stage at the inlet from each of the peak flows. The ratings are defined by two elevation points: the top of the culvert at the inlet, and the user-defined Failure Elevation, input by the user on the Hydraulic Input tab. The Failure Elevation may be any elevation the user chooses to reference, and may vary from site-to-site. What it should refer to is any critical elevation which, when the headwater stage reaches it, is considered hazardous or may result in damage to infrastructure. Most commonly this will occur at the elevation where water would begin flowing over the road; in other instances it is the elevation at which the water floods upstream infrastructure or bypasses (flanks) the structure in the case of perched roads. This stage is only input into the model to define when the user would like to see a rating of Fail.
	Thus, any peak flow that results in headwater stages that are below the top of the culvert at the inlet are rated as Pass. Any peak flow resulting in a headwater stage above the Failure Elevation is rated as Fail, and any headwater stage between the two elevation points is rated as Transitional.
	This section of the table displays the AOP Ratings resulting from the input on the AOP Input tab. The ratings are assigned as defined in the New Hampshire AOP Guide. The ratings are:  Full AOP, Reduced AOP, No AOP � Adult Salmonids, and No AOP, all highlighted in green, gray, orange, and red, respectively. A rating of Full AOP means that the crossing is likely to be passable by any aquatic organism. A rating of Reduced AOP means that the crossing likely is challenging or less desirable for organisms to navigate due to one or more factors. A rating of No AOP � Adult Salmonids means that the crossing is likely impassable for all aquatic organisms except for adult salmonids, which are much better swimmers and leapers than most other species. Finally, a rating of No AOP means that the crossing is likely impassable to all aquatic organisms, including adult salmonids.
	This section of the first table on the Results tab shows the Geomorphic Compatibility Rating and the Score calculated from the GC Input tab. The Geomorphic Compatibility Rating is based on the New Hampshire State Protocol.
	Essentially, there are five categories included in the assessment that each receives a score from 0 to 5. The sum of the individual scores gives the crossing a total score, and this is rated based on the total score out of the maximum possible 25, in increments of 5. This rating is meant to assess the crossing for its compatibility with the natural fluvial geomorphic characteristics of the stream � basically how the stream transports sediments and debris. If the crossing is a barrier to the transport of materials, an imbalance occurs, and may result in erosion, deposition, instability, and/or failure.
	Geomorphic Compatibility Rating Key
	Description
	Score Range
	Rating
	Structure fully compatible with natural channel form and process. There is a low risk of failure. No replacement anticipated over the lifetime of the structure. A similar structure is recommended when replacement is needed.
	Fully Compatible
	20 < Score — 25
	Structure mostly compatible with current channel form and process. There is a low risk of failure. No replacement anticipated over the lifetime of the structure. Minor design adjustments recommended when replacement is needed to make fully compatible
	Mostly Compatible
	15 < Score — 20
	Structure compatible with either current form or process, but not both. Compatibility likely short-term. There is a moderate risk of structure failure and replacement may be needed. Re-design suggested to improve geomorphic compatibility.
	Partially Compatible
	10 < Score — 15
	Structure mostly incompatible with current form and process with a moderate to high risk of structure failure. Re-design and replacement planning should be initiated to improve geomorphic compatibility.
	Mostly Incompatible
	5 < Score — 10
	Structure fully incompatible with channel and high risk of failure. Re-design and replacement should be performed as soon as possible to improve geomorphic compatibility
	Fully Incompatible
	0 — Score — 5
	The first column in the GC Rating section is for the Total Score, which is the sum of the five individual scores. Next to this is the Rating, which a crossing is rated as Fully Compatible, Mostly Compatible, Partially Compatible, Mostly Incompatible, or Fully Incompatible, and are colored light green, dark green, yellow, orange, and red, respectively. The table shown on the previous page summarizes the Rating, the Score Range, and contains a description of each Rating.
	This tab shows some of the calculated results from the model, in addition to the three ratings. These results describe in more detail some of the key values and descriptions used in the final ratings, as well as any warnings that may be present for the data entered for any crossing.
	The first section of the table of results contains General Information which is referenced directly from the General Input tab. After this is a section for the Peak Flow Results. Contained within this section is the Watershed Area (in acres), followed by the Calculation Method that the model determined as being the appropriate method to calculate the five peak flows. The next five columns all show the calculated peak flows (in cfs); followed by the last two columns, which detail whether or not there are warnings associated with the data entered to calculate the peak flows, and the warnings. The Peak Flow Warning Type(s) are each separated by a dash (-), and are subject to the constraints detailed in previous sections of this document. The short codes are: Pa (Average April Precipitation), %W (Percent Ponds and Wetlands), S (10-85 Slope), Ia/P (Ia/P Ratio; the ratio of intercepted precipitation over the total precipitation amount), Cn (Curve Number), and Tc (Time of Concentration).
	The next section of the table is for the Hydraulic Results. The results shown here first contain the Total Flowable Area of the structure(s) at the crossing, followed by the Bankfull XS Area from Regional Curves, which calculates the ˘naturalˇ flowable area of the stream based on the Drainage Area, using equations developed for New Hampshire. The ratio of the structure flowable area at the crossing to the calculated bankfull area is then shown as a percent in the next column, % Flowable Area to Bankfull Area. The following three columns show the same as the three previous ones, only for the culvert and bankfull width instead. The next two columns detail whether or not there are any warnings present for the entered data, and the specific warnings. The short codes for the Hydraulic Warning Type(s) are: NS (Negative Slope), LS (Low Slope), W (Wide Span), and F (Failure Elevation lower than the Top of Pipe at the inlet).
	The final four sections of the results table show the same ratings for the three rating types, seen on the previous tab, with the exception of the GC Results section. This section simply shows the calculated or user-entered individual scores for the five variables used in determining the GC Rating. 
	This is the final tab in the file and simply shows the ratings for all three rating types as quantities and percentages of the total number of crossings analyzed. For the hydraulic ratings, the results are tabulated for all five return periods (2-, 10-, 25-, 50-, and 100-yr), and shown as pie charts for only the latter four of those return periods. The AOP and GC ratings, if the user has opted to enter this data, show the total number of crossings per each rating in pie charts for each of the two rating types.
	References
	Data Requirements – Listing the data sources that are used in the model
	Data from NH Granit - http://www.granit.unh.edu/
	Other datasets

	Software requirements
	Project Folder and ArcMap Setup
	Input Gathering and Preprocessing
	DEM Processing

	Cornell University. (n.d.). Extreme Precipitation in New York & New England. Retrieved from http://precip.eas.cornell.edu/
	Earth Systems Research Center, Institure for the Study of Earth, Oceans and SpaceUniversity of New Hampshire. (n.d.). Retrieved from NHGRANIT: http://granitviewii.unh.edu/ 
	Federal Highway Administration. (2012). Hydraulic Design of Highway Culverts, Third Edition. Department of Transportation. https://www.fhwa.dot.gov/engineering/hydraulics/pubs/12026/hif12026.pdf 
	Federal Highway Administration. (2016). HY-8 User Manual (Version 7.4). Department of Transportation.  https://www.fhwa.dot.gov/engineering/hydraulics/software/hy8/  
	Natural Resources Conservation Service. (1986). Urban Hydrology for Small Watersheds (TR-55). Retrieved from https://www.nrcs.usda.gov/Internet/FSE_DOCUMENTS/stelprdb1044171.pdf 
	New Hampshire Department of Environmental Services. (2014). New Hampshire Stream Crossing Assessment Protocol Instructions.  https://www.des.nh.gov/organization/divisions/water/wetlands/documents/culvert-assessment-protocol.pdf
	PRISM Climate Group, Oregon State University. (n.d.). Retrieved from http://www.prism.oregonstate.edu/normals/https://websoilsurvey.sc.egov.usda.gov/App/HomePage.htm 
	United States Department of Agriculture, Web Soil Survey, https://websoilsurvey.sc.egov.usda.gov/app/HomePage.htm?utm_source=Updated+December+2013+Connections&utm_campaign=  
	United States Geological Survey. (2009). Estimation of Flood Discharges at Selected Recurrence Intervals for Streams in New Hampshire. Department of the Interior.  https://pubs.usgs.gov/sir/2008/5206/pdf/sir2008-5206.pdf
	United States Geological Survey, Streamstats, https://streamstatsags.cr.usgs.gov/streamstats/ 
	University of New Hampshire. (2009). New Hampshire Stream Crossing Guidelines. Environmental Research Group.  https://streamcontinuity.org/pdf_files/nh_stream_crossing_guidelines_unh_web_rev_2.pdf 
	Vermont Agency of Natural Resources. (2008). The Vermont Culvert Geomorphic Compatibility Screening Tool. Department of Environmental Conservation.  http://dec.vermont.gov/sites/dec/files/wsm/rivers/docs/rv_VTCulvertGCScreenTool.pdf
	Vermont Agency of Natural Resources. (2009). The Vermont Culvert Aquatic Organism Passage Screening Tool. Department of Fish and Wildlife.  http://dec.vermont.gov/sites/dec/files/wsm/rivers/docs/rv_VTAOPScreeningTool.pdf
	Note:  all cited web links last accessed 22 May 2017
	StreamWorks-TU Culvert GIS Model Instructions
	Authors:
	This protocol was originally authored in the model version 1 by Apollinaire William of Antioch College.  For version 2 the methodology was refined by David Justice with NH GRANIT.   Tom Taggart and Robert Cole with NHDES then further modified the content to mesh with NHDES needs.  
	Introduction
	The objective of this GIS model is to generate watershed characteristics such as area, slope, longest flow path, SCS curve numbers, coverage by wetlands, ponds and lakes, and precipitation distribution for any given storm event. These parameters are necessary for the computation of runoff and are essential for running a hydraulic model. The overall goal of the GIS modeling is to assess the hydraulic capacity of existing road stream crossings within the watershed.
	o Digital Elevation Model (DEM) - 1m resolution 
	o Soil Survey Geographic (SSURGO) database for New Hampshire - last revised in 2009
	o New Hampshire Land Cover Assessment - 2001 - 30m resolution
	o NH DOT Road Network - Scale: 1:24,000.
	o New Hampshire Hydrologic Dataset (NHHD) - Scale: 1:24,000
	o 30-year normal- Precipitation: The normals are baseline datasets describing average monthly precipitation (mm) over the period 1981-2010. Monthly values in April were chosen to use with this model because they correspond to maximum precipitations for this area (New Hampshire). 
	§ Source: http://www.prism.oregonstate.edu/normals/.
	o Rainfall data for select recurrence interval storms: 2-10-25-50-100-year rainfall.  This data is available in gridded ascii file format from Cornell , at 0.8 km resolution; units are in 1000 x inches.
	§ Source:  http://precip.eas.cornell.edu/
	o Wetlands, ponds, and lakes from National Wetlands Inventory (U.S. Fish and Wildlife Service) . (CONUS_wet_poly layer). 
	§ Source:  http://www.fws.gov/wetlands/Data/State-Downloads.htmlShapefile for New Hampshire 
	o ArcGIS (with Spatial Analyst)
	o ArcHydro tools � Installation instructions follow  
	o HEC-GeoHMS  � Installation instructions follow  
	Note:
	Arc Hydro Tools are free with your ArcGIS software license. Download from: http://resources.arcgis.com/en/communities/hydro/01vn00000010000000.htm 
	1.) Create a folder on C:\ named appropriately for the area of interest. It is best to keep the name under 13 characters and without spaces. In the case of the following examples, the Turkey River watershed will be evaluated, and therefore the example directory structure will be C:\Turkey\.  The reason for a short folder name directly on the C drive is because    ArcHydro and HEC-GeoHMS are limited by long file names and pathways, we recommend creating a project folder directly in the C: drive of your computer. ArcHydro will create its own additional folder named Layers in the destination folder you specify as your workspace once you start using Arc Hydro tools. This folder will store ArcHydro output raster data, i.e. agreedem, cat, cngrid, fac, fdr, fil, str, strlnk.
	2.) Open ArcMap and create a file geodatabase within the project folder � name it the exact same as the project folder � e.g. C:\Turkey\Turkey.gdb.  Save your map document in the folder you just created for the project (C:\Turkey\).
	3.) Set the coordinate system of the empty dataframe as the appropriate state coordinate system � for New Hampshire this is NAD_1983_StatePlane_New_Hampshire_FIPS_2800_Feet (WKID: 3437 Authority: EPSG).  Ensure you are in ˘List by Sourceˇ or ˘List by Drawing Orderˇ in the Table of Contents. Right click ˘Layersˇ in the table of contents. Go to ˘Properties,ˇ Go to the ˘Coordinatesˇ Tab. Select ˘NAD 1983 StatePlane New_Hampshire FIPS 2800 (US Feet)ˇ from Projected Coordinate Systems -> State Plane -> NAD 1983 (US Feet) and click OK. Itˇs a good idea to add this to your favorites.  
	More info on the coordinate system at Granit - http://www.granit.unh.edu/resourcelibrary/GRANITresources/standards/datastandards.html 
	4.) Check to see if Arc Hydro Tools and HEC-GeoHMS tools are installed in ArcMap. 
	a. If these tools are not installed, go to http://www.hec.usace.army.mil/software/hec-geohms/downloads.aspx and download the version of the tools that is appropriate for your ArcMap installation. HEC-GeoHMS will automatically install Arc Hydro Tools.
	b. If Arc Hydro tools are installed, they will need to be uninstalled. To do this:
	i. Close all Arc related applications.
	ii. Go to Add or Remove Programs in Windows and remove ˘Water Utilities Application Frameworkˇ, ˘Arc Hydro Toolsˇ, and ˘HEC-GeoHMSˇ if they are present in the list. Go to step 4a.
	5.) Activate ArcHydro toolbar by clicking Customize in the menu bar, then highlighting Toolbars then ensuring there is a check next to Arc Hydro Tools and HEC-GeoHMS.
	6.) Turn off background geoprocessing. To do this, go to geoprocessing menu in the menu bar, click Geoprocessing Options, uncheck enable in the Background Processing area. Click Okay.
	7.) Click ApUtilities in the Arc Hydro Toolbar, click Set Target Locations. Highlight HydroConfig, and click OK. Set Raster Data to target the project folder you created in step 1 (e.g. C:\Turkey\). Set Vector Data to target the project geodatabase (e.g. C:\Turkey\Turkey.gdb\). Click OK.
	Figure 1
	Note 1: If a polygon representing the full extent of your area of interest (covering all possible culvert drainage areas) doesnˇt exist, you will have to create one � in the case of a watershed, this may mean delineating the watershed or using a pre-defined Hydrologic Unit Code polygon if the HUC represents a true watershed or covers all possible culvert drainage areas. 
	Note 2: Set the geodatabase you created previously as your default geodatabase, so that the results of the clip are output to the geodatabase.
	Loading and Clipping the Data
	1.) The following instructions will step you through loading and clipping each dataset. Store all downloaded datasets in the project folder (C:\Turkey\) 
	2.) Download and/or load and clip the LiDAR data for the area being analyzed:
	a. Download or load the LiDAR data from one of these locations:
	i. Web - NH Granit website: http://lidar.unh.edu/map/
	ii. Local: N:\GIS\Core_GIS_Datasets\Elevation_and_Derived_Products\LiDAR_Datasets
	b. When the data is loaded into your map document, clip the LiDAR data to your area of interest, using the Clip Raster tool in the Data Management->Raster->Raster Processing->Clip. 
	c. Note: Both locally and on the web, the data is separated into large watersheds / geographic regions; add the smallest one of these regions that covers the polygon representing your area of interest.
	3.) Download and/or load and clip the SSURGO Soils layer:
	a. Locations:
	i. Web � NH Granit website: http://granit.sr.unh.edu/data/search?dset=soils&#47;nh 
	ii. Local: N:\GIS\Core_GIS_Datasets\Geological_and_Geophysical\Soils_NRCS\soils_ssurgo_2009.shp
	b. As of 1/2017, soils data in the local copy is represented for the entire state in one shape file (soils_ssurgo_2009). Load this layer into ArcMap to be clipped by the watershed / project extent polygon later on.
	c.  Clip the SSURGO Soils data to your area of interest, using the Clip tool in Geoprocessing.
	4.)  Load and clip the NH Land Cover Assessment layer:
	a. Locations:
	i. Web � NH Granit website: http://granit.sr.unh.edu/data/search?dset=nhlc01&#47;nh 
	ii. Local:  N:\GIS\GIS_Projects\NH_Geological_Survey\GIS\Land_Cover_Land_Use\nhlc01.lyr
	b. The 2001 release of this data is currently the most up to date. Add the entire data set into your map to clip by the watershed / project extent polygon later on.  
	c.  Load nhlc01.lyr and repair data source to nhlc01.asc
	d. Clip the nhlc01.lyr data to your area of interest, using the Clip Raster tool in the Data Management->Raster->Raster Processing->Clip. Enable the Use Input Features for Clipping Geometry box.
	Optional Note: In order to retain symbology for the data, repeat as followed. In the NH Land Cover Assessment 2001 layer, enter property symbology and save symbology in the Export as Raster option. In clip of desired region, open property symbology and Import symbology saved from NH Land Coer Assessment 2001. 
	5.)  Load and Clip the New Hampshire Hydrologic Dataset:
	a. Locations:
	i. Web � NH Granit website: http://www.granit.unh.edu/data/search?dset=nhhd&#47
	ii. Local: N:\GIS\Core_GIS_Datasets\Water_Resources\NH_Hydrography_Dataset.gdb
	b. Note: The relevant layers inside this geodatabase are NHDFlowline inside the Hydrography file geodatabase feature dataset, and inside the WBD (Watershed Boundary Dataset) file geodatabase feature dataset, the Hydrologic Unit level that will fully encompass the drainage area of the outlet of the watershed / project extent as it may be used as the watershed / project extent polygon later on, defining the extent to which all of the other layers will be clipped.
	c. Create layer of desired hydrography data by using the Clip tool in Geoprocessing, and clipping to your watershed boundary or area of interest. (Note: Turkey River Watershed results use turkeyflowline shapefile, an older attempt to reconcile GRANIT with LiDAR. Future attempts should use  the most recent flowlines on the N Drive.)
	6.) Download the 30 year April Normal Precipitation over the period of 1981-2010 from http://www.prism.oregonstate.edu/normals/. The options that should be selected for downloading of the correct data should be:
	a. Spatial resolution needed: 800m (18-350MB per data file; 5MB per full-size image)
	b. Climate variable: precipitation
	c. Temporal period: monthly values for April 
	d. Click ˘Download Data (.asc)ˇ after selection options are correct
	Save this file in a Precipitation folder in your project folder.
	f. Note: Refer to the picture (Figure 2) below for clarity:
	Figure 2
	g. Add the entire data set into your map.
	h. Use the Project Raster tool to reproject these files to ˘NAD_1983_StatePlane_New_Hampshire_FIPS_2800_Feetˇ. In the Properties Display, resample using Cubic Convolution.
	i. Using the Clip Raster tool in the Data Management->Raster->Raster Processing->Clip. Enable the Use Input Features for Clipping Geometry box.
	7.) Go to http://precip.eas.cornell.edu/ click on ˘Data & Productsˇ at the top of the page. The page should display a map. On the left side of the page, click ˘GIS Data Filesˇ. The map should be replaced by a page with drop down menus. 
	a. For ˘Data Typeˇ select ˘Return Period Estimates.ˇ 
	b. For ˘Durationˇ, select ˇ24 Hour.ˇ 
	c. For ˘Recurrenceˇ, select ˘2yr (50%)ˇ, then click submit. 
	d. Rename the downloaded file (˘output.ascˇ) to something more illustrative of the data in the file, such as ˘PRECIP_2YR_24HR.ascˇ before proceeding.
	e. Repeat Steps 6c through 6e, selecting ˘10yr (10%)ˇ, ˘25yr (4%)ˇ, ˘50yr (2%)ˇ, and ˘100yr (1%)ˇ for ˘Recurrence.ˇ
	f. In ArcMap, open these files and set their projections to ˘WGS-1972ˇ using the Define Projection tool.
	g. Use the Project Raster tool to reproject these files to ˘NAD_1983_StatePlane_New_Hampshire_FIPS_2800_Feetˇ. In the Properties Display, resample using Cubic Convolution.
	j. Clip each raster to the area of interest, using the Clip Raster tool in the Data Management->Raster->Raster Processing->Clip. Enable the Use Input Features for Clipping Geometry box.
	8.) Get the New Hampshire Hydrologic Dataset:
	a. Locations:
	i. Web ¨https://www.fws.gov/wetlands/Data/State-Downloads.html and download the shapefile for the state of New Hampshire.
	ii. Local: N:\GIS\Core_GIS_Datasets\Water_Resources\NH_NWI.gdb\NWI
	b. Load the layer/shapefile into your map to clip by the watershed / project extent polygon later on.  
	Note: Clipping the Data � For DES users only
	There are two ways to do this (for layers besides the DEM):
	1.) If loading layers from the Core Data sets on the N Drive&
	a. Be sure NOT TO RE-PROJECT THEM!!!!!!!
	b. Clip these files using the polygon you have chosen to use as your project extent � options include: a manually delineated watershed polygon, a HUC polygon that encompasses the all possible culvert drainage areas, etc.
	i. When clipping be sure to set the output projection as  ˘NAD_1983_StatePlane_New_Hampshire_FIPS_2800_Feetˇ in the Environment Settings options
	2.) If using local layers, 
	a. You can re-project the local layers using Project and Project Raster tools to ensure that all files are in the ˘NAD_1983_StatePlane_New_Hampshire_FIPS_2800_Feetˇ projection.
	i. NOTE: When re-projecting the DEM (and any continuous raster data), be sure to go into Environment Settings and under Raster Storage set the Resample options to Cubic. Nearest Neighbor should never be used to resampling continuous data.
	b. Then clip  (without having to set the projection in the Environments options) 
	For the DEM, the best method (since the LiDAR is in UTM 19N) might be to:
	a) Clip in the original projection.
	b) Then re-project to NAD_1983_StatePlane_New_Hampshire_FIPS_2800_Feet with Cubic Spline resampling.  
	Pre-check
	1. Ensure that the dem is in your table of contents, and is projected in correct PCS (NAD_1983_StatePlane_New_Hampshire_FIPS_2800_Feet); if it is not, go to ArcToolbox->Data Management->Projections and Transformations->Raster and select Project Raster. Set Input Raster to the DEM you clipped from the larger LiDAR data, and name the output raster dataset to something appropriate (e.g. turkeySPFt), set output coordinate system to ˘NAD_1983_StatePlane_New_Hampshire_FIPS_2800_Feetˇ, and set resampling to Cubic. The X and Y should have values that correspond to the number of feet per previous map unit. In the example case, X and Y are both 3.280833 as this is the number of feet there is in one meter.
	DEM Processing Steps
	2. In ArcHydro, click Terrain Preprocessing, select DEM Manipulation, and then click DEM Reconditioning. Set Raw DEM to the DEM you extracted by mask (e.g. demSP83 double check this name has not changed.). Set the AGREE Stream to your flowline, (e.g.nhdTraceTurkeySP). Set Sharp drop/rise equal to 10. Click Okay. This process can take a while, and can require many tens of gigabytes of hard disc space. If this process continually fails, ensure that all files involved are in StatePlane Feet, and ensure that you have at least 50 gigabytes of disc space available. It is useful to clean Arc Hydro temp files to free up space if reconditioning fails: In Arc Hydro Toolbar click ApUtils, go to Additional Utilities, click Clean Userˇs Temp Folder and click yes. 
	3.  In Arc Hydro Tools toolbar, click Terrain Preprocessing, click DEM Manipulation, click Fill Sinks. Leave everything on defaults and click Okay. This will create a layer Fil.
	4.  In Arc Hydro Tools toolbar, click Terrain Preprocessing, click Flow Direction. Leave everything on defaults and click Okay. This will create a layer Fdr.
	5.  In Arc Hydro Tools toolbar, click Terrain Preprocessing, click Flow Accumulation. Leave everything on defaults and click Okay. This process can take a while. This will create a layer called Fac.
	6.  In Arc Hydro Tools toolbar, click Terrain Preprocessing, click Stream Definition. In Area (Square km), type ˘05ˇ after the decimal place. Delete everything after ˘.05ˇ. Note that you cannot make this field blank or zero at any time, it will cause an error. Make sure the ˘.05ˇ is in this field before you delete anything. The end result in this field should be ˘0.05ˇ. This will create a layer called Str.
	7.  In Arc Hydro Tools toolbar, click Terrain Preprocessing, click Stream Segmentation. Leave everything on defaults and click Okay.  Q; are the ˘Nullˇ values for ˘Sink Link Gridˇ and ˘Sink Watershed Gridˇ correct? This will create a layer called StrLnk.
	8.  In Arc Hydro Tools toolbar, click Terrain Preprocessing, click Catchment Grid Delineation. Leave everything on defaults and click Okay. This will create a layer called Cat.
	9.  In Arc Hydro Tools toolbar, click Terrain Preprocessing, click Catchment Polygon Processing. Leave everything on defaults and click Okay. This will create a layer called Catchment.
	10.  In Arc Hydro Tools toolbar, click Terrain Preprocessing, click Drainage Line Processing. Leave everything on defaults and click Okay. This will create a layer called DrainageLine.
	11.  In Arc Hydro Tools toolbar, click Terrain Preprocessing, click Adjoint Catchment Processing. Leave everything on defaults and click Okay. This will create a layer called AdjointCatchment.
	Watershed Processing
	In this process, you will create Batch Points based on road-stream crossings (Culverts layer) and then you will delineate the watershed based on each individual point. After watersheds are delineated, you will calculate watershed characteristics (area, slope, and longest flow path).
	12. Turn off all layers except the Culvert layer and the Drainage Line layer.
	13. Use the Snap Pour Point tool from ArcGIS toolbox (Spatial Analyst Tools > Hydrology > Snap Pour Point) to snap river-roads crossing to the nearest point of the drainage line where the flow accumulation is maximal (a snap distance of 15 feet is chosen here, but can vary based on the ˝Near˛ command to find the maximum distance between the drainage lines and culvert locations). The Snap Pour Point tool is used to ensure the selection of points of high accumulation flow when delineating drainage basins using the Watershed tool. Snap Pour Point will search within a snap distance around the specified pour points for the cell of highest accumulated flow and move the pour point to that location.
	14. Open the Culvert Points attribute table. Highlight the first record from the attribute table and zoom to it.
	From Arc Hydro Tools toolbar, click the Point Delineation tool as indicated by a red arrow in Figure 3. This tool allows watershed delineation for interactively defined points.
	Figure 3. Location of Point Delineation tool (pointed to with a red arrow)
	16. Leave defaults when a dialogue window (Figure 4) opens and click OK.
	/
	Figure 4
	17. Click the nearest snapped culvert location to the first crossing point you just zoomed to. It should delineate the watershed in red if you have clicked close enough to the pour point; if not the following dialog box will open. You can try clicking ˝Yes � Snap˛ (choose the number of distance cells based on the size of your raster cells), but when the point delineates you must check to make sure that snapped point and resulting watershed make sense relative to the landscape!
	/
	Figure 5
	18. Click Yes to the question ˝Do you want to save the watershed?˛ and type the name of a culvert following with an easy identifier � like the local ID (see Figure 6) you used in the field or the 15 character NAACC crossing code (copied and pasted from the attribute table). For Description, you can type in the road name or stream name, survey ID, or whatever will make sense to you later. Or nothing at all. 
	/
	Figure 6
	19. Continue delineating watersheds in the same way (highlight > zoom to > click pour point > delineate > name and save) until you have completed all the crossings. When finished, notice that the software has created two layers. One called ˝Watershed˛ and another one called ˝WatershedPoint˛. It is important to know is the Watershed layer has a field called ˝ HydroID˛ which is the same as the field ˝DrainID˛ from the WatershedPoint layer � this will be necessary later.
	Longest flow path for watersheds
	20. From HEC-GeoHMS Toolbar, set parameters for data management (Preprocessing > Data Management) as shown in Figure 7. You do not need to type in anything. For Raw DEM, select the name your DEM; set the rest as following.
	/
	Figure 7. Data management window for HEC- GeoHMS extension.
	21. Open the new Watershed layer attribute table. Begin selecting multiple watersheds, but make sure they do NOT overlap or nest (smaller watershed within a larger watershed selected at the same time) � select as many as you can. (HEC-GeoHMS will not compute characteristics for overlapping or nesting watersheds and will only return null parameters.) From HEC-GeoHMS toolbar select Characteristics > Longest Flow Path. Notice the resulting layer is automatically named Longestflowpath (Figure 8). You will add 1 after the name to make it Longestflowpath1 since you will compute for Longestflowpath2, Longestflowpath3, and so on depending on the number of runs needed to make the calculations without overlapping. Make sure the Input Raw DEM is your original DEM and the Input Subbasin the Watershed layer; leave fdr as default for Input Flow Direction Grid (Figure 9).
	Important note: make sure this tool is NOT run in the background. It has a tendency to crash when run in the background instead of as a visible process. It can be changed in the Environments Panel.
	/
	Figure 8
	22. Continue selecting new watersheds from the Watershed layer attribute table and running the Longest Flow Path tool in HEC-GeoHMS until all the watersheds have been calculated. Give each new batch of calculations a different name. 
	23. Append or merge all the Longest Flow Path batches into a single table. Join this table to the Watershed layer using the HydroID in the LongestFlowPath layer and the DrainID in the Watershed layer (see Figure below). In the layer properties, you can go into the Field tab and uncheck all fields except DrainID, Slp, Slp1085, and LongestFL � these are the only fields we will need for later output analysis.
	                Figure 9   
	Area of wetlands/ponds in watershed (ft2)
	You will use a wetland layer from National Wetlands Inventory (U.S. Fish and Wildlife Service) (http://www.fws.gov/wetlands/Data/State-Downloads.html) or the wetlands and ponds shapefile from your state.
	24. Clip the layer to the extent of the watershed you delineated (using the Clip tool in ArcGIS).
	25. Open the attribute table of the clipped layer and add a new field (Name: Wet_Sqft, Type: Double, Precision = 10, Scale = 2) (Figure 10).
	/
	Figure 10
	26. Right click Wet_Sqft and use Calculate Geometry and set necessary parameters (Figure 11). The output is computed in square feet for each watershed. 
	/
	Figure 11
	27. To calculate how much (square feet) of watersheds, ponds, and lakes is in each watershed, use Spatial Join tool (ArcToolbox > Analysis Tools.tbx > Overlay > Spatial Join) to join the wetland layer you clipped in step 6 to the Watershed layer (Target Features = Watershed, Join Features = Wetlands layer, Join Operation: JOIN_ONE_TO_MANY. Set the output location to the Wetlands folder you created earlier) (Figure 12).
	/
	Figure 12
	Notice that the output contains HydroID field (which originates from the Watershed layer) and Sqft (which originates from the wetlands layer) (Figure 13).
	/
	Figure 13
	28. Right click HydroID > Summarize > When prompted to a dialog window, scroll down to expand Wet_Sqft field (this is a field you created in step 44) and check Sum in the ˝Choose one or more summary statistics to be included in the output table˛ box. The output table will show how much of total area (lakes, ponds, and wetlands combined) found in every watershed. 
	29. Open output table properties and click Fields tab to uncheck all fields except
	HydroID and Wet_Sqft.
	SCS Curve Numbers (CN) generation
	A widely used method of calculating storm runoff developed by the Soil Conservation Service (SCS) uses storm rainfall and a curve number. A curve number is a quantitative descriptor of the land cover/soil complex and is commonly assigned based on information acquired from field surveys and interpretations of aerial photographs (Slack & Welch, 1980). Curve numbers have been tabulated by the Soil Conservation Service on the basis of soil type and land use. Four soil groups are defined:
	" Group A: Deep sand, deep loess, aggregated silts
	" Group B: Shallow loess, sandy loam
	" Group C: Clay loams, shallow sandy loam, soils low in organic content, and soils usually high in clay
	" Group D: Soils that swell significantly when wet, heavy plastic clays, and certain saline soils (Chow, Maidment, & Mays, 1988).
	To generate CN values requires three steps: Land cover data preparation, soil data preparation and creation of SCS curve number grid. SCS curve number grid is used by many hydrologic models to extract the curve number for watersheds. We will use HEC-Geo-HMS for ArcGIS.
	Land cover data preparation
	30. Add land cover data to ArcMap. Notice that the layer does not have a spatial reference.
	Use the Define projection tool to assign spatial reference to the raster data (ArcToolbox > Data Management Tools > Projections and Transformations > Define Projection). You will then choose WGS84 for Coordinate System. Then set the projected coordinate system to your stateˇs appropriate NAD_1983 coordinates using the Project Raster tool.
	/
	Figure 14
	31. Reclassify land use into classes that have the same general characteristics (From ArcGIS ArcToolbox > Spatial Analyst Tools > Reclass > Reclassify). You will use the following table to replace old values with new values (Table 1). The reclassify shows only eight classes. Save as LC_Reclass.
	Table 1: Reclassification of land cover
	New classes
	Old classes
	1
	110: Residential/commercial/industrial
	2
	140: Transportation
	3
	211: Row crops
	4
	212: Hay/Pasture
	5
	221: Orchards
	6
	412: Beach/Oak
	414: Paper Birch/Aspen
	419: Other Hardwoods
	421: White/Red Pine
	422: Spruce/Fir
	423: Hemlock
	424: Pitch Pine
	430: Mixed Forest
	500: Open water
	7
	610: Forested wetlands
	620: Open wetlands
	630: Tidal wetlands
	710: Disturbed land
	8
	790: Other cleared
	Soil Code
	Soil Description
	A
	Excessively drained
	B
	Well drained
	C
	Poorly drained
	Very poorly drained
	D
	C
	No description
	36. Select records that correspond to Very poorly drained of the DrainClass field > Right click SoilCode field to select Field Calculator (make sure to be in editing mode!) > Type "D" under Soil Code = > OK.
	Proceed with the rest of classes. However, for those which do not have any description, you should refer to MUName field to decide which group to assign every record. For our case, since the rest of records consists mostly of water, we will consider the soil to be very poorly drained (D category).
	37. Create four attribute fields with names "PctA", "PctB", "PctC" and "PctD". Data type is
	short integer for the four fields. 
	38. You will use the Select by Attributes (from the drop-down arrow of the top left corner of the table) to select Soil Code that corresponds to category A (Figure 19). Use Field Calculator to populate the Pct A field with the value of 100; leave a value of 0 for other fields, i.e. PctB, PctC, and PctD (e.g. Figure 19). Repeat this step for PctB, PctC, and PctD. For soils containing two soil codes split the percentages appropriately (i.e. Soil Code: A/D, PctA = 50, PctD = 50. Make sure the table uses 0 instead of NULL fields.
	/
	Figure 19. Example of the Use of Field Calculator for PctA field.
	Creating CN LookUp table
	39. Create a CnLookUp table using Create Table tool (ArcToolBox > Data Management Tools > Table > Create Table). Table Location should be your project folder's geodatabase. Give the name "CnLookUp" to the table (Figure 20), then hit OK.
	/
	Figure 20
	40. Right click the table > Open. Click the top left drop-down arrow and select Add Field (Field Name: LUvalue, Type: Short Integer, Allow Null Values: Yes). Add another field (Name: Description, Type: text, lenth: 30).
	41. Add four more fields (Type = short integer) and name them "A", "B", "C", "D" respectively as illustrated in Figure 21.
	/
	Figure 21. LuValue, Description, A, B, C and D new fields added to CnLookUp table.
	42. Right click the table in the TOC, then click Edit Features > Start Editing. You will populate the table with CN values (Figure 22), then you will save edits before closing the editing session. These values have been retrieved from Soil Conservation Service (SCS) Technical Release 55 (Cronshey, 1986).
	/
	Figure 22
	Union of Soil and Landuse Data
	43. In this step, we will union Soil and Landuse Data using the Union tool (ArcToolbox > Analysis Tools > Overlay > Union). Name the output layer ˝LC_Soils_Union˛ (Figure
	23).
	/
	Figure 23
	44. Open the attribute table of LC_Soils_Union layer and click the drop down arrow from top left corner of the attribute table > Click Select by Attributes. Set parameters as follows when a dialogue window opens (Figure 24).
	/
	Figure 24. Select by Attribute dialogue window.
	The reason for selecting FID_Soils = -1 and FID_LC = -1 is that these records correspond to areas of soils and land cover which do not overlap; therefore, these need to be cleaned before we use the new layer to create CN Grid. Now you have created a new layer that has both soil attributes and land use attributes. This layer is necessary for the computation of SCS runoff curve numbers (CN) which will be performed in the next step using the HEC-GeoHMS toolbar.
	Creating CN Grid
	45. Activate the HEC-GeoHMS extension toolbar by right clicking an empty space next to the main menu tool bar and checking the HEC-GeoHMS toolbar. The toolbar appears in ArcMap (Figure 25).
	Figure 25
	46. You will now compute a CN Grid using Generate CN Grid tool (from the HEC-GeoHMS
	tool bar, click the drop-down arrow next to Utility > Click Generate CN Grid > OK).
	Leave fil as default for Input Hydro DEM; set the Input soil Landuse Polygon to the new layer you created in steps 62 � 65; leave CNLookUp as default for Input Curve Number
	Lookup; Make sure the output corresponds to where you want it and leave CNGrid as default name for the output layer as shown (Figure 26). 
	/
	Figure 26
	47. In order to determine the average CN value for each of the watersheds, we will use the Zonal Statistics as Table tool (ArcToolBox > Spatial Analyst Tools > Zonal > Zonal Statistics as Table) (Figure 27). The resulting table shows a field named "MEAN". This field stores averaged CN values for each watershed (Figure 28).
	Note: As with the process for Longest Flow Path, trying to run watersheds that overlap or nest at the same time will result in null or incorrect outputs. Select non-overlapping watersheds in multiple batches, or use an iterative model through the model builder to run each watershed individually and merge them together afterward.
	/
	Figure 27
	/
	Figure 28. Table with averaged CN values for each watershed.
	48. Highlight as many non-overlapping watersheds as possible and run the Zonal Statistics as Table tool in batches until all watersheds have been run. 
	49. Merge the batches together into a final table with all watersheds � check that all watersheds are accounted for and all CN values are populated.
	50. Join the CN values to the Watershed layer using the HydroID.
	Precipitation Data
	51. Add precipitation data you downloaded from http://www.prism.oregonstate.edu/normals/. Those are 2-10-25-50-100-year rainfall ascii files from Cornell (0.8 km resolution).
	52. Convert ASCII data into raster format using ASCII to Raster tool (ArcToolBox > Conversion Tools > To Raster > ASCII to Raster) (Figure 29).
	/
	Figure 29
	53. Define the projection as WGS-72 using the Define Projection Tool (ArcToolBox > Data Management Tools > Projections and Transformations > Define Projection). For input data set, browse to add ASCIITo_2_Yr1 layer > for coordinate system choose WGS 1972. Then project the raster and choose the appropriate WGS-83 state plane coordinate system for the output coordinate system and output name to be prec_2yr.
	54. To calculate the average precipitation (inches) for each watershed, you will use the Zonal Statistics as Table tool (ArcToolBox > Spatial Analyst Tools > Zonal > Zonal Statistics as Table) where the input raster of feature zone data is the watershed of interest, the zone field is the HydroID, the Input value raster is the precipitation raster data. The output table should be stored into the file geodatabase you created. For Statistics type, choose MEAN (Figure 30).
	/
	Figure 30
	Select and run statistics for watersheds in the same manner you selected them to run watershed characteristics (not overlapping or nesting), or the Zonal Statistics as Table tool can be used as an iterative model to compute the precipitation for all watersheds. 
	55. Merge or append all the mean precipitation tables, then join them to Watershed layer.
	56. For any watersheds that are too small to run the zonal statistics, select and zoom to the watershed, then use the identify tool to view the pixel value from the precipitation raster and manually input it into the table. 
	57. Repeat these steps for precipitation data (steps 56-61) for each of the 10-yr, 25-yr, 50-yr, and 100-yr storm intervals. Export these tables as .csv (or whatever file type youˇre comfortable with), bring them into Excel (or your spreadsheet of choice), and divide  precipitation values by 1000.
	58. Repeat these steps for precipitation data (steps 56-61) for the mean April precipitation. After exporting, convert the precipitation from millimeters to inches (1mm = 0.0393701 inch). 
	59. When exporting and compiling all tables and GIS data, BE SURE that all precipitation is measured in inches and all areas, lengths, and slopes are in ft or ft2. Final output to be loaded into the Excel-based hydraulic capacity model should look like the following figure:
	/
	Figure 31
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